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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified 
personnel are those who, based on their training and experience, are capable of identifying risks and avoiding 
potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in 
this publication is reviewed regularly and any necessary corrections are included in subsequent editions.

Siemens AG
Division Process Industries and Drives
Postfach 48 48
90026 NÜRNBERG
GERMANY
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Ⓟ 02/2017 Subject to change

Copyright © Siemens AG 2016 - 2017.
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Security information 1
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines and networks.

In order to protect plants, systems, machines and networks against cyber threats, it is 
necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial 
security concept. Siemens’ products and solutions only form one element of such a concept.

Customer is responsible to prevent unauthorized access to its plants, systems, machines and 
networks. Systems, machines and components should only be connected to the enterprise 
network or the internet if and to the extent necessary and with appropriate security measures 
(e.g. use of firewalls and network segmentation) in place.

Additionally, Siemens’ guidance on appropriate security measures should be taken into 
account. For more information about industrial security, please visit:
http://www.siemens.com/industrialsecurity

Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends to apply product updates as soon as available and to always 
use the latest product versions. Use of product versions that are no longer supported, and 
failure to apply latest updates may increase customer’s exposure to cyber threats.

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS 
Feed under:
http://www.siemens.com/industrialsecurity
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Scope of the manual 2
Just like the "Administration" manual, the "Installation" manual is written for the COMOS 
administrator target group. In terms of content, the two manuals differ in the following ways:

● The "Installation" manual describes the administrative tasks regarding the network, network 
rights and third-party software.

– All required network components, network servers and other hardware.

– All types of third-party software including operating systems and printer drivers.

– The actual installation of the COMOS software (COMOS client, license server, etc.). 
This includes the customization of COMOS files such as Main.xml.

– The installation of the COMOS database.

– Note: A separate manual is available on the installation and maintenance of the 
Enterprise server.

● The "Administration" manual describes the administrative tasks that are processed in 
COMOS. COMOS is installed and started; only tools and functions that are made available 
by COMOS are used.

– Dedicated user interfaces exist in COMOS for some printer drivers so that you can 
configure the printer driver in COMOS. This COMOS-specific user interface for printer 
configuration is also described in the "Administration" manual. 

– Individual functions are available in COMOS for some database maintenance tasks.
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Software requirements / third-party software 3
3.1 Help viewer

Browser
You can run the COMOS 10.2 HTML help in the following environments:

● Windows 7 with Internet Explorer 10

● Windows 7 with Internet Explorer 11

● Windows 10 with Edge
MS Edge is entered as the default app for Windows 10.

● Windows Mobile with IE 11

● Windows 7 with Chrome 46

● Windows 7 with Firefox 38

● Apple with Safari (iPad, iPhone)

Deactivating automatic start of Help
See chapter Administration of the help menu (Page 251), section "Start / automatic start of 
COMOS help".

Browser script for Internet Explorer
The HTML help requires Browser Script. Select one of the following options for Internet 
Explorer:

● Activate script manually when opening the help
A note regarding blocked scripts is displayed when you start the HTML help:
"Internet Explorer restricted this web page from running scripts or ActiveX controls."
Click "Allow blocked content".

● Activate script permanently
Internet Explorer:
"Internet Options > Advanced > Security > Allow active content to run in files on My 
Computer"

3.2 Compatibility matrix

Reference version
COMOS 10.2.1
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iDB Version 19

Language of the operating system
Microsoft supplies country-specific versions of the operating system. The information in the 
category "OS" refers to a successful system test in the country-specific versions "USA", 
"Germany" and "China".

Overview
All information refers to a 64-bit operating system.

Legend:

● Compatibility type

– Release
COMOS is released only for this third-party product with this version.

– Successful system test
COMOS was successfully tested with the named version of the third-party product. 
Other versions of the third-party product can also be used, depending on framework 
conditions.
If different versions of the third-party product were tested in the course of multiple 
COMOS versions, only the latest version of the third-party product is listed.

● COMOS module involved
Supplementary information indicating the preferred COMOS module in which the third-party 
product is used. This information does not represent a restriction of the compatibility type.

Catego‐
ry

Manufacturer/ 
Owner

Name of third-party prod‐
uct

Version of third-party 
product

COMOS module in‐
volved

Compatibility 
type

OS Microsoft Windows Windows 7 COMOS Client, CO‐
MOS LS 2.0.1, COMOS 
LSMonitor 1.7.2, CO‐
MOS LUM 1.5.2, CO‐
MOS RLS 3.9 

Release

Windows Windows 10
Release applies to CO‐
MOS. Siemens cannot 
confirm the functional ca‐
pability of third-party 
products across the 
board at present.

COMOS Client, CO‐
MOS LS 2.0.1, COMOS 
LSMonitor 1.7.2, CO‐
MOS LUM 1.5.2, CO‐
MOS RLS 3.9

Release

Windows Windows Server 2008 
R2

COMOS Client, CO‐
MOS LS 2.0.1, COMOS 
LSMonitor 1.7.2, CO‐
MOS LUM 1.5.2, CO‐
MOS RLS 3.9

Release

Windows Windows Server 2012, 
Windows Server 2012 
R2

COMOS Client, CO‐
MOS LS 2.0.1, COMOS 
LSMonitor 1.7.2, CO‐
MOS LUM 1.5.2, CO‐
MOS RLS 3.9

Release

Software requirements / third-party software
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Catego‐
ry

Manufacturer/ 
Owner

Name of third-party prod‐
uct

Version of third-party 
product

COMOS module in‐
volved

Compatibility 
type

Data‐
base

Make sure that the file server for SMB2.0 (active directory Windows 2000 and later) is compatible and allows 
access to small files with low latency times. No fault tolerance exists in COMOS for accessing files.
Microsoft SQL Server 2014 COMOS Platform Successful sys‐

tem test
Access (mdb) Jet 4.0 COMOS Platform Successful sys‐

tem test
Oracle Server 12 COMOS Platform Successful sys‐

tem test
Client 12 COMOS Platform Successful sys‐

tem test
Office 
soft‐
ware

Microsoft Excel (doc) 2007 COMOS Platform Release
Excel (docx) 2010 COMOS Platform Release
Word (doc) 2007 COMOS Platform Release
Word (docx) 2010 COMOS Platform Release
Access (mdb) 2013 COMOS Platform: 

Standard import
Access is listed in the 
compatibility matrix also 
in the "Database" cate‐
gory.

Successful sys‐
tem test

Project 2013 COMOS Operations Successful sys‐
tem test

Virtuali‐
zation

Citrix XenApp 7.6
on Windows 2012 R2

COMOS Platform Successful sys‐
tem test

PDF Supported PDF specifications:
● PDF 1.4
● PDF 1.7
Dependent COMOS functions:
● Export: See "COMOS Interfaces" manual, keyword "Export report as PDF"
● Import: See "P&ID Operation" manual, keyword "PDF import".
● Revisions: See section "General information on Adobe PDF (Page 212)".
● Revisions: You can find additional information on this topic in the "Administration" manual, keyword "Revision 

options: Specify revision archive (specify print format)".
● eSign: See "Administration" manual, keyword "Project properties: Preparing revision options".
Adobe Acrobat Reader XI COMOS Platform, Re‐

port Import/Export
Successful sys‐
tem test

Acrobat XI COMOS Platform, Re‐
port Import/Export

Successful sys‐
tem test

PDF Factory Standard 4.61 COMOS Platform, Re‐
port Import/Export

Successful sys‐
tem test

Server 4.10 COMOS Platform, Re‐
port Import/Export

Successful sys‐
tem test

Software requirements / third-party software
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Other third-party software
● Successful system test: AutoVue 19.2

● Successful system test: Pro II 9.3

● Successful system test: AutoCAD 2014

● Successful system test: PDMS 12.1.2

● Successful system test: OpenPlant Modeler 8i

● Successful system test: AspenPlus 11.1

● Successful system test: HYSYS 8.8

● Successful system test: UniSim Design R440 Build 5

● Successful system test for ChemCad 6.5.6.7502

● Successful system test: Promax 3.0.9065.0

● Successful system test: NOW / Proteus (previously XMpLant) 3.6.0

● Successful system test: eCl@ss based on BMECat 9.0 Advanced

Runtime components of the installation
The following runtime components must be present:

● Runtime of Microsoft Visual C++ 6.0 SP6

● Runtime of Microsoft Visual Basic 6.0 SP6

● Microsoft Visual C++ 2010 x86 Redistributable

● Microsoft Visual C++ 2012 x86 Redistributable

● Microsoft Visual C++ 2013 x86 Redistributable

● Microsoft .NET Framework 3.5 (needs Internet access)
Please check the document "Release Notes 10.2.1" for the latest information about this 
topic especially when Windows 10 is used.

● Microsoft .NET Framework 4.5.2

The runtime components are automatically included in the installation by default.

Internally-used third-party components
● MSXML

– Up to and including COMOS 10.1 SP3: MSXML 5
If the existence of MSXML 5 is explicitly requested and used as part of customizing, 
customers must install MSXML 5 themselves later or adapt the customizing.
MSXML 6 is backward compatible. If MSXML is used only generally within the framework 
of COMOS, there are no known compatibility problems caused by the changeover.

– COMOS 10.2 and later: MSXML 6

● VBScript.dll: 5.6 or 5.7

● PDFlib 9.0.2 with access to MSVCR100.dll

Software requirements / third-party software
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Information about the used browser
Windows 10 uses the "Edge" app as the standard app for the browser. If an html file is opened 
by means of a double-click, Edge is used for Windows 10 in the default setting.

The COMOS Setup Browser does not function with Edge. Start the Setup Browser with the 
Internet Explorer. 

3.3 Notes on a 64-bit operating system

Standard import in Windows 7 
The registry entry HKLM\Software\Wow6432Node\Microsoft\Jet\4.0\Engines\Text is accessed 
for clients with a 64-bit operating system. 

● The default value is "CSVDelimited", which means that the individual values are separated 
by a comma. 

● If you want to use the standard import in Windows 7, set the value to "Delimited(;)". 

"Delimited(;)" is set as the default value for clients with a 32-bit operating system.

Setting up a ODBC connection
A 32-bit ODBC connection must be visibly present for COMOS on 64-bit operating systems. 
You set it with the following program:
c:\windows\syswow64\odbcad32.exe

3.4 Enterprise Server
The Enterprise Server for COMOS 10.x supports the same operating systems as COMOS 10.x.

3.5 Freely configurable revision printer
The freely configurable revision printer (HARP) requires:

● GhostScript 9.05 – 64-bit

See chapter Configuring the "Freely configurable revision printer" revision archive (Page 204).

3.6 Software requirements for COMOS Mobile Solutions

Requirements for COMOS Mobile Solutions
COMOS Mobile Solutions is a collection of different solutions. Each of these solutions has 
different software requirements.

Software requirements / third-party software
3.6 Software requirements for COMOS Mobile Solutions
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You can find more information on this topic in the "Mobile Solutions" manual, keyword 
"Software requirements for COMOS Mobile Solutions".

See also
Microsoft (http://www.microsoft.com/en-us/download/details.aspx?id=29065)

Software requirements / third-party software
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Hardware requirements / Network 4
4.1 Interaction of network connection and latency time

Latency time ("response time", "round trip"): Time interval that a data package needs from 
client to server and back.

Recommendation for network connection:

● COMOS client: 1 Gb network connection

● File server, database server, Citrix server: 10 Gb network connection

● External SAN drives or SAN devices: 10 Gb network connection and connection to a 
separate network 

● Citrix client for COMOS: 1 Mb network connection
Average bandwidth required per Citrix client: 50-100 Kb
Latency time ("round trip"): less than 50 ms. The latency time depends on the number of 
network components and the distance to the server. 
Latency times of 300 ms and more result in a significant loss in the usability of COMOS. 

General conditions for latency times:

● Network access through mobile data connections increases the latency time by an 
additional 100 ms. 
No recommendation for processing of graphic-rich data over mobile data connections.

● Satellite connections: Due to very high latency times, they are not approved for COMOS 
Citrix clients.

General conditions for WAN:

● No approval of the network type "MPLS" 

● Use dedicated data connections with guaranteed bandwidths, guaranteed latency times 
and static routing.

● Monitor the line utilization. Shortages of line capacity result in a sharp increase in the latency 
time.

● Assign a high priority for the protocols used by Citrix in the WAN.

● Assign a high priority for access to the terminal server in the WAN. 

● In case of large geographical distances: For each 1000 km of distance over fiber-optic 
cable, the latency time is increased by 9 ms. 

● In case of large geographical distances: For each 1000 km of distance over copper cable, 
the latency time is increased by 6 ms.
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4.2 Virtualization
The COMOS system test includes a series of operating systems that are referred to as 
COMOS-compatible operating systems below. The COMOS system test does not include 
virtualization solutions in the server area. 

Use only virtualization solutions that have been approved by the manufacturer for COMOS-
compatible operating systems. The manufacturer of the virtualization solution must ensure 
compatibility.

Familiar virtualization solutions are: 

● VMware ESX

● Citrix Xenserver

● HyperV

In practice previously, the following conditions applied to the COMOS client:

● Virtual machines need the same resources for CPU and main memory as physical servers.

● If the server of the virtualization solution is a multi-processor system in NUMA architecture: 
Use only "NUMA-local" resources. Reserved CPU resources and reserved main memory 
must be available locally. 

In practice previously, the following conditions applied to the COMOS license server:

● In the standard case, virtual machines do not have access to USB devices. If the COMOS 
license server is operated with USB dongles, a compatible USB-over-IP solution must be 
used. The manufacturer of the USB-over-IP solution must ensure compatibility.

● The COMOS license server supports operation without dongle. In the latter case, the 
COMOS license server is connected to three environment parameters of the operating 
system. 

4.3 Information for RAID systems
To avoid performance losses, configure the database file system in accordance with Microsoft 
Support document 929491. This applies to the Microsoft SQL Server and to Oracle.

See also
Database server prerequisites (Page 48)

Hardware requirements / Network (Page 21)

4.4 Overview of cache technologies

Aim
A COMOS client uses a cache for quicker access to data that has already been downloaded 
once from the database during the session. COMOS also permits simultaneous write access 
of different COMOS clients to the same data.

Hardware requirements / Network
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Therefore, the caches of different clients are automatically synchronized in the background. 
This means that all users work with the latest data and see immediately how other COMOS 
clients have changed the currently used data. 

Overview of technologies
The use of multicast is required for all following technologies. See chapter Multicast 
(Page 24).

● CVS
CVS = Cache validation service
With CVS, the multicast method is used instead of the pure broadcast.
See chapter Installing or uninstalling CVS (Page 27).

● SBM (outdated name: NewCVS)
Obsolete. No longer supported as of COMOS 10.2.
See chapter Uninstalling SBM (Page 29).

● CVS 3G
TCP/IP-based technology for synchronizing the client cache.
Supported database servers:

– Oracle according to COMOS requirements

– SQL Server according to COMOS requirements

– See chapter Compatibility matrix (Page 15).

See chapter Installing CVS 3G (Page 30).

● Merge replication
Requires SBM. Because SBM is not available in COMOS 10.2, merge replication is also 
not available in COMOS 10.2.
If you are working with several databases instead of a shared database, you must also use 
the merge replication method. With this method, several users initially work autonomously 
on location-specific databases at different locations. The changes are then later merged 
into a uniform result. 
See chapter Combining several databases using merge replication (Page 31).

Interaction of the technologies
For COMOS 10.2 and later:

● Recommendation: CVS 3G

● Can be used at the same time: CVS

● Can no longer be used: Merge replication

Hardware requirements / Network
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In connection with the COMOS installation, the following recommendations apply:

● New installation of COMOS 10.2
CVS: active
CVS 3G: inactive and can be installed
SBM/NewCVS: inactive and cannot be installed

– COMOS can be used immediately because CVS is active

– Install CVS 3G and then disable CVS

● Update to COMOS 10.2 if CVS has been used so far
CVS: active
CVS 3G: inactive and can be installed
SBM/NewCVS: inactive and cannot be installed

– COMOS can be used immediately because CVS is active

– Install CVS 3G and then disable CVS

● Update to COMOS 10.2 if SBM (=NewCVS) has been used so far
CVS: If CVS was used at the same time, then CVS is active
CVS 3G: inactive and can be installed
SBM/NewCVS: inactive and can no longer be installed

– COMOS can only be used if CVS was used together with SBM/NewCVS.

– Install CVS 3G and then disable CVS if it is still active

4.5 Multicast

4.5.1 Overview of multicast technology
In order to keep the load on the network as low as possible, COMOS works in "multicast" mode. 
This technique functions extremely stably, decentralized and does not require any server 
capacity. With the exception of setting up multicast on the network routers, multicast does not 
require administration.

In contrast to "broadcast", multicast is a vendor-independent standard with a low network load. 
Data packages are only inserted once into the network. Only when the router knows that a 
workstation in this segment requires or has requested the data package, is the data package 
passed on to the segments. 

The data packet is also sent only once within the segment and can be fetched by the 
workstations that require this information. In this way, the data traffic is restricted to the 
necessary minimum. You can find additional information on this topic at www.microsoft.com 
under the keyword "Multicast". 

Hardware requirements / Network
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Each computer on which COMOS (version 5.3.6 or later) is installed automatically works with 
the COMOS Cache Validation Service (CVS). COMOS CVS uses the following addresses and 
protocols:

● Router communication to IP address 224.0.0.22, IGMP protocol

● Multicast IP address: 234.5.6.7
(registry key: CVSIPAddress)

● Port Address: 3456

In the registry, you can specify how many routers are permitted for the CVS: 

[HKEY_LOCAL_MACHINE\SOFTWARE\INNOTEC\COMOS] "CVSTimeToLive"=dword:
00000002
The number of routers connected in series for the CVS traffic can be increased by increasing 
the default value of CVSTimeToLive=2 .

● Value=2, then CVS is possible via 1 router (default)

● Value=3, then CVS is possible via 2 routers

● Value=n, then CVS is possible via (n-1) routers

Time sequence
All the changes are allowed to accumulate over a period of 5 seconds and are then sent in a 
single block. All other COMOS instances receive these messages. If the respective objects 
already exist in the working memory, they are updated. If an object specified in the CVS 
message has not actually been loaded by a COMOS instance, no changes are made.

See also
Overview of cache technologies (Page 22)

Testing network segments (Page 25)

4.5.2 Testing network segments

Requirements
● Your router is multicast-capable. 

See chapter Overview of multicast technology (Page 24).

● You are familiar with the following programs and they are available:

– "DBMON.EXE"
"\<COMOS directory>\BIN\DBMON.EXE"
Monitor for the output of COMOS CVS test output for "Comos.exe" and "ptmcast.exe".

– "ptmcast.exe"
"\<COMOS directory>\BIN\ptmcast.exe"
Test program to check the connection between the COMOS CVS sender and receiver 
(formerly: SMS), comparable to a "ping" program.

Hardware requirements / Network
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Testing the network communication
Communication between the server and the workstations functions if you were able to 
successfully carry out the test described below over your router.

1. Start "DBMON.EXE".

2. Open two DOS windows and switch to the directory in which the "ptmcast.exe" program is 
located.

3. Start the CVS receiver with PTMcast /r.
The parameter stands for "receive". This specifies that this instance of PTMcast  acts 
as the receiver. The command is as follows with a standard installation:
c:\COMOS\bin\>PTMcast/r
The following line is displayed:
Waiting for receiving until pressed Return-Key for quit 

4. Start the CVS sender with PTMcast.
The command is as follows with a standard installation:
c:\COMOS\bin\>PTMcast
The program PTMcast sends text to the instance declared as a receiver with /r.
The following lines are displayed at the sender:
PTMcast: Message <LOGO39-02\schneider: Test-Message Nr.1> with 100 
Bytes sended!
PTMcast: Message <LOGO39-02\schneider: Test-Message Nr.2> with 100 
Bytes sended!
...

5. The following text is displayed in the receiver's DOS window:
Waiting for receiving until pressed Return-Key for quit 
PTMcast.OnReceive: Message <LOGO50-01\mueller: Test-Message Nr.2> 
with 100 Bytes!
PTMcast.OnReceive: Message <LOGO50-01\mueller: Test-Message Nr.3> 
with 100 Bytes!
...

Diagnostics
If no feedback has been given at the latest after 30 seconds, the connection between the 
sender and receiver is faulty. If the test messages generated by "ptmcast.exe" are transmitted 
with errors, a corresponding message is output in DBMon. The test message from 
"ptmcast.exe" can also be larger or smaller than 100 byte. The message size can be changed 
per parameter. The control parameters of "ptmcast.exe" can be called by: "...\ptmcast. exe ?".

4.5.3 Use of multicast in COMOS
Multicast is used as follows in COMOS:

1. StationID

2. DongleID (license server)

3. CVSMonitor

4. Object cache (synchronization of UIDs)

Hardware requirements / Network
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Topics 1, 2 and 3 require multicast.

Step 4:

● ServiceBroker (for CVS); this technology is no longer included in COMOS 10.2

● CVS3G is based on the SQL server and does not need multicast

4.6 Installing or uninstalling CVS

4.6.1 Disabling CVS in the database

Requirements
Recommendation: When all COMOS clients participate in CVS 3G, disable CVS.

See chapter Installing CVS 3G (Page 30) for more on this.

Disabling CVS temporarily
Set the following method in the workset:
SendCVSMessagesWithOldStyle(bool)
TRUE: CVS is active.

FALSE: CVS is inactive.

The setting is reset to the default TRUE when the session is completed.

Disabling CVS permanently
CVS is controlled by an entry in the iDB. The following SQL command sets the entry to activate 
CVS:
LC_SETTINGS:INSERT INTO LC_SETTINGS (PROPERTY, VALUE) VALUES 
(‘MULTICAST_CVS_ACTIVE’, ‘TRUE’)
Also permitted:
LC_SETTINGS:INSERT INTO LC_SETTINGS (PROPERTY, VALUE) VALUES 
(‘MULTICAST_CVS_ACTIVE’, ‘1’)
Interaction:

● When the entry MULTICAST_CVS_ACTIVE is found in the iDB, the entry in the workset is 
no longer evaluated.

● When the entry MULTICAST_CVS_ACTIVE is missing in the iDB, CVS is automatically 
reactivated in a new session.

In this way, CVS can be disabled or enabled simultaneously for all COMOS clients with access 
to the same COMOS database. 
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4.6.2 Controlling CVS in the registry
Starting with ServicePack SP80SP715, the following applies:

In addition, the CVS is controlled by a registry entry that allows you to increase the range for 
the CVS (multicasting):

HKEY_LOCAL_MACHINE\\Software\\INNOTEC\\COMOS
The DWORD entry must be as follows: CVSTimeToLive The default value is 2 so that excessive 
network traffic does not arise. 

Example: If you set the entry to the value 5, the following message is displayed in the DBMon 
at a COMOS start: 

Comos.CWSSocket: Setting IP Time-To-Live = 5 (4 Hop(s)) succeeded.
The CVS traffic by default runs over a maximum of one router. The range is changed by means 
of the above-mentioned registry entry. Valid values are all natural numbers >= 1. 

● 1 = CVS only within its own segment

● 2 = CVS over max. 1 router

● 3 = CVS over max. 2 routers, etc.

The "ptmcast.exe" test program has a TTL default value of 10.

4.6.3 Error case

Possible causes:
● TCP/IP protocol is not used

● Router is not multicast-compatible

● Multicast option of a multicast-compatible router has not been activated.
The multicast option of the router must be activated. The multicast protocol 
"IGMP Version 1" is supported. The complete network connection between two COMOS 
clients must be bidirectionally multicast-compatible, because each receiver can also be a 
sender at the same time.

This is not recognized and reported as an error by the system. The error has to be determined 
by the user by means of "ptmcast.exe".

Errors that are caused by the software of the WinSock connection:

Error Description
WSAStartup failed Winsockets cannot be initialized
WSASocket() failed Winsockets does not respond
setsockopt() SO_REUSEADDR failed WinSockets port address cannot be set
setsockopt() SO_RCVBUF failed Buffer size cannot be set
WSARecvFrom() failed Error when receiving a message

Hardware requirements / Network
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Errors that take effect on the COMOS level:

Error Description
gethostbyname failed Local computer name could not be determined
COMOS: CWSSocket::ReceiveSendLoop error Error when sending or receiving a message

4.6.4 Interaction with other programs

CVS output: DBMon
Messages from the CVS are also visible in DBMon.

Testing CVS: "ptmcast.exe"
The "ptmcast.exe" program tests the CVS.

See also Chapter Testing network segments (Page 25).

Evaluating CVS 
The CVS Monitor displays all clients that can currently be reached via the CVS and outputs 
various types of information regarding the clients and the CVS status.

4.6.5 Kernel functions for CVS
You find more information on this topic in the "Class Documentation COMOS_dll" manual, 
keyword "CVS".

4.7 Uninstalling SBM

Requirements
● You are familiar with the overview of cache technologies.

See chapter Overview of cache technologies (Page 22).

Uninstalling SBM
1. Contact Siemens Support to receive a copy of the "NewCVS.zip" file.

2. Unpack the zip file.

3. Check that you have "sysadmin" rights in the SQL target system.

Hardware requirements / Network
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4. Start a command line tool, such as "sqlcmd", in the SQL Server Management Studio.

5. Execute the following command:
sqlcmd -S <SERVERNAME> -U <USERNAME> -P <PASSWORD> -v 
DBName=<DATABASENAME> 
ScripDir="<\\Server\Share\Folder>" -i"<\\Server\Share\Folder
\XX_CleanUp.sql>"

Replace the variables in the angle brackets with your corresponding access data, names and 
paths.

4.8 Installing CVS 3G

Requirements
● You are familiar with the overview of cache technologies.

See chapter Overview of cache technologies (Page 22).

Procedure
Unlike CVS, CVS 3G is not activated automatically but must be activated by the administrator.

Parallel operation with CVS is possible.

CVS 3G is controlled by an entry in the iDB. The following SQL command sets the entry to 
activate CVS 3G: 
LC_SETTINGS:INSERT INTO LC_SETTINGS (PROPERTY, VALUE) VALUES 
(‘CVS3G_ACTIVE’, ‘TRUE’)
Also permitted:
LC_SETTINGS:INSERT INTO LC_SETTINGS (PROPERTY, VALUE) VALUES 
(‘CVS3G_ACTIVE’, ‘1’)

Technical implementation of CVS 3G
After activation, the new LC_CVS table is automatically created in the iDB; it lists the changed 
objects. Each active COMOS client retrieves the following information from this table: 

● Changed object: UID
Used to identify the objects that have to be reloaded

● Changed object: ID of the COMOS session
Each COMOS client has a unique ID for the COMOS session. This prevents reloading of 
even changed objects.

● Changed object: Time stamp
Only the currently changed objects are reloaded depending on the last own access to 
LC_CVS.

Client without active COM do not participate in CVS 3G. This means CVS 3G has a 
performance advantage over CVS. 
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Disabling CVS
Recommendation: Disable CVS when CVS 3G has been introduced for the entire operation.

See chapter Disabling CVS in the database (Page 27).

4.9 Combining several databases using merge replication

Definitions
● Global cooperation

Using multiple COMOS databases that are synchronized regularly and automatically. For 
performance reasons, the aim is for local offices to work with their own databases but for 
the contents to be shared globally. 
Global cooperation is realized in COMOS with the "merge replication" tool. Merge 
replication requires SBM.

● Global collaboration
Term used as an alternative to the term "global cooperation".
Note: The Mobile Solutions module includes a similar term, "Collaboration". Collaboration 
is not related to global collaboration with the meaning described above.

Overview
Requires SBM. Because SBM is not available in COMOS 10.2, merge replication is also not 
available in COMOS 10.2.

SBM can be applied to several databases using merge replication. With merge replication, 
several users initially work autonomously at different locations. The changes are then later 
merged into a uniform result. This chapter describes how to set up a merge replication on an 
MS SQL Server 2008 R2 SP1. 

The use of merge replication is recommended in the following situations:

● When the same data is updated by several subscribers at different times. When changed 
data is forwarded to the publisher and to different subscribers.

● When subscribers need to receive data and make changes offline. When changes are 
synchronized with the publisher and other subscribers at a later time.

● When each subscriber needs a different data partition.

● When the application only has to access the end result of the changes. Intermediate stages 
are irrelevant. 
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4.9.1 Example for a server landscape
● 5 servers

– 1 distributor

– 1 publisher

– 3 subscribers

● Servers are MS SQL Servers 2008 R2 SP1

● Servers are in one domain

● 3 domain users

– Server Agent

– Merge Agent

– Snapshot Agent

● Servers are up-to-date and have installed all the latest updates.

Note
Number of subscriber servers

You can set up merge replication with more or fewer subscribers. You must set up the same 
number of subscriptions as subscriber servers. The chapters below refer to the number of 
servers listed above.

See also chapter Setting up a subscription (Page 38).

4.9.2 Work instruction when using replication
Each location works with a subscriber database by default. Partition your data to minimize the 
number of replication conflicts. To do this, create a working layer for each location on which 
all work is performed within the locations. All locations then work with different data records.

Release the information from the working layers centrally on the publisher to make it available 
to all users. The publisher has top priority and wins any conflicts which may arise with the 
subscribers.

Users are managed centrally via the publisher.

4.9.3 Setting up the servers

4.9.3.1 Release for the snapshots
Create a release that can be accessed by all servers. 

The snapshots of the publisher database are stored in this release. The "Snapshot Agent" user 
must have full access to this release. The "Merge Agent" user only needs read access.
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4.9.3.2 Setting up the distributor

Requirement for the distributor
1. Create an "SQL Server Agent" user. The user must be directly or indirectly included in the 

following "User Rights Assignment Policies":

– Log on as a service (SeServiceLogonRight)

– Replace a process-level token (SEaignPrimaryTokenPrivilege)

– Bypass traverse checking (SeChangeNotifyPrivileg)

– Adjust memory quotas for a process (SeIncreaQuotaPrivilege)

2. Use the "Sql Server Management Studio" to assign the "sysadmin" server role to the "SQL 
Server Agent" account.

Note

You must assign the "sysadmin" server role using the "Sql Server Configuration Manager".

Rights on the distributor
● The "Merge Agent" and "Snapshot Agent" users must have the "db_owner" role in the 

"distribution" database. Select the "User Mapping" setting in the "Login Properties" window 
of the respective user to assign this role. 

● Then select the "db_owner" role under "Database role membership for: distribution". 

Setting up the distributor
1. Right-click in the "Object Explorer" context menu to open "Replication".

2. To start the "Configure Distribution Wizard", select "Configure Distribution...".

3. Click "Next" to exit the first dialog.

4. Confirm the default setting "'SQL-SVR2008-T01' will act as its own Distributor; SQL Server 
will create a distribution database and log" in the next dialog and continue with "Next"

5. In the next dialog, enter the previously configured snapshot release. Make sure that you 
enter the correct path for the Snapshot release.

6. In the next dialog, enter:

– A name for the database

– A storage location for the database

– A storage location for the log files

7. Click "Add" in the next dialog to add the publisher. The distribution server must also be 
selected as publisher due to an error in the SQL Server.

8. Enter a password in the next dialog. 
You need the password to later set up a publication.
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9. All settings are listed in the last dialog window:

Click Finish to perform actions:
 * Configure distribution
Distribution will be configured with the following options:
 * Use 'SQL-SVR2008-T01' as the Distributor.
 * Use '\\sql-svr2008-t01\ReplData' es the root snapshot folder for 
Publishers using this Distributor.
 * Store the distribution database 'distribution' in 'C:\Program Files
\Microsoft SQL Server\MSSQL10_50.MSSQLSERVE\MSSQL\Data'.
 * Store the distribution database log file in 'C:\Program Files
\Microsoft SQL Server\MSSQL10_50.MSSQLSERVE\MSSQL\Data'.
 * Allow the following servers running SQL Server to use SQL-SVR2008-T01 
as their Distributor:
   * SQL-SVR2008-T01
   * sql-svr2008-t05

 

10.Click "Finish".
The distributor is set up.

4.9.3.3 Setting up the publisher

Requirement for the publisher
1. Create an "SQL Server Agent" user. The user must be directly or indirectly included in the 

following "User Rights Assignment Policies":

– Log on as a service (SeServiceLogonRight)

– Replace a process-level token (SeAssignPrimaryTokenPrivilege)

– Bypass traverse checking (SeChangeNotifyPrivilege)

– Adjust memory quotas for a process (SeIncreaseQuotaPrivilege)

2. Use the "Sql Server Management Studio" to assign the "sysadmin" server role to the "SQL 
Server Agent" account.

Note

You must assign the "sysadmin" server role using the "Sql Server Configuration Manager".

3. The Distributor has been set up.

4. SBM has to be set up for each publisher.
Because SBM is not available in COMOS 10.2, merge replication is also not available in 
COMOS 10.2.
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Rights on the publisher
● The "Snapshot Agent" user must have the "db_owner" role in the published database. 

Select "User Mapping" in the "Login Properties" window of the respective user to assign 
this role. Then select the "db_owner" role under "Database role membership for: 
publication".

● The "MergeAgent" user must be a user in the published database but does not require any 
special properties.

Setting up the publisher
Setting up the publication

1. Click on "Objects Explorer" in the context menu and then on "Local Publications".
The "New Publication Wizard" starts.

2. Select "New Publication".

3. Select the option "Use the following server as Distributor".

4. Click "Add..." to add the distribution server.

5. Enter the password you specified when you created the distributor.

6. In the next dialog, select the database that is to be published. Confirm with "Next".

7. Select "Merge Application" as publication type in the next dialog.

8. Select the version of the SQL Server, for example, "SQL Server 2008".

9. In the next dialog, select all tables or articles you wish to publish.

10.Add the "ROWGUID" column for each table added as an article. This column identifies the 
data record.

11.Click "Next" to skip the dialog for creating filters.

12.Select the check box for "Create a snapshot immediately". 
This way a snapshot is generated right after the publisher has been set up. Create additional 
snapshots only when prompted to do so.

13.Click "Security Settings...".

14.In the new dialog, select "Run under the following Windows account:" and enter the account 
of the snapshot agent. 
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15.To establish a connection with the publisher, select the option "By impersonating the 
process account". 
This means the previously specified Windows account is used.
Alternatively, you can also use an SQL Server login. Make sure that the account has the 
appropriate access rights.

Note

The selected account, "repl_snapshot" in the example shown above, must have the 
"db_owner" property for the "distribution" database on the distribution server. The account 
must have the same property for the published database on the publisher server.

16.Confirm with "OK".

17.In the next dialog, select "Create the publication(s)" and confirm with "Next".

Hardware requirements / Network
4.9 Combining several databases using merge replication

36 Installation Manual, 03/2017 V10.2.1, A5E37082844-AB



18.Your settings are listed in the final dialog window.

The Publisher 'SQL-SVR2008-T05' will be configured with the following 
options:
 * Use 'SQL-SVR2008-T01' as the Distributor
A publication will be created with the following options:
 * Create a merge publication from database 'ComosDB92'.
 * The Snapshot Agent process will run under the 'winntnet
\repl_snapshot' account.
 * The publication compatibility level will support Subscribers that are 
servers runnig SQL Server 2008 or later.
 * Publish the following tables as articles:
   * 'COMOS_B_CDEVICE' 
   * 'COMOS_B_CDEVSYMBOL' 
   * 'COMOS_B_CLINK' 
   * 'COMOS_B_CONNECTOR'

 

– Enter a name.

– Click "Finish".

The publisher is set up.

19.Once the publication has been created, open "Publication Access List" in the properties of 
the publication. 

20.Add the users "Snapshot Agent", "Server Agent" and "Merge Agent" in the "Publication 
Access List".

4.9.3.4 Setting up subscriptions

Requirement for the subscriber
1. Create an "SQL Server Agent" user. The user must be directly or indirectly included in the 

following "User Rights Assignment Policies":

– Log on as a service (SeServiceLogonRight)

– Replace a process-level token (SeAssignPrimaryTokenPrivilege)

– Bypass traverse checking (SeChangeNotifyPrivilege)

– Adjust memory quotas for a process (SeIncreaseQuotaPrivilege)

2. Use the "Sql Server Management Studio" to assign the "sysadmin" server role to the "SQL 
Server Agent" account.

Note

You must assign the "sysadmin" server role using the "Sql Server Configuration Manager".

3. The distributor and publisher are set up.

4. SBM has to be set up for each subscriber server.
See chapter Uninstalling SBM (Page 29).
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Rights on the subscribers
● The "Merge Agent" user must have the "db_owner" role in the subscriber databases.

Note

If the databases are not created until you set up the subscription, assign the rights at a later 
time.

Setting up a subscription
1. To start the "New Subscription Wizard", open the context menu with a right-click on the 

previously created publication database in the "Object Explorer" and select "New 
Subscription...".

2. Select the previously set up publisher server and the configured publication database.

3. You specify the type of subscription in the next dialog. Select "Run all agents at the 
distributor" and confirm with "Next".

4. Next, add 3 subscriber servers. Click "Add SQL Server Subscriber...". Select an existing 
database from the drop-down menu or create new databases as target of the replication.

5. Define security settings for each of these created subscriber servers. To do so, click "..." 
in the last column of the table.
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6. Make the settings in the dialog that opens analogous to the settings of the publisher. Enter 
the account under which the Merge Agent is being run. Also enter the type of connection 
to the SQL Server.

Note

The selected user, "repl_snapshot" in the example shown above, must have the db_owner 
property in the distributor database and the subscriber database.

7. Repeat step 6 for all subscribers.

8. Once you have added the security settings for all subscriptions, close the dialog by clicking 
"Next".

9. In the dialog that opens, select the time when the Merge Agents are to be started. Select 
"<Define schedule...>" from the drop-down menu.

10.In the dialog that opens, select "Occurs every:" under "Daily frequency"  and enter "1 
minute(s)". Confirm with "OK".

11.Repeat steps 9 and 10 for all subscription databases.

12.In the next dialog, specify the time for initialization. Select "Immediately" for all subscription 
databases and confirm with "Next".

13.Assign the "Server" type to all subscribers and give each subscriber the same priority for 
conflict resolutions.
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14.In the next dialog, select "Create the subscription(s)" and confirm with "Next".

15.Your settings are listed in the final dialog window:

The subscriptions are created and initialized with "Finish".

4.9.4 Alternative setup of the replication with TSQL scripts

4.9.4.1 Requirement for the use of TSQL scripts
You have set up servers, users and rights as described in the chapter Setting up the servers 
(Page 32).

4.9.4.2 Setting up the distributor

Requirement
Run the script on the distributor server.

Before you start the script, replace the following variables:

● <DServer>: Name of the distribution server

● <DPass>: Password for the distributor

● <PServer>: Name of the publisher server

● <PathToSnapshotsFolder>: UNC path to the snapshot folder

Hardware requirements / Network
4.9 Combining several databases using merge replication

40 Installation Manual, 03/2017 V10.2.1, A5E37082844-AB



TSQL script
use master
exec sp_adddistributor @distributor = N'<DServer>', @password = 
N'<DPass>'
GO
exec sp_adddistributiondb @database = N'distribution', @data_folder 
= N'C:\Program Files\Microsoft SQL Server\MSSQL10_50.MSSQLSERVER
\MSSQL\Data', @log_folder = N'C:\Program Files\Microsoft SQL Server
\MSSQL10_50.MSSQLSERVER\MSSQL\Data', @log_file_size = 2, 
@min_distretention = 0, @max_distretention = 72, @history_retention 
= 48, @security_mode = 1
GO
use [distribution]
if (not exists (select * from sysobjects where name = 'UIProperties' 
and type = 'U ')) create table UIProperties(id int)
if (exists (select * 
from ::fn_listextendedproperty('SnapshotFolder', 'user', 'dbo', 
'table', 'UIProperties', null, null)))
EXEC sp_updateextendedproperty N'SnapshotFolder', 
N'<PathToSnapshotFolder>', 'user', dbo, 'table', 'UIProperties'
else
EXEC sp_addextendedproperty N'SnapshotFolder', 
N'<PathToSnapshotFolder>', 'user', dbo, 'table', 'UIProperties'
GO
exec sp_adddistpublisher @publisher = N'<DServer>', @distribution_db 
= N'distribution', @security_mode = 1, @working_directory = 
N'<PathToSnapshotFolder>', @trusted = N'false', @thirdparty_flag = 
0, @publisher_type = N'MSSQLSERVER'
GO
exec sp_adddistpublisher @publisher = N'<PServer>', @distribution_db 
= N'distribution', @security_mode = 1, @working_directory = 
N'<PathToSnapshotFolder>', @trusted = N'false', @thirdparty_flag = 
0, @publisher_type = N'MSSQLSERVER'
GO

4.9.4.3 Setting up the publisher

Alternative setup of the publisher with TSQL script

Requirement
Run the script on the publisher server.

Before you start the script, replace the following variables:

● <DServer>: Name of the distribution server

● <DPass>: Password for the distributor

● <Database>: Name of the database to be published

● <PubName>: Name of the publication
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● <PServer>: Name of the publisher server 

● <SUser>: Name of the snapshot user with domain (e.g.: winntnet\repl_snapshot)

● <SPass>: Password of the snapshot user

TSQL script
use master exec sp_adddistributor @distributor = N'<DServer>', 
@password = N'<DPass>'
GO
use [<Database>]
exec sp_replicationdboption @dbname = N'<Database>', @optname = 
N'merge publish', @value = N'true'
GO
-- Adding the merge publication 
use [<Database>]
exec sp_addmergepublication @publication = N'<PubName>', 
@description = N'Merge publication of database ''<Database>'' from 
Publisher ''<PServer>''.', @sync_mode = N'native', @retention = 14, 
@allow_push = N'true', @allow_pull = N'true', @allow_anonymous = 
N'true', @enabled_for_internet = N'false', 
@snapshot_in_defaultfolder = N'true', @compress_snapshot = N'false', 
@ftp_port = 21, @ftp_subdirectory = N'ftp', @ftp_login = 
N'anonymous', @allow_subscription_copy = N'false', 
@add_to_active_directory = N'false', @dynamic_filters = N'false', 
@conflict_retention = 14, @keep_partition_changes = N'false', 
@allow_synctoalternate = N'false', @max_concurrent_merge = 0, 
@max_concurrent_dynamic_snapshots = 0, @use_partition_groups = null, 
@publication_compatibility_level = N'100RTM', @replicate_ddl = 1, 
@allow_subscriber_initiated_snapshot = N'false', 
@allow_web_synchronization = N'false', @allow_partition_realignment 
= N'true', @retention_period_unit = N'days', @conflict_logging = 
N'both', @automatic_reinitialization_policy = 0
GO
exec sp_addpublication_snapshot @publication = N'<PubName>', 
@frequency_type = 1, @frequency_interval = 0, 
@frequency_relative_interval = 0, @frequency_recurrence_factor = 0, 
@frequency_subday = 0, @frequency_subday_interval = 0, 
@active_start_time_of_day = 500, @active_end_time_of_day = 235959, 
@active_start_date = 0, @active_end_date = 0, @job_login = 
N'<SUser>', @job_password = N'<SPass>', @publisher_security_mode = 1 
use [<Database>]
exec sp_addmergearticle @publication = N'<PubName>', @article = 
N'COMOS_B_CDEVICE', @source_owner = N'dbo', @source_object = 
N'COMOS_B_CDEVICE', @type = N'table', @description = null, 
@creation_script = null, @pre_creation_cmd = N'drop', @schema_option 
= 0x000000010C034FD1, @identityrangemanagementoption = N'manual', 
@destination_owner = N'dbo', @force_reinit_subscription = 1, 
@column_tracking = N'false', @subset_filterclause = N'', 
@vertical_partition = N'false', @verify_resolver_signature = 1, 
@allow_interactive_resolver = N'false', @fast_multicol_updateproc = 
N'true', @check_permissions = 0, @subscriber_upload_options = 0, 
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@delete_tracking = N'true', @compensate_for_errors = N'false', 
@stream_blob_columns = N'false', @partition_options = 0
GO
use [<Database>]
exec sp_addmergearticle @publication = N'<PubName>', @article = 
N'COMOS_B_CDEVSYMBOL', @source_owner = N'dbo', @source_object = 
N'COMOS_B_CDEVSYMBOL', @type = N'table', @description = null, 
@creation_script = null, @pre_creation_cmd = N'drop', @schema_option 
= 0x000000010C034FD1, @identityrangemanagementoption = N'manual', 
@destination_owner = N'dbo', @force_reinit_subscription = 1, 
@column_tracking = N'false', @subset_filterclause = null, 
@vertical_partition = N'false', @verify_resolver_signature = 1, 
@allow_interactive_resolver = N'false', @fast_multicol_updateproc = 
N'true', @check_permissions = 0, @subscriber_upload_options = 0, 
@delete_tracking = N'true', @compensate_for_errors = N'false', 
@stream_blob_columns = N'false', @partition_options = 0
GO
use [<Database>]
exec sp_grant_publication_access @publication = N'<PubName>', @login 
= N'<SUser>'
GO

Note

The script shown above is only an excerpt. The highlighted script block only covers the article, 
"COMOS_B_CDEVSYMBOL". The script block must be listed once again for each additional 
article of the COMOS database to be published. 

A list with the variables of the COMOS database is available in the section COMOS articles 
(Page 43).

COMOS articles
Add the required articles to the TSQL script as illustrated in section Alternative setup of the 
publisher with TSQL script (Page 41). Add the articles after "@article" and "@source_object", 
respectively. Always observe this format: 

● @article = N'<Variable>' 

● @source_code = N'<Variable>'

For example: @article = N'LC_Case'

Here is a list of all possible COMOS articles:

● COMOS_B_CDEVICE

● COMOS_B_CDEVSYMBOL

● COMOS_B_CLINK

● COMOS_B_CONNECTOR

● COMOS_B_D3

● COMOS_B_DEVICE
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● COMOS_B_DOCOBJ

● COMOS_B_DOCTYPE

● COMOS_B_DOCUMENT

● COMOS_B_PHYSUNIT

● COMOS_B_PHYSUNITGROUP

● COMOS_B_RIGHT

● COMOS_B_SPEC

● COMOS_B_SPECTSET

● COMOS_B_STANDARDTABLE

● COMOS_B_STANDARDVALUE

● COMOS_B_XOBJ

● COMOS_B_XROP

● LC_CASE

● LC_CDEIVE

● LC_CDEVSYMBOL

● LC_CLINK

● LC_CONNECTOR

● LC_D3

● LC_DEVICE

● LC_DOCOBJ

● LC_DOCTYPE

● LC_DOCUMENT

● LC_ERROR

● LC_HIERARCHY

● LC_IMPORT

● LC_LANGUAGE

● LC_LASTTIMES

● LC_NRG_ASSIGNMENTS

● LC_NUMBER_RANGE_GENERATOR

● LC_OBJREV

● LC_OVERLAY

● LC_PHYSUNIT

● LC_PHYSUNITGROUP

● LC_PICKLIST

● LC_PICKLISTENTRY
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● LC_PROJECT

● LC_PROJLOG

● LC_REMARK

● LC_RIGHT

● LC_ROOTDIR

● LC_SETTINGS

● LC_SPEC

● LC_SPECSET

● LC_STANDARDTABLE

● LC_STANDARDVALUE

● LC_USER

● LC_USERGROUP

● LC_VERSION

● LC_XOBJ

● LC_J ROP

4.9.4.4 Alternative setup of the subscriber with TSQL script

Requirement
Run the script on the publisher server.

Before you start the script, replace the following variables:

● <Database>: Name of the database to be published

● <PubName>: Name of the publication

● <SServer1>: Name of subscriber server 1

● <SDatabse1>: Name of the database on subscriber 1

● <SubUser>: Name of the Merge user with domain (e.g.: winntnet\repl_merge)

● <SubPas>: Password of the Merge user

TSQL script
use [<Database>] 
exec sp_addmergesubscription @publication = N'<PubName>', 
@subscriber = N'<SServer1>', @subscriber_db = N'<SDatabase1>', 
@subscription_type = N'Push', @sync_type = N'Automatic', 
@subscriber_type = N'Global', @subscription_priority = 75, 
@description = null, @use_interactive_resolver = N'False' 
exec sp_addmergepushsubscription_agent @publication = N'<PubName>', 
@subscriber = N'<SServer1>', @subscriber_db = N'<SDatabase1>', 
@job_login = N'<SubUser>', @job_password = N'<SubPass>', 
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@subscriber_security_mode = 1, @publisher_security_mode = 1, 
@frequency_type = 4, @frequency_interval = 1, 
@frequency_relative_interval = 1, @frequency_recurrence_factor = 1, 
@frequency_subday = 4, @frequency_subday_interval = 1, 
@active_start_time_of_day = 0, @active_end_time_of_day = 235959, 
@active_start_date = 20120101, @active_end_date = 99991231, 
@enabled_for_syncmgr = N'False'
GO

Note

The script shown above is only an excerpt for a subscriber server. The script must be executed 
once again for each additional subscriber server that is used. For additional servers, adjust 
the variables <SServer1> and <SDatabase1> to those of the respective server.

4.10 Infrastructure requirements for clients

4.10.1 Standard clients
COMOS 10.1 was developed primarily in WPF and Dot.Net. The WPF technology enables an, 
up-to-date user interface according to the newest ergonomic standards. This technology 
requires a graphic card with support of the interface by the hardware. 

The total performance of the application increases significantly when you use a dual-core 
processor with sufficient RAM. 

Technical background
Approx. 512 MB RAM are sufficient for Windows XP. For this reason we recommend 4 GB 
RAM as main memory for Windows 7. Common PCs make about 3.5 GB of this memory 
available to the operating system. This covers the additional memory requirements for 
Windows 7. 

Hardware for standard clients
● Random Access Memory (RAM) 

2 GB RAM

● Processor 
Dual core CPU > 2.46 GHz (Athlon X2 5xxx or Intel E7xxx)
Additionally recommended: Quadcore CPU

● Hard disk
SATA hard disk, approx. 2 GB free storage memory

● Graphic card
Graphic card with 1 GB memory and DirectX 9.0c
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● Network 
100 Mbit Ethernet

● Operating system 
Windows

4.10.2 Citrix clients
Either Thin Clients or PCs in a simple basic configuration are used for COMOS. 

Hardware for Citrix clients
● RAM

512 MB RAM

● Processor
2 GHz CPU

● Hard disk
SATA hard disk

● Graphics card
Separate graphics card with medium performance characteristics
Current recommendation: Use the same graphics card that is recommended in the standard 
client.

● Network

– At least a 1 Mbit bandwidth and latent times below 50 ms.

– In the current use, peak demands remain slightly below 1 Mbit. Also take 3 Mbit lines 
into consideration for future infrastructure planning.

– Recommendation: 100 Mbit Ethernet or WAN-enabled network interfaces

● Peripherals
One or two monitors with 1280 x 1024 resolution
For 1680 x 1050 resolution in dual-monitor operation on Citrix you must reduce the color 
depth to 16-bit.

● Operating system
See also section Compatibility matrix (Page 15).
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4.11 Infrastructure requirements for servers

4.11.1 Database server prerequisites

Supported database systems
● Microsoft SQL Server

● Oracle

● Microsoft Access database files
Only Microsoft SQL Server and Oracle are considered below. 

● Supported versions for Oracle and Microsoft SQL Server:

– 32-bit version

– 64-bit versions

For professional use, Microsoft SQL Server or Oracle is recommended. The use of a local 
Access DB is only practical for test purposes.

Hardware requirements for initial configuration
We recommend the following hardware features for Microsoft SQL Server and Oracle:

● RAM
8 GB as standard for databases

● Processor
CPU >= 2 GHz, dual core for > 10 users
Recommendation: Calculate one CPU core for every 20 registered users.

● Network
1 Gbit Ethernet

● Hard disk
Initial size of a COMOS database with SQL: approx. 2-3 GB 

● Data backup
Back up your databases regularly.

Microsoft SQL Server 
COMOS works seamlessly together with a hot standby cluster configuration on the Microsoft 
SQL Server. 

Comparison of the servers 
COMOS achieves a significantly higher performance with database-dependent operations by 
using Microsoft SQL servers. 
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Storage space requirements 
The increase in size of the database file depends on how many new objects and documents 
are created. 

● Microsoft SQL Server
Large COMOS installations with 100 clients can reach a database size of 100-500 GB on 
a Microsoft SQL Server after 5 years of operation.

● Oracle
Under Oracle the storage space is managed differently. Here the database files are 50-75% 
smaller when compared to the Microsoft SQL Server.

Large installations
No recommendation is made for the design of a database server which supports hundreds or 
thousands of concurrent users and databases exceeding a volume of 100 GB. The design of 
a database server is customer-specific and depends on the product portfolio which you can 
access from your hardware vendor.

Requirements for the COMOS Mobile Solutions 1.0 solution
See chapter Software requirements for COMOS Mobile Solutions (Page 19).

4.11.2 File server
The file server has to provide a release for all users of the database. This release is realized 
by means of a file server or an appropriate NAS device. NAS devices have to support "DSO 
file properties". 

Hardware for a file server 
● RAM

4 GB RAM

● Processor
2 GHz CPU

● Hard disks
Hard disks for COMOS documents as Raid 1, Raid 5 or NAS.

● Network
1 Gbit Ethernet

● File system
NTFS file system for COMOS documents

● Operating system
Any
Recommended: Windows Server 2008 R2

As delivered, the COMOS document directory contains less than 1 GB of data. 

Hardware requirements / Network
4.11 Infrastructure requirements for servers

Installation Manual, 03/2017 V10.2.1, A5E37082844-AB 49



4.11.3 Licence server
The license server has few requirements regarding the hardware. 

A PC with standby backup is sufficient. COMOS clients bridge a downtime of up to 10 minutes.

The license server runs with an Aladdin Hardlock USB dongle and license files. Dongles for 
single-station licenses are also possible. 

Hardware for a license server 
● Operating system: Windows Server 2008 R2, Windows Server 2012

● RAM: 4 GB

● Processor
2 GHz CPU

● Network
Ethernet 100 Mbit

● Hard disks
SATA hard disk

● Peripherals
One free USB port.

To also run in VMWare, the license server requires a dedicated USB port (VMWare 7) or a 
dongle server (AnywhereUSB).

AnywhereUSB with Multihost option
A second backup license server including backup dongle and license file can be installed for 
the license server.

4.11.4 COMOS Web
COMOS Web provides a part of the functional scope of COMOS via an integrated Web server. 
A Web browser as a client is sufficient.

Hardware for COMOS Web
● RAM

4 GB RAM

● Processor
Quad-Core, 2 GHz

● Hard disks
2x 74 GB mirrored hard disks

● Network
1 Gigabit Ethernet

Hardware requirements / Network
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● Graphic
Onboard graphic is sufficient

● Operating system
See also section Software requirements for COMOS Mobile Solutions (Page 19).

Additional resource requirements under COMOS Web
The specified resources are sufficient for 10 users. Additional resources are needed for more 
users.

● Per user: approx. 300 MB RAM

● Per user ca. 20% of a CPU core

Hardware for COMOS DocumentView
An additional installation of SharePoint is required for COMOS DocumentView.

● Processor
Quad-Core

● RAM
8 GB RAM

4.11.5 COMOS Enterprise Server
The COMOS Enterprise Server is responsible for data import/export from external data 
sources. The data is transported by means of XML files. Data are automatically transferred 
from SAP, for example.

Hardware for a COMOS Enterprise Server (1-2 instances) 
● RAM

4 GB RAM

● Processor
Dual core CPU 2 GHz

● Hard disks
2x 74 GB mirrored hard disks

● Network
1 Gigabit Ethernet

● Graphic
Onboard graphic is sufficient

● Operating system
Windows Server 2008 R2 SP1, Windows Server 2012

Hardware requirements / Network
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Additional resource requirements under COMOS Enterprise Server 
The COMOS Enterprise Server can be operated in multiple instances. A CPU core is almost 
fully utilized by one instance when extensive data amounts are imported. In addition, up to 2 
GB of storage per instance is required. The required memory depends on the amount of data 
to be imported and the number of operations conducted on the data. 

For extensive import procedures, provide one CPU core per instance and 2 GB of RAM.

See also
Enterprise Server (Page 19)

4.11.6 Citrix server
● RAM 

– At least 4 GB RAM

– Depending on the number of users 8 to 16 GB RAM
See further below for additional information about the resource requirements.

● Processor
Quadcore CPU 3 GHz

● Hard disks
2x 74 GB mirrored hard disks

● Graphic
Onboard graphic is sufficient

● Network 
Gigabit Ethernet

● Operating system
See chapter Compatibility matrix (Page 15).

Additional resource requirements for the server under COMOS 
● Per standard user 500 MB RAM.

● Per power user 1 GB RAM.

● A separate CPU core for every 3-4 users.

The WPF interface of COMOS supports multithreading for interface rendering. Here, at least 
4 CPU cores with the highest performance are required for the basic equipment of the server. 

Hardware requirements / Network
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Preparing logon to network and database 5
5.1 Definition of the three types of logins for COMOS users

Working locally
If you are working with an Access DB which is available locally on the computer, you do not 
require any network rights. 

Storage structures in a client/server structure
Standard workflow: 

● The individual users have installed the COMOS software on their PCs ("workstations"). The 
user is not an administrator, neither on the PC nor in the network.

● The data is managed centrally in the network. Thus, the PCs of users are "clients" and 
access a common "server". Take the following information into account:

– Everything that is referred to as an "object" in COMOS originates from the actual 
database. 
The server on which the COMOS database is located is called the "database server".

– Everything that considered a "Document" or "File" in COMOS is stored independently 
as a physical file and saved in the "Document folder". 
The document folder is located on the database server or on a separate server. If the 
document folder is located on a separate server, this server is called the "document 
server" or "file server".

Types of login when working with a client/server structure
When working with a client/server structure, the following logins are required: 

1. Client login at the database server
To do this, a kind of "network user", a so-called "System DSN", must be set up on the client 
in the "ODBC data sources administrator".
See also Chapter Database server login using DAT password file (Page 58).
The counterpart to this occurs in the user management of the database server: there, a 
user is set up with exactly the same name as the login ID of the "System DSN" on the client. 
This user then gets the required rights to the database server. 

2. Login to the file server
The required rights on the file server are given to the user of the workstation. 

3. Login to COMOS, the "COMOS login"
Only at this point does the COMOS rights administration take effect.

See also
Securing network access with network login (Page 61)
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5.2 Administering an ODBC data source for an SQL client

Purpose of the ODBC entry
● The ODBC entry serves as the basis for a number of values that are needed at another 

point. Data communication no longer takes place via the ODBC connection but instead via 
ADO.

● You can enter ODBC connections in either the system DSN or the user DSN. The difference 
is that, with the system DSN, the entries you make are valid for all workstation users. Entries 
in the user DSN are only valid for the specific user who has created them.

● COMOS reads the user DSN entries and then the system DSN entries. If an entry exists 
in the user DSN, only this entry appears in the database selection.

Creating an ODBC data source
● Windows 64-bit

Open "Start > Run" in the Windows menu and enter the following path: "%WINDIR%
\syswow64\odbcad32.exe".

● Windows 32-bit
Open "Start > Settings > Control Panel > Administration > Data sources (ODBC)".

1. Click the "Add" button in the "User DSN" tab.

2. Select the driver from the "SQL Server" list.

3. Click the "Finish" button.

"Microsoft SQL Server DSN configuration" window
The "Microsoft SQL Server DSN configuration" window opens. The configuration assistant 
guides you through the process of creating an ODBC data source.

1. Make the following settings:

– "Name" field: pt_sql_server
To create additional ODBC data sources, see the section below "Creating additional 
instances for SQL access".

– "Description" field: You can enter optional text here.

– "Server" list: <Name of the SQL Server in the network>

2. Click "Next >".
The next window is used to authenticate the client.

Preparing logon to network and database
5.2 Administering an ODBC data source for an SQL client

54 Installation Manual, 03/2017 V10.2.1, A5E37082844-AB



3. Make the following settings:

– Alternative 1: Activate the "With Windows NT authentication based on..." option
See chapter Windows NT authentication for SQL client (Page 56) for more on this.

– Alternative 2: Activate the "With SQL Server authentication based on...": option
See chapter Database server login using DAT password file (Page 58) for more on this.

– "User name" field: Freely selectable

– "Password" field: Will not be evaluated

Note that for compatibility reasons, the user name "COMOS" or "comos" is not available. 
If you use this login ID, COMOS attempts to log in without a password.

4. Click the "Client configuration" button.

– Activate the TCP/IP options.

– Click "OK".

– Click "Next".

5. Activate the option "Change ComosDB to".

– Select your ComosDB from the list.

– Click "Next".

6. Click the "Finish" button.
In the "ODBC Microsoft SQL Server Setup" window, all the data source settings are listed.

7. Click the "Test data source ..." button.
In the "SQL Server ODBC data source test" window, the following message is displayed: 
"TESTS COMPLETED SUCCESSFULLY".

Creating additional instances for SQL access
Instances for the SQL Server must observe the following naming system:

● Name: pt_sql_server
Description: Any 

● Name: pt_sql_server_<unique character string>
Description: Any

● Name: pt_sql_server_3
Description: Any 
An instance with this name deviates from the rule: COMOS does not save a password file 
or DAT file. See chapter Database server login using DAT password file (Page 58) for more 
on this.

Changing the ODBC connection
If the "User DSN"/"System DSN" is changed, the DAT file might not be updated. 

In this case, delete the DAT file manually. Then create a new DAT file and distribute it.

Preparing logon to network and database
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5.3 Windows NT authentication for SQL client

Requirements
● You are familiar with the administration of the ODBC data source for the SQL client.

See chapter Administering an ODBC data source for an SQL client (Page 54).

Aim
The Windows NT authentication does not use a separate input of a user password. This means:

● Without DAT password file: 

– Login with the account that is also logged in to the PC

– No password query

– DAT password file is not created

● With DAT password file: The existing DAT password file is not evaluated.

The current user account on the client must have the following rights to access the COMOS 
database with Windows NT authentication:

● Creating saved procedures

● Editing datasets in all tables of the database (create, edit, delete)

● Read access to the system tables

The standard schema of the user in the database system must correspond to the schema of 
the COMOS database.

Exceptions
● NetLogin

Windows NT authentication and NetLogin cannot be used simultaneously.

● TranslateDB
The COMOS function "Translation database" cannot be used.

● COMOS Maintenance
The COMOS Maintenance plugins cannot be used.

● COMOS version older than 10.1.3.2.0

● SQL Server older than SQL Server 2012

Preparing logon to network and database
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5.4 Administering an ODBC data source for an Oracle client

Purpose of the ODBC entry
● The ODBC entry serves as the basis for a number of values that are needed at another 

point. Data communication no longer takes place via the ODBC connection but instead via 
ADO.

● You can enter ODBC connections in either the system DSN or the user DSN. The difference 
is that, with the system DSN, the entries you make are valid for all workstation users. Entries 
in the user DSN are only valid for the specific user who has created them.

● COMOS reads the user DSN entries and then the system DSN entries. If an entry exists 
in the user DSN, only this entry appears in the database selection.

Creating an ODBC data source
● Windows 64-bit

Open "Start > Run" in the Windows menu and enter the following path: "%WINDIR%
\syswow64\odbcad32.exe".

● Windows 32-bit
Open "Start > Settings > Control Panel > Administration > Data sources (ODBC)".

1. Click the "Add" button in the "User DSN" tab.

2. Select the required driver from the list. Important: Use "Microsoft ODBC driver for Oracle" 
and not "Oracle ODBC driver".

3. Click the "Finish" button.

"Microsoft ODBC for Oracle configuration" window
The "Microsoft ODBC for Oracle configuration" window opens. The configuration assistant 
guides you through the process of creating an ODBC data source.

1. Make the following settings:

– "Data source name" field: pt_oracle
To create additional ODBC data sources, see the section below "Creating additional 
instances for SQL access".

– "Description" field: You can enter optional text here.

2. "User name" field: The Oracle user name on the server
Corresponds to the database name

3. "Server": <Net Service Name> field.
This is the name that has been assigned with the Net Configuration Assistant.

Click "OK" to confirm. The system data source is now displayed in the list in the "System DSN" 
tab.

Creating and distributing a DAT file
See chapter Database server login using DAT password file (Page 58).
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Creating additional instances for Oracle access
Additional instances for the SQL Server must observe the following naming system:

● Name: pt_oracle
Description: Any 

● Name: pt_oracle_<unique character string>
Description: Any

● Name: pt_oracle_3
Description: Any 
An instance with this name deviates from the rule: COMOS does not save a password file 
or DAT file. See chapter Database server login using DAT password file (Page 58) for more 
on this.

Changing the ODBC connection
If the "User DSN"/"System DSN" is changed, the DAT file might not be updated. 

In this case, delete the DAT file manually. Then create a new DAT file and distribute it.

5.5 Database server login using DAT password file

Requirements
● An ODBC data source exists

– See chapter Administering an ODBC data source for an SQL client (Page 54).

– See chapter Administering an ODBC data source for an Oracle client (Page 57).

Access via a DAT file
COMOS uses a System DSN to find a data source. However, the login ID and password are 
normally taken from an encoded DAT file and not from the System DSN. Advantages:

● You do not have to enter the password every time you log in.

● You can use any user name and are not restricted to the user name "COMOS".

You can change the password later for all clients by replacing the DAT file. See also chapter 
Distributing a DAT file (Page 64).

The user logs into COMOS as usual. 
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Procedure
To set up automatic access to the database server, proceed as follows:

1. Install the database server and the clients.

2. Create a system DSN on a client as follows:

– Start COMOS in the operating system with the option "Run as administrator".
This ensures that the password file is generated at the correct point. 

Note
Normal operation of COMOS

Do not start COMOS in normal operation with the option "Run as administrator".

– Log into COMOS on the same PC.

– Browse for the system DSN.
Since a DAT file does not exist at this moment, the login window for the login to the 
database server appears in COMOS.

– Enter the login ID and password in the login window.
If COMOS logs into the database server with this information, it automatically generates 
an encoded DAT file. This DAT file is independent of the station.

– Create the System DSN for all other clients.

– Distribute the DAT file that has been created.

The login window in COMOS is circumvented and the users work without having to enter a 
password.

Automatically creating a DAT file
When a server database is opened and an instance does not exist yet, a DAT file is created.

Note
Instance 3

For instance 3, there is no DAT file. Therefore a password query is always displayed at instance 
3.

Windows NT authentication without password
Windows NT authentication is available for SQL Server. A password is not entered with this 
method. See chapter Windows NT authentication for SQL client (Page 56).

Preparation:

● Create a Windows group of all the COMOS users on MS SQL Server

● The standard scheme "dbo" is assigned to the Windows group.

● The Windows group is provided access to the COMOS database through the "db_owner" 
profile

Preparing logon to network and database
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See also
Securing network access with network login (Page 61)

5.6 Preparing network login: Configuring the operating system

Purpose
With Network Login, an additional account is set up which performs the login on the network 
as a proxy of the COMOS user. See chapter Aim of the network login (Page 61) for more on 
this. 

In the case of operating systems older than Windows Server 2008 security policies have to be 
adjusted before this procedure is permitted. 

If Network Login is not supported by the operating system, adjust the following local security 
policies:

1. In the Windows Start menu, select the command "Settings > Control Panel > Administration 
> Local Security Policy".

2. Select the folder "Security Settings > Local Policies > User Rights Assignment".

"Act as part of the operating system" policy
1. Open the properties of the "Act as part of the operating system" policy.

2. Click "Add".

3. Add "Everyone" to the list at the bottom.

4. Confirm twice with "OK" and close all open windows.
The policy has now been changed.

"Replace a process level token" policy
COMOS must be authorized to call the operating system function CreateProcessAsUser. 
For this purpose, the "Replace a process level token" policy must be changed:

1. Open the properties of the "Replace a process level token" policy.

2. Enable the policy for all users that use COMOS.
You can also make an entry in the "Everybody" list at the bottom.

3. Confirm twice with "OK".

"Create a token object" policy
The "Functional account" that was set up for anonymous data access must be entered here.

If your administrator has defined policies for the domain that overwrite these local policies, 
then the changes to the local security policies will not take effect. In this case, the administrator 
must modify the domain-level security policies accordingly.
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5.7 Securing network access with network login

5.7.1 Aim of the network login

Requirement
● The various logins are clear.

See Chapter Definition of the three types of logins for COMOS users (Page 53).

Aim
The "network login" function restricts the direct (COMOS-independent) access to the document 
directory of a COMOS project. Network login is available for:

● Oracle

● MS SQL Server

Other functions which protect document access
External documents can also be protected using the "Check out" and "Check in" functions. 
You can find more information on this topic in the "Administration" manual, keyword 
"Configuring external editing of documents".

See also
Overview of the network login sequence (Page 61)

5.7.2 Overview of the network login sequence

Requirements
● You understand the purpose of the network login. 

See Chapter Aim of the network login (Page 61).

Operational principle of network login
In addition to the COMOS user logins, a domain user is also created. When the network folder 
containing the COMOS documents is accessed from COMOS, the system switches 
automatically to the domain user. Once the folder has been accessed, the system switches 
back to the user that is logged into the station. Outside of COMOS, access to the network 
folder containing the COMOS documents can be prevented.

Preparing logon to network and database
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Rights concepts for network access
You can set up network access for COMOS users via Network Login in the following ways:

● User
Set up a Network Login user with full access and grant the "List folder content" right to the 
individual COMOS users. This procedure is recommended for security reasons for "normal" 
users.

● User acting as a local administrator
You assign the rights "Read, Write, Change, Delete" for the COMOS document directory 
to some COMOS users.

Network access using UNC address 
Use the UNC address to address the document directory of the database.

Correct: \\<Server_name>\<COMOS_document_directory> 

Incorrect: O:\<COMOS document directory>

See also
Protected login names (Page 62)

COMOS rights relating to network login (Page 63)

Calling up the Network Security Configuration Tool (Page 63)

5.7.3 Protected login names

Requirements
● You understand the network login overview.

See Chapter Overview of the network login sequence (Page 61).

Names with a fixed meaning
For compatibility reasons, the user name "Comos" or "comos" is not available. If you use this 
name, COMOS attempts to login without a password.

See also
Calling up the Network Security Configuration Tool (Page 63)
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5.7.4 COMOS rights relating to network login

Requirements
● You understand the network login overview.

See Chapter Overview of the network login sequence (Page 61).

Access via script 
For security reasons, COMOS users are not allowed to have scripting rights. To turn off the 
scripting rights, deactivate the "Object debugger" function right in COMOS.

See also
Calling up the Network Security Configuration Tool (Page 63)

5.7.5 Calling up the Network Security Configuration Tool

Requirements
● You understand the network login sequence.

See Chapter Overview of the network login sequence (Page 61).

Overview
The "Network Security Configuration Tool" is used to store the domain user for the network 
login.

Procedure
1. Open the application "NetLogin.exe" under "<Installation directory>\Comos\<COMOS 

Version directory>\BIN".
The "Network Security Configuration Tool" window is opened.

2. Select a database.

3. Enter the login information in the "Database user name" and "Database password" fields.

4. Click the "Edit configuration data" button.
If you are entitled to carry out configuration, the following fields are displayed.

– "Domain"

– "User name"

– "Password"

5. Enter the information of the domain user in these fields.

6. Click "OK".
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See also
Distributing a DAT file (Page 64)

5.7.6 Distributing a DAT file

Requirements
● You are familiar with the Network Security Configuration Tool.

Calling up the Network Security Configuration Tool (Page 63)

● You are familiar with the login using a DAT password file.
See chapter Database server login using DAT password file (Page 58).

Name of the configuration file
The configuration data is saved in a configuration file:
<xxx>PWD<n>.DAT 
Depending on the database system used, <xxx> has either the value ORA (for Oracle) or 
SQL (for MS SQL Server).

<n> represents the instance used (blank stands for the default instance, otherwise "_1" or 
"_2"). 

Filing place of the configuration file
As of COMOS 9.0: "<COMOS installation directory>\Config"

Examples
ORAPWD.DAT
SQLPWD_1.DAT.
You can either repeat the configuration settings for each COMOS installation or distribute the 
DAT file to the various installations.

5.7.7 Reestablishing access to connected network drives

Overview
For safety reasons, a setting was changed for Microsoft. With the following operating systems, 
the ProtectionMode key is entered and activated:

● Windows Server 2003

● Windows XP SP3

Preparing logon to network and database
5.7 Securing network access with network login

64 Installation Manual, 03/2017 V10.2.1, A5E37082844-AB



Effect
This has an effect on updates and upgrades. In some cases, existing software environments 
may no longer work.

Connected drives may no longer be visible to other users. This also means that encapsulated 
access to the COMOS document folder no longer works. 

You can no longer use the network login if you install one of the following operating systems 
on a computer and retain the default settings:

● Windows Server 2003

● Windows XP SP3

This is also the case when you update an existing operating system to one of the listed 
operating systems and retain the default settings.

Note

Please test updates and upgrades of Microsoft operating systems in a protected environment 
first before changing productive environments.

Procedure
In order to use the network login again, change the following key in the registry and then restart 
the PC:

HKEY_LOCAL_MACHINE \SYSTEM\CurrentControlSet\Control\ SessionManager
\ProtectionMode
Default: ProtectionMode = 1
Set to: ProtectionMode = 0
If this key was manually entered for an operating system other than those mentioned above, 
it must be set to "0 there, too.

Case study
Citrix server based on Windows Server 2003:

● ProtectionMode is set to "1" by Windows Server 2003.

● To use network login, the user sets ProtectionMode back to "0".

The user profiles saved on the Citrix Server can no longer be used as they cannot be loaded 
onto the Clients during login.

If you switch to ProtectionMode = 1, the original status is restored. You can then no longer 
use network login.
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5.8 Programming extensions for network login

5.8.1 Class IComosDAutoNetworkLogin

Constructor/destructor
● Constructor 

In the constructor of this object, the system automatically switches to the correct user for 
the requested file access.

● Destructor 
The system automatically switches back to the user who started the COMOS application.

5.8.2 Class IComosDWorkset

Function NetworkLogin

Function NetworkLogin(  
 FileName As String, _
 FileAccessMode As Long) As IComosDAutoNetworkLogin

Generates a new IcomosDAutoNetworkLogin object. 

This function must always be called before accessing a file. The IcomosDAutoNetworkLogin 
object that is returned must be destroyed directly after opening the file. Access rights are 
preserved until the file is closed.

FileName Name of the file (full path) that is to be accessed.
FileAccessMode Mode for the requested file access.
NetworkLoginDefault (0): Read access
NetworkLoginRead (1) Read access
NetworkLoginWrite (2) Write access
NetworkLoginReadWrite (3) Read and write access
NetworkLoginAppend (8) Append to a file

Note
FileAccessMode is not analyzed at present, but is provided for a future use and therefore must 
always be set correctly. 

The constants correspond to those of the FileSystemObject of the operating system.

Preparing logon to network and database
5.8 Programming extensions for network login

66 Installation Manual, 03/2017 V10.2.1, A5E37082844-AB



5.8.3 Interaction between network login and XStdMod.Dll

Function ComosOpenTextFile
Creates a new text file. The user is switched before creating the file. The parameters and their 
meaning are the same as for FileSystemObject.OpenTextFile.

Function ComosOpenTextFile (  
 ByVal Filename As String, _
 Optional ByVal Mode As IOMode = ForReading, _
 Optional ByVal Create As Boolean = False, _
 Optional ByVal Format As Tristate = TristateFalse) As
TextStream  

Function ComosCopyFile
Copies the file specified in SourceFilename to TargetFilename. If the file TargetFilename 
exists, it is overwritten if Overwrite has the value True. 

Function ComosCopyFile(  
 ByVal SourceFilename As String, _
 ByVal TargetFilename As String, _
 ByVal Overwrite As Boolean) As Boolean

5.8.4 Interaction between network login and COMOS.dll

Access for COMOS.dll to the document folder
The following applies to all methods from the COMOS.dll that access the COMOS document 
folder:

These methods have been implemented in such a way that they carry out the Network Login 
automatically. When a software developer calls such a method, the developer does not need 
to worry about the Network Login, the method does this for him.
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Notes about backup and restoration 6
6.1 Disclaimer

Data backup is the sole responsibility of the COMOS licensee. Siemens AG does not offer any 
guarantee or accept any liability in connection with backup and recovery. The following 
information is non-binding and intended only to provide assistance.

6.2 Split COMOS data
COMOS data consists of two components:

● The actual database in which information regarding the COMOS objects and all 
administrative information is stored.

● An associated document directory in which the report files are stored.

In case of an MS Access database, the database (MDB file) and document directory are located 
next to each other in a directory on a file server.

In the case of server databases (MS SQL or Oracle), in the interest of performance you should 
use two separate server systems: a database server and a file server for the documents.

6.3 COMOS data backup

Shared backup time of both data components
To ensure data consistency, back up the database and the document directory at the same 
time. Do not carry out any work in the database from the moment the backup process starts 
until it has been completed.

Consequently, although the backup process is not critical for Access databases, by contrast 
server databases usually involve the use of different backup mechanisms (file backup of the 
documents, database backup by agents, dumps, etc.).

6.4 Database accessibility
In order to increase the availability of the database, you can resort to familiar redundancy 
mechanisms such as mirroring of hard disks or servers. Remember to duplicate both the 
database and the document directory.

COMOS supports Microsoft cluster services for SQL Server 2005 and Veritas cluster services 
for Oracle, enabling you to achieve system stability for the database via a hot standby cluster 
configuration. In case of a failure of a cluster node the previously inactive cluster node takes 
over the work. You will need to restart any database operations that were already in progress, 
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e.g. the creation of an evaluative report. The cluster services only mirror the database 
functionality, not the Random Access Memory/CPU of the database server.

6.5 Backup of the CLS data
The COMOS license server stores information regarding the current license usage in the 
subdirectories "\data" and "\license". The location of the directory usually is a subdirectory of 
the installation location of the CLS. You also have the option of specifying a folder on the 
network during installation.

Back up these directories to retain the original user mapping of the Named User Licenses 
following a restore operation or after the license server has been reinstalled.

6.6 Specifying the data backup and restore strategy

Requirement
See also section COMOS data backup (Page 69).

Recommendation
Use additional servers for all critical systems in order to increase availability during operating 
and maintenance periods. See also section Database accessibility (Page 69).

Regular backup
If you carry out a regular backup, the data loss in the event of a malfunction corresponds to 
the work that you have carried out since the last backup.

● Complete backup
Carry out a complete backup of the file and database servers once a week during a period 
when the work load is low, for example, at night or at the weekend.

● Incremental backups
Carry out backups of the file and database servers twice a day, for example, at noon and 
in the evening. If you work with COMOS 24 hours a day, carry out a backup more frequently, 
for example, every four to six hours. Both backups must run simultaneously.

Continuous backup
If you carry out backups continuously, the data loss in the event of a malfunction corresponds 
to the work that you carried directly before the malfunction.

● Complete backup
Carry out a complete backup of the file and database servers once a week during a period 
when the work load is low, for example, at night or at the weekend.

● Continuous incremental backups of the file and database servers.
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Access databases
The method supported by COMOS of exporting databases as Microsoft Access databases is 
not a backup strategy. Database exports have the purpose of making planning projects with 
the corresponding base and system projects available offline.

See also
Split COMOS data (Page 69)

Notes about backup and restoration
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COMOS License Management (COMOS LM) 7
7.1 Overview of COMOS LM

Aim
COMOS is based on a client-client network, and for this reason all COMOS clients are 
technically equal. Every COMOS client can provide its own license (local license). Citrix 
solutions and similar work environments are excluded in this case. COMOS License 
Management (COMOS LM) is not required in a system of clients with local licenses

COMOS License Management is absolutely required if central licenses are intended to be 
used.

COMOS License Management is a collection of software tools and workflows that are provided 
along with the central licenses for COMOS. They also support mixed systems including local 
licenses. COMOS LM has the following general conditions:

● The COMOS clients use the same protocols and ports, see section Protocol and ports of 
COMOS LM (Page 74).

The hierarchy of COMOS LM components
1. COMOS License Server Service (COMOS LS Service)

COMOS LS Service is a Windows service and starts the COMOS License Server Process.

2. COMOS License Server Process (COMOS LS Process)
COMOS LS Process is the license management itself. Informally the COMOS LS Process 
is referred to as the "license server". When COMOS LS Process is active and set up, 
COMOS can be used. 
COMOS LS Process is controlled by means of configuration files. The key issues can also 
be controlled via COMOS License Server Monitor.

3. COMOS License Server Monitor (COMOS LS Monitor)
COMOS LS Monitor controls the key functions of COMOS LS Process. Administrator rights 
are required for COMOS LS Monitor.

4. COMOS License User Manager (COMOS LUM)
COMOS LUM is used to manage the users, user groups and license types of COMOS LS 
Process. No administrator rights are required for COMOS LUM.

5. COMOS Remote License Supplier (COMOS RLS)
COMOS RLS is launched on the Citrix client. The Citrix client launches a Citrix session on 
the Citrix server. 
COMOS RLS recognizes a local license on the Citrix client and logs on to a license server 
(COMOS LS Process). COMOS is then launched in the domain of the Citrix server, but the 
license is provided by the Citrix client.

6. COMOS Remote ICA (COMOS RICA)
A predecessor COMOS RLS technology. For reasons of compatibility, COMOS RICA is 
still supported, but it is no longer supplied.
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You will find a detailed overview of the components and the associated configuration files in 
section Overview of the software modules in COMOS LM (Page 75).

Packages that can be installed in COMOS LM
The following installation packages are available: 

● COMOS LS
The setup for COMOS LS includes the following components:

– COMOS LS Service

– COMOS LS Process ("license server")

– COMOS LS Monitor (integrated application)

● COMOS License User Manager

● COMOS LS Monitor (single application)

● COMOS Remote License Supplier

All packages that can be installed have their own version number, see section Version details 
for the software in COMOS LM (Page 78) in this connection.

License management without dongle
For license management without the use of dongles, use the function COMOS LS Host-ID.

See section Dongle-free license with COMOS LS Host-ID (Page 167).

User interface language
All COMOS LM interfaces are in English.

Storage location of the license files
You will find the storage location rules and the naming system for the license files in section 
Storage location and name of license files (Page 79).

7.2 Protocol and ports of COMOS LM

Requirement
● You are familiar with the COMOS LM overview.

See section Overview of COMOS LM (Page 73) for more on this.
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Procedure
Both on the client and on the server PC, the following must be enabled: 

● HTTP protocol

● Port

– Client configuration of the port / configuration of the RemoteLicenseService port
"Comos.LicenseLib.config" file
Key: <setting key="ComosLicenseServerPort" value="27011" />
Default: 27011 
This value is also used in the case of a missing key, empty value, or a missing 
"Comos.LicenseLib.config" file. 

– Server and monitor configuration of the port:
File: "ComosLSCommon.config"
Node: <appSettings> 
Key: <add key="ComosLicenseServerPort" value="27011" />
Default: 27011 
This value is also used in the case of a missing key or an empty value. 

– User Manager configuration of the port:
File: "ComosLicenseUserManager.exe.config"
Node: <appSettings> 
Key: <add key="ComosLicenseServerPort" value="27011" />
Default: 27011 
This value is also used in the case of a missing key or an empty value. 

You will find a detailed list of the available configuration files and their purpose in section 
Overview of the software modules in COMOS LM (Page 75).

Information about domains
Cross-domain structures are also supported by COMOS clients and license servers.

Heartbeat / runtime check
When a COMOS client receives a license from the license server, a reply ("Heartbeat") is sent 
from the client to the COMOS license server periodically in two minute intervals. 

See Chapter Runtime check/ Heartbeat (Page 89).

7.3 Overview of the software modules in COMOS LM

Requirement
● You are familiar with the COMOS LM overview.

See section Overview of COMOS LM (Page 73) for more on this.
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General information about "config" files
All "config" files mentioned in the remainder of this manual are XML files.

Do not change the order of entries in the XML config files. This especially applies to 
"ComosLSCommon.config".

Crossover config files
● "ComosLSCommon.config"

This file is configured during the installation process and read by "ComosLS.exe" and 
"ComosLicenseServerMonitor.exe". 
See also Chapter Reference for ComosLSCommon.config (Page 88).

COMOS LS Service
Application purpose: Starts the license server process.

● "ComosLSService.exe"
The assigned Windows service launches and terminates the "ComosLS.exe" file. 

● "ComosLSService.exe.config"
Contains the path to the "ComosLS.exe" file. This "config" file is created automatically 
during the setup and you do not change it.

COMOS LS Process
Application purpose: Assigns and monitors the licenses.

● "ComosLS.exe"
The file does not launch itself. Double-click or Return are not possible. Instead, the file is 
controlled from the COMOS LS Service.
See also Chapter Administering central licenses (Page 81).

● "ComosLS.exe.config"
Contains various types of administrative information. This "config" file is created 
automatically during the setup and you do not change it.
See also Chapter Reference for ComosLS.exe.config (Page 84).
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COMOS LS Monitor
Application purpose: COMOS LS Process interface. 

● "ComosLicenseServerMonitor.exe"
When you launch the file, the "Server Monitor" dialog box opens. The "Server Monitor" is 
used for the following actions:

– Starting and closing the license server

– Managing the licenses in the company network.

Various views of the available licenses and the licenses currently in use are provided. You 
can terminate the "Server Monitor" without affecting the license server.
See also Chapter Using COMOS License Server Monitor (Page 116).

● "ComosLicenseServerMonitor.exe.config"
See also Chapter File: "ComosLicenseServerMonitor.exe.config" (Page 119).

LicenseLib license administration
Application purpose: Controls access to the local license file and communication with COMOS 
LS Process. 

● "LicenseLib"
"LicenseLib" controls access to a local license file and handles communication with 
COMOS LS Process. 
See also Chapter Registration of the "Comos.LicenseLib.dll" file (Page 158).

● "Comos.LicenseLib.config"
Configuration of the client license components

– COMOS

– RemoteLicenseService

– ICA Client:

See also Chapter Syntax of "Comos.LicenseLib.config" (Page 91).

COMOS LUM
Application purpose: Assigns and monitors licenses for users and user groups

● "ComosLicenseUserManager.exe"
This file is launched in the normal way.
See also Chapter Using the COMOS License User Manager (Page 133).

● "ComosLicenseUserManager.exe.config"
Configuration
See also Chapter ComosLicenseUserManager.exe.config (Page 135).
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COMOS RLS
Application purpose: Assigns and controls remote access.

● "RemoteLicenseService.exe"
Supporting service for COMOS. This service is not included in the list of Windows services. 
This file is launched in the normal way.
See also Chapter Using the COMOS Remote License Supplier (Page 147).

Software from third-party developers
If the following software does not already exist on the computer, it is installed during the setup:

● .NET Framework 2.0

● WebServices Enhancement 3.0 for .NET

Administration files
In addition to the files described above, a number of DLLs and predefined log files are installed.

7.4 Version details for the software in COMOS LM

Requirements
● You are familiar with the COMOS LM overview.

See chapter Overview of COMOS LM (Page 73) for more on this.

License check COMOS 10.2 and later
A modified license check is used as of COMOS 10.2. The following therefore applies in 
COMOS 10.2 and later:

● You must use a license server 2.0 or higher.

● You must use RLS 3.9 or higher.

Versions of the COMOS LM installation packages at the time of going to press

Installation package Version
COMOS LS 2.0.5
COMOS LS Monitor 1.7.2
COMOS LUM 1.5.2
COMOS RLS 3.9
COMOS RICA 3.5
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7.5 Storage location and name of license files

Requirement
● You are familiar with the COMOS LM overview.

See section Overview of COMOS LM (Page 73) for more on this. 

Terminology
● The license file is referred to hereafter as "ComosLicense*.xml" 

● The COMOS LS Process components are referred to hereafter as the license server.

File name of a license file for the license server
If a license server is used, another name can also be selected for the license file. Depending 
on the customer, the support department also sends license files with other names. The license 
file can also be renamed later. The only requirements are that the content of the license file 
may not be changed and the license file must remain an XML file.

Working with more than one license file on the license server
If a license server is being used, more than one license file can be worked with.

A three-digit sequence ID is stored in every license file. None of the sequence IDs in any of 
the license files that are being used can be identical.

If two or more license files with the same sequence ID are used, the following message is 
output in the log file: "Duplicate sequence ID found".

File names of local license files
Local license files must have a "ComosLicense" prefix.

The following are allowed, for example:

"ComosLicense.xml"

"ComosLicense_Test1.xml"

"ComosLicense Test2.xml"

"ComosLicenseTest3.xml"
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Storage location of the license file
The license file is searched as follows: 

1. Starting from the current directory of LicenseLib: Change to the higher-level directory. 
A search for a "\config" directory is performed and, once this directory has been located, a 
further search for a ComosLicense*.xml license file is performed.

2. In the current directory, LicenseLib  is searched for a ComosLicense*.xml license 
file.

3. The network is searched for a license server.

Storage location of multiple local license files
You can copy multiple local license files to a shared folder. If multiple local license files are 
available, they are checked one after another until a file matching the dongle is found. 

The following scenario is possible: 

All local license files are stored on all workstations. Should they need to, employees take their 
dongle with them and use it on another workstation. Users can then also work on the same 
stations. 

This makes the allocation of a dongle to a PC superfluous. 

Multiple dongles
If multiple dongles are activated on a PC, then the first physical dongle in a signal chain is 
always found first.

7.6 Administering local licenses

Requirement
● COMOS is installed.

You can find additional information on this topic in the "COMOS xx - Readme" manual, 
keyword "Installing COMOS on PCs".

● Hardlock dongle driver is installed.
You can find additional information on this topic in the "COMOS xx - Readme" manual, 
keyword "Dongle drivers".

● For COMOS versions prior to COMOS 9.0:
Register the "Comos.LicenseLib.dll" file Run the following CMD file to this purpose:
"<Comos>\BIN\" directory: "ComosLicenseLib_Register.cmd"
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Procedure
1. Store one or more local license files in the "<Comos>\config" directory.

The license files must be named "ComosLicense<x>.xml". See section Storage location 
and name of license files (Page 79).

2. Plug the dongle associated with the license file into the PC.

3. Alternative: Use COMOS LS Host-ID to install license management without dongle.
See section Dongle-free license with COMOS LS Host-ID (Page 167).

4. Start COMOS.
The first login might take some time.

A local license file always has priority over a license server. This also applies when all licenses 
in the local file have expired: even then no "COMOS LS Process" is contacted.

7.7 Administering central licenses

7.7.1 Installing COMOS LS

7.7.1.1 Requirements/System environment

Requirement
● Current setup browser

Alternatively: Individual package with the installation file for COMOS LS.

● License file, starting April 1, 2008

Releases
COMOS LS is released for the following operating systems: 

32-bit

● Windows XP Pro SP3

● Windows Server 2003 SP1

● Windows Server 2008 SP1

64-bit

● Windows Server 2003 SP1

● Windows Server 2008 SP1

● Windows Server 2008 R2 SP1

The installation file for COMOS LS also contains: Microsoft .NET Framework 2.0; 
Windows  Services Enhancement 3.0 for .NET.
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7.7.1.2 Setup procedure

Requirement
Carry out all the following setup activities, including the start of COMOS LS Process, with the 
"Administrator" status. 

Procedure
The PC that runs the Windows service for the license server is called the "Server PC". 

1. Steps on the server PC
For the installation of COMOS LS via the setup browser, see also the "COMOS xx - Read 
Me" manual, keyword "Installing COMOS license products".

– If necessary, uninstall the previous version of COMOS LS. You will need the old setup 
of the previous version to do so.
See section Updating the license server (Page 90) for more on this.

– Run "Setup.exe" for the current version of COMOS LS.

– Follow the setup instructions for COMOS LS.

– If necessary, setup installs: Microsoft .NET Framework.

– Restart the server PC after installation of the .NET Framework.

– If necessary, setup installs: Windows Services Enhancement for .NET.

– Setup asks for the license file. If you close the license selection dialog using the "Cancel" 
button, copy the license file later into the license directory entered during the setup.

2. Steps on the client PC

– Run the COMOS setup.

– If the default value 27011 for the port is not used, this value has to be adjusted in the 
following file: "Comos.LicenseLib.config". Recommendation: First update the file in the 
service pack, then distribute the service pack.
See section Protocol and ports of COMOS LM (Page 74) for more on this.

– Install the Service Pack.

– If Microsoft .NET Framework has not been installed on your PC yet, install it. The 
corresponding setup can be found on the Siemens AG FTP server or on the Microsoft 
website.

– Restart the PC after installation of the .NET Framework.

– COMOS 9.0 and later: For COMOS 9.0, SetLicPath does not need to be called, since 
the license server is specified in the "Comos.LicenseLib.config" file by means of the 
ComosLicenseServer key.
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3. Steps on the server PC

– If you have not yet selected the file "ComosLicense*.xml", copy the file into the directory 
specified in the setup.

– If the default value 27011 for the port is not used, this value has to be adjusted in the 
following file: "ComosLSCommon.config".
See also Chapter Protocol and ports of COMOS LM (Page 74).

– Select "Start > Programs > Comos License Service" in the Windows menu.

– Select the "License Server" tab and check whether the license file has been recognized 
and is valid.

In the initial state, "ComosLS Service" Windows service is not started. You have two options 
to start this Windows service:

– Start the Windows service in the "Services" dialog box of the operating system.

or

– Click the "Start Comos LS" button in the COMOS LSM.
If the license server is inactive, the clients are terminated after 5 heartbeats. 5 heartbeats 
correspond 8 to 10 minutes. If the license service is shut down permanently, the COMOS 
clients are closed and open work is discarded. 
If the license server is restarted within this time, the COMOS clients reconnect and 
continue to operate.

4. To install the "Comos License Server Monitor", double-click the file 
"ComosLicenseServerMonitor.exe".

5. Start the COMOS clients.
The first login might take some time.

Changes on the computer
● Clients

– Installation of Framework, if not yet installed

– Installation of COMOS

– For COMOS versions prior to COMOS 9.0: Registration of "Comos.LicenseLib.dll"

● Server PC

– Installation of .NET Framework, if not yet installed

– Installation of Windows Services Enhancement for .NET, if not yet present

– Installation of the new license server
The setup also installs the service "Administrative Tools > Services > ComosLSService":
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7.7.1.3 Reference for ComosLS.exe.config

Reference
● <appSettings>

– <WarningBeforeExpirationAdmin>
States the number of days from when a user with COMOS administrator rights receives 
a warning when a license expires. Default: seven days.

– <WarningBeforeExpirationUser>
States the number of days from when a user without COMOS administrator rights 
receives a warning that a license expires. Default: one day.

– <NamedUserAutoAdd>
0: No automatic adding of the user who checks out a Named User License. In this case, 
the user has to exist in the current Named User file, otherwise, he does not receive any 
license.
1: Automatic adding of the user unless he does not already exist in the current 
Named User file and creation of a new Named User file if there is still a license available.

– <NamedUserAutoDeleteOverwritable>
0: In case of a successful switch to an older Named User file, the files that now have a 
higher sequence ID are not deleted. These files are overwritten, if necessary.
1: In case of a successful switch to an older Named User file, all files that now have a 
higher sequence-ID are automatically deleted.

– <StatisticSnapshotGenerate>
0: Evaluation turned off.
1: Two files are generated: "ComosLSLicenseSnapshot.log" and 
"ComosLSLicenseSnapshotUsers.log".
"ComosLSLicenseSnapshot.log":
In the "<Comos LS>\Data\Logfiles\Statistic" directory, the 
"ComosLSLicenseSnapshot.log" file with the current license utilization is created each 
time a license is checked in or out. 
This file contains information for each product on the total number of licenses, the 
number of currently checked out licenses and the utilization percentage. The file is 
structured as follows:
<Product>;<Date>;<#Count>;<#Usage>;<% Usage>
"ComosLSLicenseSnapshotUsers.log": 
In the "<Comos LS>\Data\Logfiles\Statistic" directory, the 
"ComosLSLicenseSnapshotUsers.log" file with the current license utilization, broken 
down by user, is created each time a license is checked in or out.
This file contains information for each product on the number of checked-out licenses 
per user. The file is structured as follows:
<Product>;<User>;<Date>;<#Usage>
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– <StatisticWorkloadGenerate>
0: Evaluation turned off.
1: In the "<Comos LS>\Data\Logfiles\Statistic\Users\<Year>\<Month>" directory, the 
"ComosLSLicenseWorkload_<year>_<month>.log" file with information on the 
corresponding operation is updated each time a license is checked in or out. The 
subdirectories <Year> and <Month> are created automatically.
The files contain the following information for every check-in/check-out of a license:
- User login
- License group (if used)
- IP address of the client PC 
- IP address of Citrix session, if applicable
- Cookie
- Date of the action
- Action (CHECKOUT, CHECKIN, RELEASE)
When COMOS crashes, only a CHECKOUT is initially entered. The CLS releases the 
licenses again after no more than 15 minutes. This release is entered with the entry 
RELEASE.
- Product
- COMOS LS error codes, see chapter COMOS LS error codes (Page 158).
- Total number of licenses
- Number of licenses currently checked out
The file is structured as follows:
<User>;<License group>;<IP>;<IP session>;<Cookie>;<Date>;
<Action>;<Product>;<Return code>;<#Count>;<#Usage> 

– <LogfilesMaxSize>
States the maximum size of the log files. The size is displayed in MB.
0: No size restriction of the files (Default set in installation).
Dependency: ComosLSCommon.config: <PathLogFilesBackup>
<PathLogFilesBackup> must exist.
<PathLogFilesBackup> is empty: The log file is emptied when the maximum size is 
reached.
<PathLogFilesBackup> includes path information: The log file is moved according 
to the absolute path when the maximum size is reached. Logging is continued in a new 
file.
Dependency on license server start: see under <PathLogFilesBackup>.
Dependency: <LogfilesSavePerMonth>. 
<LogfilesMaxSize> has priority over <LogfilesSavePerMonth>.

– <LogfilesSavePerMonth>
0: Turned off (Default setting after installation)
1: <PathLogFilesBackup> is empty: The log file is deleted when the month changes.
<PathLogFilesBackup> includes path information: The log file is moved according 
to the absolute path. Logging is continued in a new file.
Dependency: ComosLSCommon.config: <PathLogFilesBackup>
<PathLogFilesBackup> must exist.

● <system.diagnostics>
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– <Switches>
The name of the entered key may not be changed.
With this value you can configure which kind of messages should be logged. Possible 
values:
- Critical
- Error
- Warning
- Information
- Prohibitions
All entries: Value is set to Information after the installation.
A value always includes the hierarchically subordinate values. The Warning value, for 
example, also logs all messages classified as Error or Critical. Changes are 
applied after the license server has been restarted.
Dependency: License server start
When the license server is started, the following information is always logged 
irrespective of the set level.
- The version and the port
- The key value pairs of the configuration files read
- Information about the license files
- Any named user files
- HTTP listener

– <sources>
Only one setting is allowed to be edited here:
initializeData = <path + name logfile>
Path and name of the log file are given. This entry occurs twice and is also input during 
the installation.
The path must match the following entry:
<appSettings> <PathLogFiles>

– <trace>

Example
<?xml version="1.0" encoding="utf-8" ?>
<configuration>

  <appSettings>
    <add key="WarningBeforeExpirationAdmin" value="7" />
    <add key="WarningBeforeExpirationUser" value="1" />
    <add key="NamedUserAutoAdd" value="1" />
    <add key="NamedUserAutoDeleteOverwritable" value="0" />
      <add key="StatisticSnapshotGenerate" value="0" />
      <add key="StatisticWorkloadGenerate" value="1" />
       <add key="LogfilesMaxSize" value="0" />
      <add key="LogfilesSavePerMonth" value="0" />
  </appSettings>

  <system.diagnostics>
    <switches>
      <add name="ComosLicenseServer" value="Information" />
      <add name="ComosLicenseWebService" value="Information" />
    </switches>
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    <sources>
<source name="ComosLicenseServer" switchName="ComosLicenseServer" 
switchType="System.Diagnostics.SourceSwitch">
        <listeners>
          <add name="ComosLicenseServer"
               type="System.Diagnostics.DelimitedListTraceListener"
delimiter=" "       initializeData="C:/Comos/ComosLS/Server/Data/
Logfiles
/ComosLicenseServer.log"
               traceOutputOptions="DateTime" />
          <remove name="Default"/>
        </listeners>
      </source>
      <source name="ComosLicenseWebService" 
switchName="ComosLicenseWebService" 
switchType="System.Diagnostics.SourceSwitch">
        <listeners>
          <add name="ComosLicenseWebService"
               type="System.Diagnostics.DelimitedListTraceListener"
               delimiter=" "
               initializeData="C:/Comos/ComosLS/Server/Data/Logfiles/
ComosLicenseWebService.log"
               traceOutputOptions="DateTime" />
          <remove name="Default"/>
        </listeners>
      </source>
    </sources>

    <trace autoflush="true" indentsize="2" />
  </system.diagnostics>

</configuration>
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7.7.1.4 Reference for ComosLSCommon.config

Reference
This file is read by "ComosLS.exe" and "ComosLicenseServerMonitor.exe" and configured 
during the installation process. See also chapter Using COMOS License Server Monitor 
(Page 116).

● <<appSettings>

– <PathBasicData>
Directory in which XML files for user and license group administration and for the 
mapping to products is stored.
See also chapter Users and license groups (Page 96).

– <PathNamedUserFiles>
Directory where the Named User files are saved. It is set during the installation and must 
only be edited by authorized users afterwards. If you change this path without copying 
the latest Named User file to the new directory at the same time, this has the following 
consequence: The license server cannot be started and Named User licenses can no 
longer be checked out. 

– <PathLicenseFiles>
Directory where the license files are saved. It is set during the installation and must only 
be edited by authorized users afterwards. If you change this path without copying the 
license files to the new directory at the same time, this has the following consequence: 
The license server shuts down during operation and cannot be restarted.

– <PathLogFiles>
Directory where the LOG files are saved. It is set during the installation.

– <PathLogFilesBackup>
States how LOG files are dealt with if the license server is restarted:
<<PathLogFilesBackup> does not exist: LOG files will continue to be used; also 
analysis of the value of <LogfilesMaxSize>.
<PathLogFilesBackup> Exists, but without a path designation: LOG files are deleted.
<PathLogFilesBackup> Exists, but without a path designation: LOG files are moved 
to the specified directory and renamed according to the following scheme: YYYY-MM-
DD_HHMMSS.<name>
Dependencies: License server start / <LogfilesMaxSize>

– <ComosLicenseServerPort>
States the port for ComosLicenseServer.
Default value: 27011 
This value is also used in the case of a missing key or an empty value.

Example
<?xml version="1.0" encoding="utf-8" ?>
<configuration>
  <appSettings>
    <add key="ComosLicenseServerPort" value="27011" />
    <add key="PathNamedUserFiles" value="C:/Comos/ComosLS/Server/
Data/NamedUser/" />
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    <add key="PathLicenseFiles" value="C:/Comos/ComosLS/Server/Data/
License/" />
    <add key="PathLicenseFilesBackup" value="C:/Comos/ComosLS/Server/
Data/License/Backup/" />
    <add key="PathLogFiles" value="C:/Comos/ComosLS/Server/Data/
Logfiles/" />
    <add key="PathLogFilesBackup" value="C:/Comos/ComosLS/Server/
Data/Logfiles/Backups/" />
    <add key="PathBasicData" value="C:/Comos/ComosLS/Server/Data/
Basic/" />
</appSettings>
</configuration>

7.7.1.5 Responses from the server

Running Level
"STOPPED": License server is stopped; no available licenses. 

"RESTRICTED": License server is started with restrictions: the currently required Named User 
file is missing. The Named User sequence can be reset, and the password to start the User 
Manager can be assigned or changed. 

"FULL": License server is active. 

Responses to heartbeats 
When a COMOS client receives a license from the license server, a reply ("Heartbeat") is 
sent from the client to the COMOS license server periodically in two minute intervals. The 
license server responds to the heartbeat.

See also section Runtime check/ Heartbeat (Page 89).

7.7.1.6 Runtime check/ Heartbeat

Objective of the runtime check
The license server runtime check handles the following tasks: 

● Release of licenses temporarily not available
Example: Licenses that were not released due to an unexpected shutdown of a COMOS 
client.

● Checking for illegal manipulations of the license system

Runtime check is called up by the following function:

● Periodical check by COMOS LS Monitor.

● Heartbeats of the COMOS clients

If more than 5 minutes have passed since the last runtime check, another runtime check is 
conducted. The client heartbeat has a 2-minute cycle. The duration between two Runtime 
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checks therefore amounts to 5 to 6 minutes. Depending on the number of active clients in the 
network, there is a possibility of the license server conducting a runtime check every 5 minutes. 

If the clients and the Server Monitor are not active, no queries are sent to the license server 
and no runtime check is carried out. 

The interval between two Runtime checks amounts to 5 minutes. Licenses that are temporarily 
not available are therefore released again at the latest after 15 minutes. This maximum period 
of 15 minutes results from the following procedure:

● In order for a license to be released, it has to be unavailable for at least 10 minutes. 

● The licenses are checked every five minutes. It is therefore possible that the license is not 
available in the first five minutes. 

● After the next five minutes, it has been unavailable for less than 10 minutes. It can therefore 
not be eliminated until the next 5-minute interval. 
The license can therefore be unavailable for a maximum of 15 minutes.

Heartbeat 
When a COMOS client receives a license from the license server, a reply ("Heartbeat") is sent 
from the client to the COMOS license server periodically in two minute intervals. The license 
server responds to the heartbeat. 

If there is a problem with the response, the client continues trying to send this heartbeat. 

● The request was not answered by the license server three times in a row: Entry in log file: 
"The last heartbeat is older than 6 minutes - the licenses mapped 
to the corresponding cookie will be released soon".

● The request was not answered by the license server five times in a row: A COMOS-internal 
flag is set. This flag is evaluated by the COMOS client during the next runtime check and 
COMOS is closed after confirming the corresponding message.

Saving is not possible after confirming the message!

See also
Protocol and ports of COMOS LM (Page 74)

7.7.2 Updating the license server

Overview
If you want to install a new version of the license server, follow these steps:

● Stopping COMOS LS Process 

● Close all applications with access to the service: Server Monitor, User Manager

● Back up the data directory
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● Uninstall the license server 

– Start setup of the old license server

– The old setup offers you the "Uninstall" option. Uninstall the old license server by using 
this option.

– Please note: The license server cannot be uninstalled with the Windows software 
management. You must use the setup of the old license server to uninstall the old 
version. 

● Delete the installation directory

● Start the setup of the new license server

● Install the new license server

● Copy the backup of the data directory to the new "Data" directory

7.7.3 Configuring a license server

7.7.3.1 Overview of the configuration of the license server

Overview of the configuration of the license server
The license sever is configured in two places:

● Configuration within COMOS
The component "Comos.LicenseLib.dll" (LicenseLib) is responsible for the communication 
between COMOS and COMOS LS Process. The "Comos.LicenseLib.dll" is controlled using 
Comos.LicenseLib.config. The configuration of the license server is, therefore, equivalent 
to editing Comos.LicenseLib.config. 
"LicenseLib" is included in current service packs and in the setup of the COMOS RLS. The 
"LicenseLib" file of the service pack and the "LicenseLib" file of the COMOS RLS do not 
interfere with each other.
See Chapter Syntax of "Comos.LicenseLib.config" (Page 91).

● Configuration on the client
See Chapter Ignoring the proxy server options (Page 93).

7.7.3.2 Syntax of "Comos.LicenseLib.config"

Requirement
● You are familiar with the configuration overview.

See Chapter Overview of the configuration of the license server (Page 91).

Comments in the config file
<configuration> section: Single-row XML comments (which start with <!--) are permitted. 
All other comments or additions are prohibited.
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Location of the config file
The following method is used to search for the "Comos.LicenseLib.config" file:

1. Starting from the current directory: Change to the higher-level directory. A search is 
performed there to find the "\config" directory, and this directory is in turn searched for the 
"Comos.LicenseLib.config" file.

2. After this, the current directory of "LicenseLib" is searched for the 
"Comos.LicenseLib.config" file.

3. Then, the default port 27011 is tested.

Syntax
<configuration>

● <<ComosLicenseServer>
Name of the server PC on which COMOS LS Process is installed. Evaluation, COMOS 9.0 
or higher.

● <<ComosLicenseServerPort>
Port through which communication with COMOS LS Process takes place. If the value is 
empty, 27011 is used as a default.

● <IgnoreProxySettings>

– 0: The Internet Explorer proxy settings are used.

– 1: (Default): The proxy server is ignored.

● <CryptUseMachineContainer>

– 0: The temporary files created for the encoding through Windows are stored in the user 
profile. This is the default value.
Example for Windows 7: "C:\Users\<User>\AppData\Roaming\..."

– 1: The temporary files created for the encoding through Windows are stored in the public 
profile of the PC. 
Example for Windows 7: "C:\Users\All Users\..." or "C:\Users\Public\..."

● <UseLicenseServer>
If this key is available, the registry key LastUsedLicenseServer is ignored. 
FLEXlm: Communication takes place via the FLEXlm license server.
CLM: Communication takes place via COMOS LS Process.
The <UseLicenseServer> key is evaluated by the "Comos.dll" file - not by the 
"Comos.LicenseLib.dll" file as in the case of the others.

Example
<configuration>
  <setting key="ComosLicenseServer" value="ComosLicenseServer" />
  <setting key="ComosLicenseServerPort" value="80" />
  <setting key="IgnoreProxySettings" value="1" />
  <setting key="CryptUseMachineContainer" value="1" />
  <setting key="UseLicenseServer" value="CLM" />
</configuration>
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See also
Copy exception for "Comos.LicenseLib.config" (Page 93)

LicenseLib (Page 153)

7.7.3.3 Copy exception for "Comos.LicenseLib.config"

Requirement
● You are familiar with the configuration overview.

See Chapter Overview of the configuration of the license server (Page 91).

Standard behavior in the Update Center
The "Comos.LicenseLib.config" file from a service pack is not copied from the COMOS Update 
Center to "<Comos>\config". 

To apply the file "Comos.LicenseLib.config" from the Service Pack, copy it to "<Comos>
\config". 

Simplified copying via the "ComosLicenseLib_Register.cmd" file
The following files are created with a service pack: 

● "<Comos>\BIN\" directory: "Comos.LicenseLib.template"

● "ComosLicenseLib_Register.cmd"

Requirement for executing the "ComosLicenseLib_Register.cmd" file:

● The "<Comos>\config\" file: "Comos.LicenseLib.config" does not exist:

● The "<Comos>\BIN\" file: "Comos.LicenseLib.template" exists:

Effect:

1. The "config" directory is created again if required.

2. "Comos.LicenseLib.template" is copied to the "<Comos>\config" directory as 
"Comos.LicenseLib.config".

3. The "Comos.LicenseLib.template" file is deleted from the "<Comos>\BIN\" directory.

7.7.3.4 Ignoring the proxy server options

Requirement
● You are familiar with the configuration overview.

● See Chapter Overview of the configuration of the license server (Page 91).
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Effect of implementation 
COMOS LS is implemented as a web service with the following default: 

● The "Proxy server" option in the Internet configuration on the client
If this option is not activated, Windows will forward all license requests from COMOS to the 
address entered as the proxy server. 

However, a typical proxy server cannot handle license requests from COMOS. Therefore, the 
requests are not forwarded to the license server, and COMOS does not receive a license. 

With the "Comos.LicenseLib.dll", there is a way to fully ignore the proxy settings of the Internet 
Explorer on the PC. 

Editing Comos.LicenseLib.config
File: "Comos.LicenseLib.config"

● Key: IgnoreProxySettings 
Value: 0|1 , Default: 1 
– 0: Regard the proxy settings 

– 1: Ignore proxy settings 

The complete row looks like this: 
<setting key="IgnoreProxySettings" value="1" />

See also
Entering an exception on the proxy server (Page 94)

Using FQDN (Fully Qualified Domain Name) (Page 95)

7.7.3.5 Entering an exception on the proxy server

Requirement
● You understand the effect of the proxy server configuration. 

See Chapter Ignoring the proxy server options (Page 93).

Alternative procedure
The alternative to Chapter Ignoring the proxy server options (Page 93) is to enter an exception 
on the proxy server. 

Case 1: All affected computers are located in the same domain
Requirement: The workstations on which COMOS is installed and the license server are 
located in the same domain. 
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Internet options, "Connections" tab, "Local Area Network (LAN) Settings" group: "Settings" 
button 

● Option: "Use a proxy server for your LAN"
Background info: This option is the reason for the problem described above. 

● Option: "Bypass proxy server for local addresses"
Effect: The license server is reached via the name. 

Case 2: Access via IP / cross-domain access
Requirement (alternative 1): The license server is addressed via an IP address. 

Requirement (alternative 2): The license server is located in another domain. 

Internet options, "Connections" tab, "Local Area Network (LAN) Settings" group: "Settings" 
button 

● Option: "Use a proxy server for your LAN"
Background info: This option is the reason for the problem described above. 
Button: "Advanced", "Exceptions" field"
Forms that cover the license server names entered in the registry can also be used. 
Examples: 
LicensePath Value valid entries exception list 
192.168.1.25 192.168.1.25 ; 192.168.1.* 
LicenseServer LicenseServer ; License* 
LicenseServer.comos.de LicenseServer* ; *comos.de

7.7.3.6 Using FQDN (Fully Qualified Domain Name)

Requirement
● You understand the effect of the proxy server configuration. 

See Chapter Ignoring the proxy server options (Page 93).

Alternative procedure
As an alternative to section Ignoring the proxy server options (Page 93), you can use a FQDN 
entry. 

COMOS LS can handle input masks as well as FQDN, for example, 
ComosLizenzServer.Comos.De.  

If the FQDN entry is used for a server located in the same domain, then it is not necessary to 
add the server to the exception list in addition. In that case, it is sufficient to activate the "Bypass 
proxy server for local addresses" option.
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7.7.4 Users and license groups
The rights management for COMOS LM users covers the following options: 

● User administration
See Chapter "Users" tab (Page 139) and "Users" menu (Page 146).
"LicenseUsers.xml": Contains the users detected via the COMOS LUM. 
This file is located in the directory defined by means of the <PathBasicData> key.
See section Reference for ComosLSCommon.config (Page 88).

● Assignment of the user to a product of type NAMED_USER 
See Chapter "Named User" tab (Page 137) and "Named User" menu (Page 144).

● Assignment of a user to a license group
See section "License Groups" tab (Page 138).
"LicenseGroups.xml": Contains the license groups created via the COMOS LUM. This file 
is located in the directory defined by means of the <PathBasicData> key.
See section Reference for ComosLSCommon.config (Page 88).
Dependency: The actual assignment of the user to a group is specified in the 
"LicenseUsers.xml" file. 

● Assignment of the user to two-way usage of products
See section "License Assignments" tab (Page 141).

7.7.5 Assignments to a product
Users and license groups can be assigned to products so that the use of the corresponding 
product can be classified more precisely. See also section "License Assignments" tab 
(Page 141).

It is possible to assign following types:

● "RESERVE"
The number of licenses specified for the type "RESERVE" is reserved so that this number 
is always available for the assigned users and/or license groups. 
Here, the number of licenses to be reserved must be clearly stated. 

● "EXCLUDE"
The use of the product is not allowed for users who are directly or indirectly assigned via 
a license group.

● "INCLUDE"
The use of the product is allowed for users who are directly or indirectly assigned via a 
license group.

For users, license groups and the classification via a type, the following hierarchical rules have 
been defined (these always apply to one product):

● If there are no assignments to a product the license is provided as usual.

● The assignment of a user to a product has priority over the assignment of a group in which 
the user is included to this product.

● An assignment of the "EXCLUDE" type has priority over an assignment of the "RESERVE" 
type.
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● An assignment of the "RESERVE" type has priority over an assignment of the "INCLUDE" 
type.

● If assignments of the type "EXCLUDE" exist, but none of the type "INCLUDE": Users without 
assignments receive a license.

● If assignments of the type "INCLUDE" exist: Users without assignments do not receive a 
license.

7.7.6 Access to the dongle at server start

Requirement
● The dongle driver is installed.

You can find more information on this topic in the "COMOS Read Me" manual, keyword 
"Installing dongle drivers".

Optional adjustment of the registry
When starting COMOS LS Process, a login takes place in the associated dongle. 

If the server PC is started and the start parameter of the "ComosLSService" is set to 
"Automatic", in some circumstances it is possible that the "Hardlock" service, which is 
responsible for access to the dongle, is not yet started. This leads to an error message in 
COMOS LS Process that prevents it from accepting requests. 

If an error occurs during the dongle login when starting COMOS LS Process, there is a one-
time 20-second waiting period. If a login is still not possible after the waiting period, COMOS 
LS Process is not started. 

This problem can be solved by a manual extension in the registry database of Windows. 

Open the registry branch of the Window services: 

"HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services" 

Entry: ComosLSService 

Generate new values called: DependOnService 

Type: REG_MULTI_SZ 
Value: Hardlock. 

If you now open the properties of "ComosLSService" in the Windows services management, 
the name "Hardlock" is displayed in the "Dependencies" tab below "This service depends on 
these system components". 

After a restart of the server PC, "ComosLSService" is now only started if the "Hardlock" service 
has already been started.

Interaction with the "Dongle.exe" tool
The dongle driver is a prerequisite for the "Dongle.exe" tool to be used.
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Alternative: Install license management without dongle
Use COMOS LS Host-ID to install license management without dongle. See section Dongle-
free license with COMOS LS Host-ID (Page 167).

7.7.7 Providing a dongle for a VMWare

Overview of using a dongle with a VM
There are various possible physical interfaces for plugging in the dongle:

● The USB interface of the server

● A special hub for USB interfaces

● The USB interface of the client

The dongle driver of SafeNet, Inc. must be available where the dongle is being used. In each 
of the cases described below, the dongle driver must be available in the VM. 

Plugging in the dongle with the VMWare ESX server
VMWare ESX servers also support the transfer of USB components to a client. The "USB 
Path" option must be selected and the server restarted. 

The dongle can then be used by the client entered in "USB Path".

USB hubs with IP address
If you use a USB hub that has its own IP address, the VM can talk to the hub. 

Example: Digi AnywhereUSB MHC.

This is a USB hub in which each USB port can be assigned separately. 

Using the USB port on the client PC
The USB port must be detected physically. If this is the case, the USB port appears in the 
"USB controllers" list in Windows Device Manager.

No hardware/software solutions that emulate a USB port may be used.

Installing the dongle driver
You can find more information on this topic in the "COMOS Read Me" manual, keyword 
"Installing dongle drivers".
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7.7.8 Sequences of license files
There can be several license files that are identified by the name "Sequence 001, ...". 
Sequences are used for additive licenses.

7.8 Configuring the failover system (optional)

7.8.1 Introduction

What is a failover system?
The failover system is a server failure backup mechanism. In order to continue working when 
the license server at the client fails, the failover system makes the licenses available. You 
install the license server and the FailOver license server on different various server PCs. 
Afterwards, you use the same license file for the license server and the FailOver license server.

The failover system is in stand-by mode and takes over automatically at a failure of the license 
server.

A failover system cannot be combined with the "dongle-free license".

Constituents
● Failover dongle with number of the license server dongle and a prefixed "F".

●  Customized components of the COMOS LS software (as of Version 1.5.6)

● License files

● Data files

Usage and runtime
As of COMOS LS Software Version 1.5.8, the following changes apply: 

The failover system can be activated for the default runtime of up to 30 days. After use the 
dongle is deactivated. Please contact SIEMENS to activate the dongle again.

Licenses
Licenses of the NAMED_USER type are handled by the failover system like licenses of the 
FLOATING type. This behavior is necessary since the number of the current NAMED_USER 
file is stored in the original dongle and cannot be transferred to the failover dongle.

Master system
To uniquely differentiate the COMOS LS system and the failover system, the COMOS LS 
system is also referred to as the master system in this section.
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7.8.2 Installing the failover system

Setup procedure
To install the failover system, use the COMOS LS setup: 

1. Select the "License server configuration" page and activate the "Install as failover system" 
option.

2. Enter the corresponding values in the "Computer name" and "Port" fields. The values from 
the two edit fields are saved as follows: 

– File "ComosLS.exe.config" 

– Key ComosLicenseServerMaster 
Key ComosLicenseServerMasterPort <add key="ComosLicenseServerMaster" 
value="Name of the master server" /> (license server of the master system)

– Key ComosLicenseServerMasterPort 
<add key="ComosLicenseServerMaster" value="name of the master server" /> (license 
server of the master system)<add key="ComosLicenseServerMasterPort" 
value="master port" (port for accessing the license server of the master system)

Adjusting the "Comos.LicenseLib.config" file (client)
1. Adapt the configuration files of the failover system to the configuration of the master system. 

2. Add the following values to "Comos.LicenseLib.config" in the [...]/config folder of your 
COMOS installation:

● (COMOS Vega and later) <setting key="ComosLicenseServerBackup" 
value="Name of the failover server"/>

● (For all COMOS versions) <setting key="ComosLicenseServerPortBackup" 
value="Port of the failover server" />

Using files from the master system
The failover system needs an image of the directory and file structure of the master system. 
Copy the following files used in the master system to the corresponding folder of the failover 
system:

1. License files ("ComosLicense#001.xml")

2. Assignment files ("LicenseUsers.xml", "LicenseGroups.xml", "ProductAssignments.xml")

3. Password files ("Password.xml", "PasswordUser.xml")

Example for standard installation:

Copy the following path from the master system to the FailOver license server:
C:\Program Files (x86)\Comos License Management\Data\Basic

Starting the failover system
You must start the failover system and, in so doing, add a variety of information.
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See chapter Starting the failover system (Page 101).

7.8.3 Starting the failover system

Requirement
See chapter Installing the failover system (Page 100).

Procedure
Only the administrator carries out the setup. To test your settings, connect the failover system 
to a client which is not being used by an employee.

1. Connect the failover dongle to the server on which you want to set up the failover system.
See chapters Providing a dongle for a VMWare (Page 98) and Access to the dongle at 
server start (Page 97).

2. Start the Server Monitor.

3. Click the "Start Comos LS" button to start the license server service.

4. Click "Yes".
The license service is started and the "Fail Over" tab opens.

5. Select the "Fail Over Settings" tab.

6. Enter the corresponding values in the boxes.
See also chapter Interface reference for the failover system (Page 104), keyword "Failover 
Settings".

7. Select the "Fail Over" tab.
You are in test mode. See Chapter Controlling and managing the failover system in the 
Sever Monitor (Page 102).

8. Simulate the failure of the license server, e.g. by entering non-existent values for 
ComosLicenseServer / Port in the "Comos.LicenseLib.config" file. The failover server is 
addressed, but issues no licenses because it is in test mode.

9. Check whether the failover server responded. The following message appears in the log 
file of the clients.
443: The 'Fail Over'-System was started but not yet activated

10.Send a test e-mail.

– Select the "Fail Over Settings" tab.

– Click the "Send test E-Mail" button

11.Restore the correct entries in "ComosLicense.Lib.config".

12.Click on "Switch to level Stand By".

The status changes and the failover System is ready to run.
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7.8.4 Controlling and managing the failover system in the Sever Monitor

Representation in deactivated state
As long as the license server process has not been started, the Server Monitor does not display 
a failover system. This means the "Fail Over Settings" tab is not available in this state. Only 
after startup does the license server signal to the Server Monitor that a failover system is 
running.

Four different failover system states
1. Test

2. Stand By

3. Activated

4. Deactivated

Test
The first time the system starts it is in test mode. In this status, you make the desired settings 
and test the functionality of the system. In the test state, license requests are submitted to the 
failover server but no licenses are issued. If an error code is displayed, check the configuration 
settings, the specified path and the server.

If the failover system is in FAILOVER_TEST mode, no licenses are being assigned. An entry 
in the log file is generated and the value FAILOVER_TEST_OK is returned.

Stand By
From within the test state you can switch the system to Stand By mode. This activates the 
automatic fail-protection. If your master system now fails, the failover system automatically 
switches to the Active state after the first license request.

Activated
The system is in the Enabled status after the master system has failed.

If the failover system is unable to communicate with the master system, it automatically 
activates itself from standby and issues licenses to the clients.

When the failover system is activated, an e-mail is sent to the recipients in the mailing list. You 
can edit this e-mail in the Server Monitor. The e-mail is sent asynchronously, so you receive 
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no direct feedback in the Server Monitor. Check the sent mails in the Outbox of the configured 
SMTP server.

Deactivated
The failover system is deactivated when one of the following events occurs:

● The maximum runtime in days was reached.

● After a failure, the master system is restored and is accessible from the failover system.

When the failover system is deactivated, an e-mail is also sent to the mailing list.

The dongle is deactivated and the failover system can no longer be used.

If no Server Monitor is opened at the moment it is deactivated, a standard error message is 
displayed during the next start of the Server Monitor. The "FAIL OVER DEACTIVATED" status 
as shown in the screenshot is not displayed. Check the log files to verify the deactivation.

Renewed use of the dongle
To reactivate the failover system, see chapter Failure of the master system (Page 103).

7.8.5 Failure of the master system

Communication between failover system and master system
The failover system checks at regular intervals whether the master system is accessible. The 
following points are checked:

1. Start of license service

2. Runtime check

3. First request from a client, creation of a cookie

4. Switch to Stand By state

Failure of the master system
If communication with the master system fails, the failover system is activated. The clients get 
Floating licenses and COMOS can continue to be used normally. COMOS is not closed during 
this switchover. Open projects and data are maintained.
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An e-mail is automatically sent to the mailing list to notify the recipients of the failure of the 
master system. 

The time counter starts. You can see the remaining runtime of the failover system in the server 
monitor.

Re-activating the dongle
To reactivate the failover system, proceed as follows:

1. Log on as administrator.

2. Open the Server Monitor and go to the "Fail Over" tab.

3. Click the "Create code" button.
A code appears in the "Code from customer" field.
The designation of the button now changes to "Reset the dongle".

4. Provide the code in the "Code from customer" field and additionally the dongle ID of the 
failover system to SIEMENS.

5. SIEMENS creates a response code and conveys it to you.

6. Enter the answer code in the "Answer code" and click the "Reset the dongle" button.
If the two codes are compatible, the failover dongle is reset to its delivery state.

7. If an error message is output, repeat the process.

7.8.6 Interface reference for the failover system

Changes on the Server Monitor
The failover system is integrated in the COMOS LS Monitor following installation.
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User interface
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New "Fail Over" tab
● "Status" field: Status of the Fail Over system:

– "FAIL OVER TEST"

– "FAIL OVER STAND BY"

– "FAIL OVER ACTIVATED"

– "FAIL OVER DEACTIVATED"

● "Runtime (days)" field: Maximum runtime in days

● "Date of activation" field: Date of first license request

● "Runtime remaining" field: Remaining runtime in days and hours

● Button "Switch to level FAIL OVER STAND-BY"
Switches the failover system to the STAND-BY state.
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● Button "Switch to level FAIL OVER TEST"
Switches the failover system to the TEST state.

● "Create code" button
Creates a code for the renewed commissioning of the failover system. After the "Create 
code" button has been clicked, this code is entered in the "Code from customer" field.

● "Reset the dongle" button
Before clicking this button enter, the answer code of SIEMENS in the "Answer code" field.
See also chapter Controlling and managing the failover system in the Sever Monitor 
(Page 102)

New "Fail Over Settings" tab
You set up the mailing lists on this tab. These mailing lists are notified when the Fail Over 
system is activated and deactivated. Click the "Save Settings" button to save your entries.

"Template for e-mail" control group
● "Mailing list to" field:

A list of e-mail addresses to which the notification is to be sent. Insert new addresses as 
follows:

1. Select the "Select and click here to enter a new value" line with a mouse click. The line is 
highlighted in blue.

2. Select the marked line with another mouse click or F2 to create an entry.

3. Enter an e-mail address and press Enter or left-click anywhere outside of the input field to 
confirm your input. New entries are highlighted in yellow.

4. Entries can be changed or deleted. Deleted entries are highlighted in red.
"From": Enter the desired e-mail address to be used as the sender (Administrator / Support).
"Subject": Subject line
"Message": Compose a message that is to be sent upon the status change from Stand By 
to Activated ("When activated") or during the status change from Activated to Deactivated 
("When deactivated").
"Signature": Insert a signature.

To save the changes, click the "Save" button.

"SMTP" control group
● "Server name" field: Name of the SMTP server

● "Server port" field

● "User" field: User name. If no user is entered, the e-mail is sent with "Anonymous Account" 
as the sender.

● "Password" field: Password

● "Confirm Password" field: Reenter and confirm the password

● "Use SSL" option: Use the SSL protocol, or alternatively only the HTTP protocol
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"Save settings" button
Saves your entries to the "FailOver.xml" file in the <...>\Data\Basic directory. Yellow or red 
highlighted entries have not yet been saved. Click "Save settings" to save your changes, or 
close the Server Monitor to discard the changes.

New "Fail Over Settings" menu
"Save": Saves the contents of the "Fail Over Settings" tab to the "FailOver.xml" file in the <...>
\Data\Basic directory.

"Send test E-Mail": Sends an e-mail to the e-mail addresses entered in the "Mailing list to" field.

Changes to the "Status Products" tab
The NAMED_USER license type is still displayed in the "Type" column of the respective license 
file as NAMED_USER, but is additionally highlighted in yellow. This shows the changed 
handling as FLOATING.

Changes to the "License Server" tab
The "Read dongle infos" menu command is renamed to "Test dongle". When the item is 
selected, there is a read access directly to the dongle (without a request to COMOS LS). When 
the dongle is successfully accessed, the readout dongle ID is put out in the "Status messages" 
area; if access failed, the error message and ID. 

If the Server Monitor is a remote installation of the Server Monitor, the menu command is 
disabled. 

NAMED_USER tab
In parallel, the "Named User" tab and "NAMED_USER" menu are hidden, as there are no 
NAMED_USER licenses in the Fail Over system.

7.9 Administration of Named Licenses

7.9.1 Purpose of Named Licenses
Named Licenses require a license server. The "Named User" list restricts which user may 
obtain a license from the license server. In practice, this is used to restrict the use of floating 
licenses. 

From the administrator point of view one can, in this manner, directly assign the limited 
resources of the licenses to the more important accounts. 

A similar technique is the reservation of licenses. If both techniques are used, then it is 
necessary to reasonably balance Named Licenses and reserved licenses. Otherwise it may 
occur that the two techniques block each other and some licenses cannot be obtained at all.
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See also
Definitions for Named Licenses (Page 109)

7.9.2 Definitions for Named Licenses

Requirement
● You understand the purpose of Named Licenses. 

See Chapter Purpose of Named Licenses (Page 108).

Definition of "Named Licenses"
Named Licenses are sometimes also called "Named User Licenses". Named Licenses consist 
of the following components: 

● Named User List

● Tickets (optional)

● Restrictable license

Definition: "Named User" list 
The "Named User" list restricts which user may obtain a license from the license server. 

Definition: Tickets (Rename Counter)
Tickets are what entitle you to delete a login from the "Named User" list. Thereafter a new login 
can be registered and entered in the "Named User" list.

See section "Named User" menu (Page 144), keyword "Add tickets".

See also
Technical workflow when using Named Licenses (Page 109)

7.9.3 Technical workflow when using Named Licenses

Requirement
● You are familiar with the definitions of Named Licenses.

See section Definitions for Named Licenses (Page 109).
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Quintessence
Two steps are performed during the login:

1. "Named User" list
The "Named User" list is checked to see whether a login entry already exists or if another 
entry is free. 

2. License
If this is the case, it is checked in the second step if a relevant license is free.

Named User list check
A user registers as usual with his login. Consequence: A place is reserved in the "Named User" 
list and linked to the login. 

The first and second user login is handled in the same manner. It is irrelevant whether the first 
registration was carried out with the first or second login. The first registration is the login that 
initially occupies a place in the "Named User" list. The first and second login can also be used 
freely in all the following sessions. The same entry is always searched for in the "Named User" 
list. 

If all places in the "Named User" list have been taken, no other login can register on COMOS 
with any of the licenses affected. Even if an employee logs out, no further login with the 
respective license is possible. The link in the "Named User" list to the login is permanent and 
is not bound to whether the corresponding employee is actually logged in. If another employee 
tries to log in with a new login, he will receive the message "No free licenses". 

If you want to remove the link between a place and a login in the "Named User" list, you need 
a ticket.

License check
Named Licenses require a license server. In such cases, each COMOS startup with registration 
requires a license. This also applies when working with Named Licenses. Reminder: The entry 
in the "Named User" list only states whether the user may use an involved license at all. The 
entry in the "Named User" list does not state whether another involved license might be free. 

A user can occupy several licenses. In this case, there are no free licenses left for other logins 
in the "Named User" list. However, there are certain restrictions when using Named Licenses, 
as described in the following. 

Login-based license request
Licenses are assigned based on the login sequence until all involved licenses are occupied. 
After this, COMOS must be closed first before another user who is registered in the "Named 
User" list can log in.

COMOS License Management (COMOS LM)
7.9 Administration of Named Licenses

110 Installation Manual, 03/2017 V10.2.1, A5E37082844-AB



Multiple login for COMOS start
If different PCs are used, then one login can register on three PCs at once. The following 
applies: 

● As long as only two different PCs are used, the users can register on both PCs as often as 
they like.

● If a user registers on a third PC, an additional product is required for this purpose (current 
name: Administrator). If no free Administrator license is available, registration is not 
possible.

● A further COMOS start on one of the first two PCs now also requires the license (current 
name: Administrator). Each COMOS startup with registration uses one license.

If the user is logged in on different PCs and one of the PCs incorrectly loses contact with the 
license server, the following applies: 

After two minutes, the counter of the number of PCs on which the user is logged in from the 
point of view of the license server is reduced by 1.

If all licenses were in use at the time of the improper exit of the PC, also see section Runtime 
check/ Heartbeat (Page 89).

Multiple COMOS starts on a PC
COMOS can be started as many times as you want on a computer. A license is obtained at 
every registration. 

Citrix
Terminal server (Citrix): 

Three registrations per login are allowed. With one login, a user can log in to COMOS, which 
is installed on a terminal server, a maximum of three times. The third registration requires an 
additional product (current state: Administrator). 

If a user is logged in several times on the Citrix Server and one of the sessions incorrectly 
loses contact with the license server, the following applies: 

After two minutes, the counter of the number of sessions logged in on the Citrix server from 
the point of view of the license server is reduced by 1. 

Loss of contact with the license server means that correct returning of the licenses to the 
license serve is no longer possible.

If all licenses were in use at the time of the improper exit of the PC, also see section Runtime 
check/ Heartbeat (Page 89).

See also
Changing the workflow (Page 112)
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7.9.4 Changing the workflow

Requirement
● You understand the technical workflow.

See Chapter Technical workflow when using Named Licenses (Page 109).

Login from the user's point of view
From the user's point of view, a normal COMOS login takes place, just as before. Neither the 
interface nor the handling has changed. 

Effect on the workflow
The login sequence is very important, especially in the introductory phase, because the places 
in the Named User List are occupied based on the login sequence.

The login sequence is also important later on, when participants use several involved licenses. 
If the user logs off, he releases a license in this case. 

Do not create a "Test login" and work with it in COMOS, as even this "Test login" obtains and 
ties up a Named User License.

7.9.5 Administration of Named Licenses

Controlling Named Licenses in the Server Monitor
See also chapters "Named User" tab (Page 128) and "Named User" menu (Page 131).

Administrating Named Licenses in the User Manager
See also chapters "Named User" tab (Page 137) and "Named User" menu (Page 144).

Changing from a dongle-based license management to COMOS LS Host-ID
The assignment between Named User licenses and users is saved as follows:

● Without the use of COMOS LS Host-ID
Saving in the dongle

● With the use of COMOS LS Host-ID
Saving in the registry
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When switching to COMOS LS Host-ID, the previous assignment list is no longer evaluated in 
the dongle. You have the following options for creating a new assignment list for COMOS LS 
Host-ID:

● Creating all assignments again with the User Manager

● Importing the previous assignment list with the User Manager
See chapter "Named User" menu (Page 131).

config entries
<NamedUserAutoAdd>

See also chapter Reference for ComosLS.exe.config (Page 84).

<NamedUserAutoDeleteOverwritable>

See also chapter Reference for ComosLS.exe.config (Page 84).

<PathNamedUserFiles>

See also chapter Reference for ComosLSCommon.config (Page 88).

More Named Users than licenses
If the number of valid licenses is reduced, this may result in the existing Named User file 
containing more Named Users for a product than the licenses available for the product.

See also chapter "Named User" tab (Page 137).

In this case, COMOS still allows the license server to start. However, the number of Named 
Users who can simultaneously check out a license for a product must correspond to the number 
of available licenses.

If the number of permissible Named Users is exceeded when the license server is started, the 
following warning is recorded in the log file:

"The number of stored users in the actual Named User file exceeds the maximum number of 
available licenses for the product".

It is not possible to replace an existing Named User file with another file in which the number 
of Named Users is larger than that of the valid licenses for the product. 

A new Named User can only be added to the Named User file if the total number of Named 
Users is covered by the valid licenses. Otherwise, delete the corresponding number of existing 
Named User beforehand. Use the COMOS LS User Manager to this purpose.

See also chapter Using the COMOS License User Manager (Page 133).
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7.9.6 Error messages with outdated Named User list
When you change or remove a NAMED_USER license, you must also adapt or delete the 
Named User file. You will receive the following messages in case of an error:

● A license of the type NAMED_USER exists, and users are assigned to this license in the 
Named User list. 

– The license type changes to FLOATING. The administrator incorrectly does not adapt 
the assignments in the Named User list.
Effect: The CLS starts correctly but issues the warning "-467" in the log file. Example:
2015-08-19 15:39:13,578 | WARN | >< NamedUser::Read | NAMED_USER 
assignments exist but license type is not NAMED_USER: Basic

– NAMED_USER license is no longer required and is therefore deleted in the license file. 
The administrator incorrectly does not adapt the assignments in the Named User list. 
Effect: The CLS starts correctly but issues the warning "-468" in the log file. Example: 
2015-08-19 15:39:13,578 | WARN | >< NamedUser::Read | NAMED_USER 
assignments exist but product does not exist in license file: RI 
scheme

7.9.7 Old licenses
Old licenses of the "COMOS Basic" module can no longer be used if the corresponding Named 
Licenses are used. Contact the Marketing department in this case.

7.10 License packages

7.10.1 Purpose and definition of packages

Properties
Packages are available so that you can combine licenses to suit your requirements.

A package is defined by means of the following properties:

● A defined name that is unique within all packages

● Assigned licenses from the pool of all existing licenses
These have to be of the FLOATING type.

● A package can only be defined in a server license file.

License file
Packages are stored in a license file (XML format). As the license files are signed, the packages 
cannot be modified manually at a later date.
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A package can be included in several license files, in which case the associated licenses 
complement one another. 

Requirements
A package is requested via your login on the license server. The licenses contained within the 
package can only be activated for you if you have been assigned to the package requested. 
Assuming the results of the check are positive, all the assigned licenses will be at your disposal.

The licenses will not be made available to you under the following conditions:

● If one of the assigned licenses is not present

● If the maximum number of available licenses (for at least one of the license types included) 
are already in use

● No login is assigned uniquely to a package.

If any of these conditions apply, you will be notified accordingly.

7.10.2 Conditions and restrictions
The following conditions and/or restrictions apply when using packages:

● No package can be requested when using ReportToExcel or ReportToWord.

● No package can be requested when using the special login for PQM. As the PQM login is 
restricted to particular licenses, the licenses concerned must be requested individually.

● No package can be requested when using the  COMOS Enterprise Server.

● No package can be requested unless COMOS was started with the /MD:PA start mode.

● Where licenses are interdependent, this is not recognized within the context of packages.
1. Example:
The FDA license is assigned to the BASIC license, where the type is OPTIONAL.
The BASIC license is requested individually.
The BASIC and FDA licenses are both activated.
2. Example:
The BASIC license is included in a CONSTRUCT package.
The CONSTRUCT package is requested.
Only the BASIC license is activated.

7.10.3 Calls via the command line
Enter the "comos.exe /MD:PA" parameter to start the call of the package via the command 
line.

You can find additional information on starting COMOS in the "Operation" manual, keyword 
"Reference of the start parameters".
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7.11 Using COMOS License Server Monitor

7.11.1 Overview of installation types
The COMOS LS Monitor can be installed in two different ways: 

● As part of the COMOS LS setup, it is installed along with the license server.

● If the independent "CLS ServerMonitor" setup is used, it can be installed remotely on a 
different PC.
See Chapter Performing the remote installation (Page 117).

7.11.2 Configuring the Windows firewall for remote installation
If the Windows firewall is running on the computer where COMOS LS is installed, the 
configuration described below is required. 

The procedure during the configuration depends on whether the remote connection user is a 
member of the "Local administrators" group.

User is a local administrator
Configuration takes place via the following call:
netsh firewall set service RemoteAdmin enable 
As an alternative, the Group Policy Editor gpedit.msc can be used: 

1. In the Windows menu, select "Start -> Run".

2. Enter gpedit.msc and click "OK".
The "Group policy" window opens.

3. Open the "Local Computer Policy" path on the left in the tree. "Computer configuration > 
Administrative templates > Network > Network connections > Windows Firewall".

4. If the COMOS LS computer is in the domain, open the folder "Domain profile". Otherwise, 
open the "Default profile" folder.

5. Select the "Properties" command on the right in the context menu of the entry "Windows 
Firewall: Allow remote management exception".
The properties are opened.

6. Activate the "Activated" option.

7. Click "Apply".

8. Click "OK".

9. Quit the application.

In a domain, the domain guidelines can also be distributed via the domain controller, instead 
of defining the guidelines locally on each computer. 
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User is not a local administrator
Configuration takes place via the "DCOM Configuration" application ("dcomcnfg.exe" file): 

1. In the Windows menu, select "Start -> Run".

2. Enter "dcomcnfg.exe" and click "OK".
The "Component services" window opens.

3. Open the "Component services > Computer" path on the left in the tree.

4. Click the "Properties" command in the context menu of the "Workplace" entry.
The "Workplace properties" window opens.

5. Select the "COM Security" tab.

6. Click "Edit Limits..." in the "Launch and Activation Permissions" section.
The "Launch Permission" window opens.

– Click "Add" to add a new user.

– Select the new user from the "Group or User Names" list.

– Select "Remote Launch" and "Remote Activation" from the "Allow" column in the 
"Permissions" list.

– Click "OK".

7. Click "Edit Limits..." in the "Access Permissions" section.
The "Launch Permission" window opens.

– Click "Add" to add a new user.

– Select the new user from the "Group or User Names" list or "ANONYMOUS LOGON".

– Select the "Remote Access" option from the "Allow" column in the "Permissions" list.

– Click "OK".

8. Click "OK".

9. Quit the application.

Depending on the general conditions in the network, the following alternative is also possible: 
adding the user to the local group "Distributed COM Users".

7.11.3 Performing the remote installation

Requirements/System environment
● Framework Net 2.0

● Setup of the Server Monitor (CLS ServerMonitorxx.zip)

● The IP addresses are compared for a remote installation.

Releases
COMOS LS Monitor is released for the following operating systems: 
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32-bit

● Windows XP Pro SP3

● Windows Server 2003 SP1

● Windows Server 2008 SP1

64-bit

● Windows Server 2003 SP1

● Windows Server 2008 SP1

● Windows Server 2008 R2 SP1

COMOS LS Monitor is released for the following COMOS software:

● COMOS LS Process 1.4.2 or higher

Installation
1. Unpack the ZIP file with the COMOS LS Monitor setup.

– The ZIP file is moved to a dedicated, empty folder and is unpacked.

2. Double-click "Setup.exe".

3. Follow the instructions in the InstallShield Wizard.
A log file is created at the following location during the installation:

"<install path>\Data\Logfiles\" directory, "ComosLSMonitor_<PC name>.log" file.

Operation
"Login to Server Monitor" dialog window:

During operation, the PC accesses the services and processes of a different PC. Therefore, 
first log in as an Administrator.

● "User login" / "Password" / "Domain or Computer name"
Enter the correct information to access the remote computer.

● "Remember last login and domain/computer name"
Entries in the "User login" and "Domain or Computer name" fields are stored in the 
"ComosLicenseServerMonitor.exe.config" file and prepopulated at the time of the next call.

● "Use Windows login"
Entries in the "User login" and "Domain or Computer name" fields from the current Windows 
login are used.

● "Full login" button
The login dialog is closed, and the COMOS LS Monitor is displayed.
If access to the services and processes of the remote computer with the selected login is 
refused, a message is displayed and the Server Monitor is started in RESTRICTED  mode. 
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● "Restricted login" button
The login dialog is closed, and the COMOS LS Monitor is displayed.
Only the "Status products" and "Status checkouts" tabs are visible.

● "Close" button
The login is canceled and the COMOS LS Monitor is closed.

If the following information is missing or you do not have access, a message is displayed in 
the login dialog:

● Licenses

● Named User files

● Log files in the file "ComosLSCommon.config"

If this items of information are displayed, they have to be enabled on the remote computer.

Entries in the "ComosLicenseServerMonitor.exe.config"
In the case of a remote installation, the following entries in the 
"ComosLicenseServerMonitor.exe.config" are of relevance:

● <RemoteRememberLogin>
● <RemoteUseWindowsLogin>
● <RemoteUserLogin>
● <RemoteDomain>
See also chapter File: "ComosLicenseServerMonitor.exe.config" (Page 119).

7.11.4 File: "ComosLicenseServerMonitor.exe.config"
For additional configuration details of the "ComosLicenseServerMonitor.exe" file,

See also chapter Reference for ComosLSCommon.config (Page 88).

If COMOS LS Monitor was installed as part of the integrated COMOS LS package, COMOS 
automatically determines the name of the PS as the server name. If COMOS LS Monitor was 
installed by remote installation, the ComosLicenseServer key is evaluated.

<<ConfigSections>
These settings are made automatically and may not be changed.

<applicationSettings>
These settings are made automatically and may not be changed.

<<appSettings>
These settings are partially made in the setup of the COMOS LS.
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Authorized and experienced employees can also change these settings in the config file.

Various settings can only be changed together with settings in other config files.

● <<RunningLevelMonitor>
Permitted values: 0 | 1
Current mode in which COMOS LS Monitor is started. The value is set automatically.

– Value = 0 / FULL.

– Value = 1 / RESTRICTED.

● <IgnoreProxySettings>
Permitted values: 0 | 1

– Value = 0
Regard the proxy settings of the MS Internet Explorer.

– Value = 1 (default and setting if entry missing).
Ignore the MS Internet Explorer proxy settings.

● <<ComosLicenseServerKeepOnRunning>
Permitted values: 0 | 1

– Value = 0 (default and setting if entry missing)
If there are communication problems between COMOS LS Monitor and COMOS LS 
Process (e.g. no response or an error message), this setting closes COMOS LS Process.

– Value = 1
COMOS LS Process remains active.

● <<ComosLicenseServer>
Permitted values: String
This key only exists if COMOS LS Monitor was installed by remote installation (see section 
Performing the remote installation (Page 117)). COMOS LS Process is found by means of 
this key.

● <LogfilesMaxSize>
States the maximum size of the log files.

– <X>: size in MB

– 0: No size limitation for the file
This is also the setting after the installation.

Dependency: <PathLogFilesBackup> 
If the <PathLogFilesBackup> key exists, this setting is evaluated When the configured 
size for the log file is reached, it is either deleted or copied to the directory specified in 
<PathLogFilesBackup>. Logging is then continued with a new file. If the log file is 
deleted, the value for <PathLogFilesBackup> is empty.
Dependency: <<LogfilesSavePerMonth>
The <LogfilesMaxSize> key has priority over the <LogfilesSavePerMonth> key.
If the <PathLogFilesBackup> key is present when the COMOS LS Monitor is started, 
the log file is either deleted or moved according to the associated value, irrespective of 
<LogfilesMaxSize>. If the <PathLogFilesBackup> key is not available and the log 
file therefore continues to be used, the value of <LogfilesMaxSize> is evaluated.
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● <<LogfilesSavePerMonth>
If the <PathLogFilesBackup> key exists, this setting is evaluated

– 0: Deactivated
This is the value after installation.

– 1: When the month changes, the log file is either deleted or copied to the directory 
specified in <PathLogFilesBackup>. Logging is then continued with a new file. If the 
log file is deleted, the value for <PathLogFilesBackup> is empty.

Dependency: <PathLogFilesBackup>
If COMOS LS Monitor is started and the <PathLogFilesBackup> key is available, the 
log file is either deleted or moved in accordance with the associated value, irrespective of 
<LogfilesSavePerMonth>. If the <PathLogFilesBackup> key is not available and 
the log file therefore continues to be used, the value of <LogfilesSavePerMonth> is 
evaluated.

● <RemoteRememberLogin>
– 0: Login and domain / computer name are not stored.

– 1: Login and domain / computer name are stored.

This entry is required if a remote installation is carried out.

● <RemoteUseWindowsLogin>
– 0: Login data of the current Windows session are not used.

– 1: Login data of the current Windows session are used.

This entry is required if a remote installation is carried out.

● <RemoteUserLogin>
Login if <RemoteRememberLogin> is set to 1.
Dependency: <RemoteRememberLogin> 
This entry is required if a remote installation is carried out.

● <RemoteDomain>
Domain or computer name if <RemoteRememberLogin> is set to 1.
Dependency: <RemoteRememberLogin> 
This entry is required if a remote installation is carried out.
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<system.diagnostics>
● <Switches>

The name (name) of the entered key may not be changed. The associated value is set to 
Information after the installation.
This value determines which kind of messages should be logged. The following values are 
possible. The list is structured hierarchically from top to bottom:

– Critical
– Error
– Warning
– Information
– Verbose
A value includes the more critical values in each case. The Warning value, for example, 
also logs all messages classified as Error or Critical.
A change is only applied after restarting the COMOS LS Monitor.
When the COMOS LS Monitor is started, certain information is always logged irrespective 
of the set level. This includes the version and the port as well as the key-value-pairs that 
are read from the configuration files.

● <<sources>
Here, you edit the following setting:
<system.diagnostics> <sources> <source ...> <listeners> <add 
name ...>
initializeData = <path + name logfile>
The path must match the following entry:
<appSettings> <PathLogFiles> 
Generates the optional LOG file.

● <trace>
Serves internal purposes and has to be left.

Example
<?xml version="1.0" encoding="utf-8" ?>
<configuration>
    <configSections>
        <sectionGroup name="applicationSettings" 
type="System.Configuration.ApplicationSettingsGroup, System, 
Version=2.0.0.0, Culture=neutral, PublicKeyToken=b77a5c561934e089" >
            <section 
name="Comos.LicenseServerMonitor.Properties.Settings" 
type="System.Configuration.ClientSettingsSection, System, 
Version=2.0.0.0, Culture=neutral, PublicKeyToken=b77a5c561934e089" 
requirePermission="false" />
        </sectionGroup>
    </configSections>
    <applicationSettings>
        <Comos.LicenseServerMonitor.Properties.Settings>
            <setting name="ComosLicenseWebService" 
serializeAs="String">
                <value>http://cls/WebServices/</value>
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            </setting>
        </Comos.LicenseServerMonitor.Properties.Settings>
    </applicationSettings>

  <appSettings>
    <add key="ComosLicenseServerKeepOnRunning" value="0" />
    <add key="FilterLogFiles" value="*.*" />
    <add key="ViewLogfileWith" value="C:\WINDOWS\notepad.exe" />
    <add key="ViewLogfileWithRegistered" value="1" />
    <add key="StatisticDummyBlock" value="0" />
    <add key="LogfilesMaxSize" value="0" />
    <add key="LogfilesSavePerMonth" value="0" />
  </appSettings>

  <system.diagnostics>
    <switches>
      <add name="ComosLSMonitor" value="Information" />
    </switches>

    <sources>
      <source name="ComosLSMonitor" switchName="ComosLSMonitor" 
switchType="System.Diagnostics.SourceSwitch">
        <listeners>
          <add name="ComosLSMonitor"
               type="System.Diagnostics.DelimitedListTraceListener"
               delimiter=" "
               initializeData="C:/Comos/ComosLS/Server/Data/Logfiles/
ComosLSMonitor.log"
               traceOutputOptions="DateTime" />
          <remove name="Default"/>
        </listeners>
        </source>
    </sources>

    <trace autoflush="true" indentsize="2" />
  </system.diagnostics>
</configuration>

7.11.5 Reference to the Server Monitor

7.11.5.1 "File" menu
● "Running mode"

The possible modes in which the server monitor can be started are displayed. The current 
mode is marked. You can switch to the other modes. 

● "Clear status messages"
A portion of the messages from the license server are output at the very bottom in the 
"Status messages" field. The entries in this field can be deleted via "Clear status messages". 
A complete list of messages is given in the log file.
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7.11.5.2 "License Server" tab
Controls the license server. 

"COMOS LS" control group
● "Stop COMOS LS" button

Terminates the ComosLSService, i.e. the license server. 

The COMOS clients are closed if the license server is terminated. Any work that is open is lost.

● Traffic light: Running Level

– Red (STOPPED): Server is stopped; no available licenses.

– Yellow (RESTRICTED): Started with restrictions: the currently required Named User file 
is missing. The Named User sequence may be reset.

– Green (FULL): Server active.

– Question mark (UNKNOWN): An error occurred after starting the COMOS LS Monitor. The 
status of COMOS LS Process cannot be detected. The "Start COMOS LS" or the "Stop 
COMOS LS" button is not available. However, it is possible to send status requests to 
COMOS LS Process. Even if such a query delivers a positive result, the status 
UNKNOWN is retained.

● "Connection string to ComosLS" field
The network server on which the ComosLSService runs. This field can also contain an 
alias. If this network server is shut down or fails, then the license server fails as well. 

● "Connection port from ComosLS" field
The port number under which COMOS LS Process can be reached. 

● "Last start time" field
Start time of the license server. 

● "Version of Server Process" field
Version of the license server. 
(You will find the version number of the COMOS LS Monitor under "Help > About".)

● "Ignore system proxy settings" field
Displays the value for IgnoreProxySettings that has been entered in the 
"Comos.LicenseLib.config" file. The setting can here not be changed in the interface. 

● "Restriction" field
For internal use. Default value: DONGLE.

● "Restricted to dongle ID" field
The on the dongle burned in ID. Must be the same as the ID on the dongle sticker.
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"Information from the first license file" control group
● "Vendor" field

Siemens AG

● "Client" field
The in the dongle specified owner of the license file.

● "Restricted to dongle ID" field
The on the dongle burned in ID. Must be the same as the ID on the dongle sticker.

License files table
The table displays all the available license files.

Background: Due to the change to the new license server, it is possible to use more than one 
license file. The available licenses are the sum of all licenses (which have not expired) that 
are included in the license files.

● "Colors" button
Opens a legend for the colors in the "License Files" list.

● "Show License Files" button
Switches to the "License Files" tab.

7.11.5.3 "Status Products" tab
Module-related view of the licenses that are used and available. 

"Product" list
Lists all products and modules that exist in the license files displayed on the tab. Any desired 
number of entries can be selected from this list. The details of this selection are then displayed 
in the other lists. 

"Status enquiry" control group
● "Start status enquiry" button

Updates the tab. 

● "Date of status enquiry" field
The content of this tab is not updated continuously for reasons associated with 
performance. The status displayed on the tab can differ from the actual license usage due 
to users logging in and out. You can tell from the date how old the displayed status actually 
is. If necessary, you have to click the "Start status enquiry" button again. 

"Product details" table 
● "Product" column

The relevant product (which means the relevant license). 

● "Total count" column
Total number of available licenses for this module in all available license files. 
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● "Checked out" column
Number of licenses for this module that are currently in use ("checked out"). 

● "Type" column
"Floating" or "Named User". 

● "State" column
"Not expired" or "Expired". 

"Sequences" table 
● "Product" column

The relevant product (which means the relevant license). 

● "Sequence ID" column
Lists the assignment of the license to a license file. 
At the end, the license files have one unique counter per customer: the "Sequence ID". The 
associated license files can be found in the "License Server" tab by means of the Sequence 
ID. 

● "Count" column
Number of available licenses for this module in the license file specified with Sequence ID. 

● "Expiration date" column
Expiration date of the licenses. A license file does not necessarily need to have a general 
expiration date. It is also possible to order a license file from Siemens AG that assigns 
different expiration dates to the licenses or license blocks within the license file. 

"Status messages" field  
Provides feedback messages from COMOS LS Monitor.

7.11.5.4 "Status Checkouts" tab
Mapping between licenses and users.

"Status enquiry" control group
● "Start status enquiry" button

Updates the tab in accordance with the selected option. 

● "For all products" option
The left-hand field receives the title "Product". All products that are at least available in one 
of the available license files appear in the list. All modules that are currently being used 
within the selected user group are marked in red. 

● "For all users" option
The left-hand field receives the title "User". All users who obtained at least one license are 
displayed in this list. 

● "For user" option
The left-hand field receives the title "User". The stated user is displayed in the list if this 
user obtained at least one license. Otherwise the list remains empty. The entry in the "For 
user" field must be identical to the login name in COMOS (not case-sensitive). 
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If you click on one or more entries in the list, specific information is displayed in the "Details" 
and "Count" lists. 

● "Date of status enquiry" field
Date on which the tab was last updated. The last update could have either taken place 
manually via the "Start status enquiry" button or automatically via "Update view after 1 
minute". 

● "Update view after 1 minute" option
Automatically updates the tab after one minute. Without this option, the following applies: 
The displayed information could be outdated. 

"Details" table
Columns 1 and 2 swap depending on whether products or users are entered in the list. 

● "IP of client" column
Network address of the computer that obtained the license. 

● "Checkout time" column
Time at which the license was checked out. 

If a COMOS client is terminated unexpectedly, no direct release of the respective licenses is 
carried out.

If this unexpected termination took place further back than 6 minutes ago, the respective 
licenses are displayed with a yellow background.

After 10 minutes, the licenses are then marked at COMOS LS as temporarily unavailable and 
released again during the next Runtime check.

As long as this Runtime check has not yet been carried out, the licenses have a red 
background. This highlighting is only carried out if you have selected the "For all products" 
option.

"Counts" table
● "Licenses checked out" column

For each selected entry in the list, the number of currently used licenses is displayed here. 

● Column "Licenses: total count"
For each selected entry in the variable list, the maximum number of available licenses is 
displayed here.

7.11.5.5 "License Files" tab
Content of the license files. 

● "Path of license files" field
Common storage location of all available license files. 

● "Show status details" button
Switches to the "Status Products" tab and selects all entries in the "Product" list. 
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"License files" table
Displays the content of the license files. 

● "Colors" button
Opens a legend for the colors in the "License Files" list.

Table displaying the content of the license file
One or more subordinate tabs with the corresponding details. 

● "Product" list
On the far left there is a list of the products included in the license file.

● "Packages" list
Structure of license packages: 

– First level: Package name

– Second level: Licenses included

● "Dependencies" list
In some cases, license dependencies are defined by Siemens AG. For example, one 
license can contain another license ("INCLUDE").

7.11.5.6 "Named User" tab
Reads the contents of the selected Named User license file. 

The Named User file can be purchased in addition to the license files. It is incremented and 
there can always be only one valid Named User file.

"Actual 'Named User' files" control group

"File list" table
You have to select a XML file here, which is then displayed in detail on the right. 

"Details of selected file" table
This list points to the data of the XML files selected on the left. 

● "Product"
The functionality for which a license was checked out. 

● "User"
The assigned user.

● "User insertion time"
Time at which the user was assigned to the product.

● "Tickets"
Displays how many tickets were available in this XML file. 

● "Ticket SID"
Each addition of tickets increments the ticket sequence. 
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"Colors" button
Via this button explanations regarding the possible colors are provided in which a named user 
file can be displayed. 

"Named User file to compare" control group
This area contains a list with all Named User files. If a file is selected there, the associated 
details are displayed in the "Details of selected file to compare" table and can be compared 
with the above displayed values.

7.11.5.7 "Logging" tab
Storage location of the LOG files: 

The LOG files can be opened by double-clicking on them. 

"Load log files" control group
● "Filter for reading the logfiles" fields

Only LOG files whose file name corresponds to the specified filter are displayed in the "Log 
files" list. 

● "Reload log files" button
Updates the list of LOG files according to the selected filter settings. 

"Log files" control group
● "Path of active log files" field

Shared storage location of the LOG files. 

● "Path of moved log files" field
Shared storage location of all backup LOG files.

● "Show moved log files" option
Also displays the saved LOG files in the "Log files" list, provided that their file name 
corresponds to the specified filter. 

"Log files" table
List of all LOG files whose file name corresponds to the specified filter. The LOG files can be 
opened by double-clicking on them. Saved LOG files are displayed in blue. 

The local LOG file of a COMOS LS Monitor remote installation is displayed in green.

7.11.5.8 "Statistic" tab
Updates the "Workload" and "Denials" control groups according to the selected time range. 
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"Status enquiry" control group
● "Start status enquiry" button

Updates the lists for "Workload" and "Denials" according to the selected time range. 

● "Per license groups" option
The values per product are grouped according to license groups. If no license groups are 
defined or if there is no assignment of a product to a license group, a dash ("-") is displayed 
as the name.

● "Per users" option
The values per product are grouped according to users. 

● "For user" option
The display is conducted per product for the stated user. 

● "Evaluate from" and "Evaluate to" list
Definition of a time range for which statistical data is supposed to be collected and displayed.

"Workload" control group
Depending on the selected grouping, a "License group" or "User" header is assigned to the 
first column. The use of each product is indicated in the "Number of checkouts / Time used in 
hours" structure. If the product was not used, a dash ("-") is displayed.

The hour values are displayed in the h,hh  format. A value of 1.5 thus corresponds to 1 hour 
and 30 minutes. 

"Denials" control group
● "Sum" table

For each product the complete number of all declined license requests in a certain time 
range is displayed.

● "Denials" table
Depending on the selected grouping, a "License group" or "User" header is assigned to the 
first column. For each product the complete number of declined license requests in a certain 
time range is displayed. If there are declined license requests the field is displayed with a 
yellow background.

7.11.5.9 "License Server" menu
This menu is part of the "License Server" tab. When the menu is opened, the corresponding 
tab is automatically displayed. 

● "Start ComosLS"/ "Stop ComosLS"
The same functionality as the according button. Caution: The COMOS clients are closed 
if the license server is terminated. Any work that is open is lost. 

● "Refresh server info"
Updates the tab. 

● "Test dongle"
 Determines the dongle ID and displays the result in the "Status messages" field.
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● "Reload existing license files"
All license files located in the configured directory are reloaded The current state in the 
COMOS LS Process is checked for consistency with the new information from the license 
files. The administrator gets a message concerning the process. If the license files cannot 
be loaded due to consistency errors, the current state is kept in the COMOS LS Process, 
and the administrator receives information regarding the errors. 

● "Copy and reload new license files"
First, a dialog opens in which new license files can be selected. After confirming your 
selection the license files are copied to the configured directory. 
Afterward, "Reload existing license files" is executed automatically. 

● "Disable selected license files"
Invalid or expired license files initially remain in the overview. With this command such a 
file can be moved into a backup folder or be deleted. To do so, click the "Delete" button or 
the "Move" button. If you click the "Move" button, a security message is displayed if this 
license file has already been saved at an earlier time. 
If license files are to be deleted, the COMOS LS Monitor automatically checks to see if the 
sum of the remaining license files is consistent. If the remaining license files are not 
sufficient then there is a response to the user and the files are not deleted. 
As an alternative a license file can be deleted (or moved) on the file level. If you then refresh 
the COMOS LS Monitor, this has the same effect as the "Disable selected license files" 
command. 

● "Passwords"

– "Create password for applications"/ "Change password for applications": As of version 
1.3.3, a password is required to start the COMOS LUM. This password is stored in the 
following file: 
"<install path ComosLS>\Data\Basic\" directory, "Password.xml" file. This password can 
be created or changed via this menu command. If a password already exists, the name 
of the menu command changes to "Change password for applications". The password 
can also be set in the "Restricted" mode of the server.

– "Create password for user access"
A password is required to access the license server entered via the COMOS command 
line. This password is stored in the following file:
"<install path ComosLS>\Data\Basic\", "PasswordUser.xml" file
If a password already exists, the name of this menu command changes to "Change 
password for user access". The password can also be set in the "Restricted" mode of 
the server. See also chapter Transferring the license server using the COMOS start 
parameter (Page 157).

7.11.5.10 "Named User" menu
● "Reload files"

Reads the information from the license files again.
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7.11.5.11 "Logging" menu
This menu is part of the "Logging" tab and contains the following commands: 

● "Reload files"
Updates the list of log files according to the selected settings.

● "View file with registered application"
Activated: Displays the log file with the application registered for the .log extension. 
Deactivated: Displays the log file with the selected application (notepad.exe by default). 

● "Choose application to view file"
Opens a dialog to select an application to be used to display the log files.

7.11.5.12 "Statistic" menu

Note
You are not permitted to store your own data or to edit the existing data inside the "<Comos 
LS>\Data\Logfiles\Statistic" directory or any of the subdirectories.

Description
This menu is part of the "Statistic" tab and contains the following commands: 

● "Generate data for workload"

Turns the generation/update of statistical data in the COMOS LS on and off. 

● "Generate data for snapshot"

Turns the generation of data for the actual utilization in the COMOS LS on/off. 

● "Start status enquiry"
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Updates the "Workload" and "Denials" lists according to the selected time range. 

● "Save data"

– "Actual workload"
Creates a CSV file with the values currently displayed in "Workload". The file name can 
be selected. The stored data is separated by semicolons. 

– "Actual denials"
Creates a CSV file with the values currently displayed in "Denials". The file name can 
be selected. The stored data is separated by semicolons. 

● "Create statistical file"

– "Usage"
Creates a CSV file with statistical information regarding the selected time range. The 
source files are: 
"<Comos LS>\Data\Logfiles\Statistic\Users\<Year>\<Month>...": 
"ComosLSLicenseWorkload_<year>_<month>.log" 
File structure: 
1. First row with headers:
Product;Timestamp;Usage;Count;Percentage Usage
All other rows with the corresponding data. 

– "Denials"
Creates a CSV file with information on denied requests with reference to the selected 
time range. The source files are:
"<Comos LS>\Data\Logfiles\Statistic\Users\<Year>\<Month>...": 
"ComosLSLicenseWorkload_<year>_<month>.log" 
File structure: 
1. First row with headers: 
Product;Timestamp;Denial 
All other rows with the corresponding data.

7.12 Using the COMOS License User Manager

7.12.1 Purpose of the License User Manager
The COMOS License User Manager (COMOS LUM) manages users and license groups and 
enables assignments of users to licenses of the "NAMED_USER" type. In addition, 
assignments of users and license groups to products can be defined. The respective 
assignment is classified by a type.

You initially work in the protected environment of the COMOS LUM. Your changes do not affect 
the work of the user until you click the "Save changes" button. 

If there are any changes that still have not been taken into account when the COMOS LUM is 
closed, you are notified. You then either discard the unaccounted changes or transfer them to 
the actual license server via "Save changes".
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7.12.2 Prerequisites/System environment
Framework Net 2.0 

Setup of the COMOS LUM (CLS UserManagerxx.zip) 

Releases
COMOS LUM is released for the following operating systems: 

32-bit

● Windows XP Pro SP3

● Windows Server 2003 SP1

● Windows Server 2008 SP1

64-bit

● Windows Server 2003 SP1

● Windows Server 2008 SP1

● Windows Server 2008 R2 SP1

7.12.3 Installation

Unpacking the ZIP file
CLS UserManagerxx.zip 

1. Place the ZIP file in a dedicated, empty folder and and unpack the file.

2. Start the "Setup.exe" file.

3. Then follow the instructions in the InstallShield Wizard.

Optional: Uninstalling the previous User Manager
If a COMOS LUM is already installed on the client, you will first be asked to remove the old 
version.

The following steps are required for removal:

1. Setup language
"Choose a setup language"
The application is removed in the language in which it was also installed.

2. Welcome window

3. Program administration
Select "Remove program"

4. Remove program
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5. Finish
InstallShield Wizard is completed.

6. Start "Setup.exe" again manually.

Installation
Setup runs through the following steps:

1. Setup language
"Choose a setup language"

2. Welcome window

3. Select destination folder

4. License server
The COMOS LUM must work with a license server.
"Name": Any.
"Port": The port specification 27011 is a suggestion.

5. Install

6. Finish
InstallShield Wizard is completed.

7.12.4 Starting and saving
COMOS LUM 1.3.3 and later starts with a password. This password is generated via the 
COMOS LS Monitor and is administered and checked via the server. 

If you enter an incorrect password or COMOS LS is not running, a message is displayed and 
the application is closed. See also chapter "License Server" menu (Page 130).

"Save changes" button
You must save all changes before changing to another tab. The information in the tabs is 
interdependent. If you change to a different tab without first saving, out-of-date data can be 
displayed.

7.12.5 ComosLicenseUserManager.exe.config

<<ConfigSections>
These settings are made automatically and may not be changed. 

<applicationSettings>
These settings are made automatically and may not be changed. 
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<appSettings> 
These settings are made in the setup. 

Authorized and experienced employees can also change these settings in the config file. 

Please note that some settings can only be changed together with settings in other config files. 

● <IgnoreProxySettings>
Permitted values: 0|1 

– Value = 0:
Regard the proxy settings of the MS Internet Explorer. 

– Value = 1: 
Default and setting if an entry is missing
Ignore proxy settings of the MS Internet Explorer. 

● <add key="ComosLicenseServer" value=""/> 
● <add key="ComosLicenseServerPort" value="27011" /> 

Default value: 27011 
This value is also used in the case of a missing key or an empty value.

7.12.6 Relationship between "Package Assignments" and "License Assignments" 
If a user has been assigned to a package, he may still draw on licenses that are not allocated 
to his package.

If a license not included in the user's package is requested in COMOS and is available, this 
license is also placed at the user's disposal.

Only make those licenses that are included in the assigned package available to the user. Go 
to the "License Assignments" tab and stop the user concerned from having access to all 
licenses.

These two options ensure a high degree of flexibility when using packages and license 
assignments.

7.12.7 Reference to the User Manager license

7.12.7.1 Status area

License server status
Indicates the network name of the server, the dongle ID and the proxy settings. 

Named User status
Indicates the ID, the available tickets, and the current sequence identifier ("Ticket SID").
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7.12.7.2 "Named User" tab

"User list"
Display of all users that were detected as users and can be mapped to a product of the type 
NAMED_USER.

"License list of type NAMED_USER" table
Displays all products of the type NAMED_USER: 

COMOS LS tells COMOS LUM which licenses of type NAMED_USER are available. 

● Column "Licenses: total count"
Maximum number of available licenses. 

● Column "Licenses: available"
Maximum number of available licenses.
If more users are assigned than there are available licenses, then the difference is displayed 
in this column by a negative number which has a red background.
When a license is freely available for use again, it can be assigned again without restarting 
COMOS.
If obtaining a new Named_User license fails, a new attempt can be made after two minutes 
respectively.

"Assign" button
After the start, the button is displayed in red and cannot be selected. 

If at least one entry is selected in the "User list" table and at least one in the "License list of 
type NAMED_USER", the color changes to green and the button can be used. Clicking the 
button assigns the selected users to the selected product and highlights them in yellow in the 
"Assigned to products" table. 

When the details are sent to the COMOS LS via the "Save changes" button, the yellow 
highlighting disappears. 

An already assigned user cannot be assigned again. 
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"Assigned to products" table
Displays all users that are already assigned to a product of the type NAMED_USER. 

● "Assigned to products" table, "Delete selected assignments" context menu
Selecting this menu brings up a prompt asking whether you really want to delete the 
assignment. If the prompt is confirmed, all entries marked in green are deleted immediately. 
If there are enough tickets available, existing entries are marked in red and are thus marked 
for deletion. For each entry marked in red the number of tickets on the status bar is 
incremented by one digit. The display in the "License list of type NAMED_USER" list is 
refreshed if needed. 
If there are not enough tickets available, a message appears and deleting is not possible. 

● "Assigned to products" list, "Remove flag for deletion from selected assignments" context 
menu
If a red mark exists for a selected element, it is removed again. 

If the total of the entries is greater than the specification in the "Licenses: total count" column, 
then you have fewer licenses for a product than entered Named Users. 

"Save changes" button
Saves the inputs and updates the other tabs.

7.12.7.3 "License Groups" tab

"New license group" control group
● "Group name" / "Confirm group name" field

Entry and confirmation of a new license group. The input is converted to upper-case letters. 

● "Add to group list"
The new license group is added to the "Group list" and displayed with a yellow background. 
An existing license group cannot be inserted a second time. The administrator then receives 
a message. 

"Group list"
Contains all previously saved and newly collected (yellow highlighted) license groups. 

● "Group list"

– "Delete selected groups" context menu
Entries marked in green are deleted immediately. Existing entries are marked in red and 
are thus marked for deletion. 

– "Remove flag for deletion from selected assignments" context menu
If a red mark exists for a selected element, it is removed again. 

● "Group list"

– "Change to license assignments" context menu
Switches to the "License Assignments" tab, where the "Group list" and "Assigned 
groups" subtabs are displayed.
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"Save changes" button
Saves the inputs.

7.12.7.4 "Users" tab

"New user" control group
● "User name" / "Confirm user name"

Used to enter and confirm a new user. The input is converted to upper-case letters. 

● "Comment"
When you enter a new user, you have the option of recording a comment directly.
You can edit or add to a comment at any time. To do this, double-click the relevant entry 
in the "User list". The selected user appears in the "New user" control group. The user is 
prevented from accessing the "User list" and fields. The "Comment" field turns yellow and 
you can enter a comment inside it. The description of the "Add to user list" button changes 
to "Update user".
Once you have entered your comment and confirmed it by pressing the "Update user" 
button, the software reverts to the original state. The entire row in the "User list" is now 
highlighted in yellow, which means that changes have been made in respect of the user. 
To complete the process, click the "Save changes" button.
All data is encoded and sent to the license server in encrypted format. When entering your 
comment, avoid using any foreign and special characters (because of the ANSI encoding/
ANSI decoding used to date). Any such characters will be lost during transfer.

● "Add to user list" button
The new user is added to the "User list" and displayed with a yellow background. 
An existing user cannot be added again. The administrator then receives a message.
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"User list"
Contains all previously saved and newly collected users (displayed with a yellow background). 

● "User list"

– "Delete selected users" context menu
Entries marked in green are deleted immediately. Existing entries are marked in red and 
are thus marked for deletion. 

– "Remove flag for deletion from selected assignments" context menu
If a red mark exists for a selected element, it is removed again. 

– "Change to license assignments" context menu
Switches to the "License Assignments" tab, where the "User list" and "Assigned users" 
subtabs are displayed.

– "Change to license group assignments" context menu
Switches to the "License Group Assignments" tab.

– "Change to 'Named User' list" context menu
Switches to the "Named User" tab.

– "Change to package assignments" context menu
Switches to the "Package Assignments" tab.

● "License group assignments" column
Displays all license groups to which the user is assigned. 

● "License assignments" column
Display of all licenses assigned to the user. 

● "Part of Named User list" column
Indicates whether the user is included in a Named User list. 

● "Package assignments" column
The package name is displayed here, assuming an assignment has been set up for the 
relevant user.

"Save changes" button
Saves the inputs.

7.12.7.5 "License Group Assignments" tab

"User list"
List of all collected users that can be assigned to a license group. Multiple users can be 
selected. 

"Group list"
List of all collected license groups to which a user can be assigned. A selection of multiple 
license groups is possible. 
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"Assign" button
After the start, the button is displayed in red and cannot be selected. 

If at least one entry is selected in the "User list" and one in the "Group list", the color switches 
to green and the button can be used. Clicking this button assigns the selected users to the 
selected license groups and highlights them in yellow in the "Assigned users" list. 

When the details are sent to COMOS LS Process via the "Save changes" button, the yellow 
highlighting disappears. 

An existing assignment cannot be created again. The administrator receives a message to 
this effect. 

"Assigned users" list
List of all users already assigned to a user group. 

An existing user cannot be added again. The administrator then receives a message.

● "Delete selected assignments" context menu
Entries marked in green are deleted immediately. Existing entries are marked in red and 
are thus marked for deletion. 

● "Remove flag for deletion from selected assignments" context menu
If a red mark exists for a selected element, it is removed again.

"Save changes" button
Saves the inputs.

7.12.7.6 "License Assignments" tab

"User list"
List of all collected users who can be assigned to a product. Multiple users can be selected. 

"Group list"
List of all collected license groups that can be assigned to a product. A selection of multiple 
license groups is possible. 

"License list"
List of all products to which users and/or license groups can be assigned. For each product, 
the number of the existing licenses and the number of already reserved licenses are displayed. 
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"Assigned users" list
List of all users already assigned to a product. An existing assignment cannot be added again. 
The administrator then receives a message. 

● "Delete selected assignments for users" context menu
Entries marked in green are deleted immediately. If these are of the type "RESERVE", the 
"Reserved" column in the "License list" is refreshed accordingly. If there are no existing 
new assignments left, the corresponding value is displayed normally again.
Existing entries are marked in red and are thus marked for deletion. 

● "Remove flag for deletion from selected user assignments" context menu
If a red mark exists for a selected element, it is removed again. 

"Assigned groups" list 
List of all license groups that are already assigned to a product. An existing assignment cannot 
be added again. The administrator then receives a message. 

● "Delete selected assignments for groups" context menu
Entries marked in green are deleted immediately. If these are of the type "RESERVE", the 
"Reserved" column in the "License list" is refreshed accordingly. If there are no existing 
new assignments left, the corresponding value is displayed normally again.
Existing entries are marked in red and are thus marked for deletion. 

● "Remove flag for deletion from selected group assignments" context menu
If a red mark exists for a selected element, it is removed again. 

"… as type" group
Every assignment to a product is classified by a type. 

● "RESERVE"
The number of licenses specified for the type "RESERVE" is reserved so that this number 
is always available for the assigned users and/or license groups. 
Here, the number of licenses to be reserved must be clearly stated.

● "EXCLUDE"
The use of the product is not allowed for users who are directly or indirectly assigned via 
a license group. 

● "INCLUDE"
The use of the product is allowed for users who are directly or indirectly assigned via a 
license group.

"Assign" button
After the start, the button is displayed in red and cannot be selected. 

If at least one entry is selected in the "User list" or the "Group list", and one entry is selected 
in the "License list", the color switches to green and the button can be used. If the button is 
used, the selected users or license groups are assigned to the selected product with the 
selected type and displayed in yellow in the "Assigned users" list or the "Assigned groups" list. 
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When the details are sent to COMOS LS Process via the "Save changes" button, the yellow 
highlighting disappears. 

● Special case: "RESERVE"
If these are of the type "RESERVE", the "Reserved" column in the "License list" is refreshed 
accordingly and highlighted in yellow. This update now displays the current status within 
the "COMOS LS User Manager" and therefore differs from the values still stored on the 
license server. 
New assignments can only be made for the type "RESERVE" if the number of licenses 
already reserved plus the number of new licenses to be reserved does not exceed the total 
number of licenses for the respective product.

An existing assignment cannot be created again. The administrator receives a message to 
this effect.

"Save changes" button
Saves the inputs.

7.12.7.7 "Package Assignments" tab

"User list"
Contains all the users entered on the system who can be assigned to a package. Multiple 
users can be selected.

"Package list"
Contains all the packages from the license files to which a user is assigned.

Only one package can be selected at a time, because a user may only be assigned to one of 
them.

"Assign" button
After the start, the button is displayed in red and cannot be selected.

If at least one entry is selected in the "User list" and one entry (and only one entry) is selected 
in the "Package list", the color changes to green and the button can be used. Clicking this 
button assigns the selected users to the selected package and highlights them in yellow in the 
"Assigned users" list.

"Save changes" button
When the details are sent to COMOS LS via "Save changes", the yellow highlighting 
disappears. An existing assignment cannot be created again. If applicable, you will be notified 
accordingly.
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"Assigned users" list
Contains all the assignments between a user and a package. An existing user cannot be added 
again. If applicable, you will be notified accordingly.

The "Assigned users" list has an associated context menu containing the following menu 
commands:

● "Delete selected assignments"

– Entries marked in green are deleted immediately.

– Existing entries are marked in red and are thus marked for deletion.

● "Remove flag for deletion from selected assignments"

– If a selected element is marked in red, the red marking is removed again.

7.12.7.8 Status
Existing assignments are displayed in the "Assigned users" list in the "Package Assignments" 
tab.

7.12.7.9 "File" menu

Refresh Views
Sends a request to COMOS LS and refreshes the lists.

Exit 
Closes COMOS LUM.

7.12.7.10 "Named User" menu

Change Named User file
In the "Change Named User file" dialog box, the "Current sequence ID" and any incidentally 
generated "Request code" are initially displayed:

The "Request code" is disclosed to the support employee by telephone. This employee 
provides the "Answer code". 

The user enters the "Answer code" and presses "Reset dongle". 

Automatically delete overwritable files
Sets a flag on the license server to determine if the remaining files with a higher "sequence 
ID" should be deleted automatically after a reversion to an older Named User file. 
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Import assignments from file
You use this function to import an existing assignment list of Named User licenses to users. 
An existing assignment list exists when you have changed from dongle-based license 
management to COMOS LS Host-ID. See also chapter Dongle-free license with COMOS LS 
Host-ID (Page 167).

You import an existing assignment list as follows:

1. Start the Server Monitor.

2. Switch to the "Named User" tab.
See chapter "Named User" tab (Page 128).

3. Check the storage location of the assignment list in the "Path of 'Named user' files" field.

4. Check the file name of the currently used assignment list in the "File list".

5. Start the User Manager.

6. In the menu bar, select the "Named User > Import assignments from file" command.

7. Select the assignment list determined above.

Add tickets
Calls a dialog window in which a ticket file can be selected. After selecting a ticket file, tickets 
are entered at the license server and the view is refreshed. 

Automatically add user
Sets a flag at the license server to determine if users of Named User licenses should 
automatically be entered in the Named User file when checking out. 

Each user must be individually activated in the License User Manager if this option turned off.

"Save changes" button
Saves the inputs.

7.12.7.11 "License Groups" menu

"Save changes" button
Saves the inputs.

See also
Starting and saving (Page 135)

COMOS License Management (COMOS LM)
7.12 Using the COMOS License User Manager

Installation Manual, 03/2017 V10.2.1, A5E37082844-AB 145



7.12.7.12 "Users" menu

Import Named User
All users who are already assigned to a product as Named Users, but do not yet exist as users 
are imported into the "User list". This menu is intended for customers who have already created 
Names Users using an earlier version and do not want to enter them again. 

Import from text file
Imports all entries of a previously selected file as user. Each row of the file is interpreted as a 
user, and spaces are deleted. 

Import from CSV file
Imports all entries of a previously selected file as user. The entries have to be separated by a 
semicolon; line breaks and spaces are deleted.

"Save changes" button
Saves the inputs.

7.12.7.13 "License Group Assignments" menu

"Save changes" button
Saves the inputs.

7.12.7.14 "License Assignments" menu

"Save changes" button
Saves the inputs.

7.12.7.15 "Package Assignments" menu

"Save changes" submenu
Corresponds to the "Save changes" button in the "Package Assignments" tab.
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7.12.7.16 "Help" menu

About...
Version information.

7.13 Using the COMOS Remote License Supplier

7.13.1 Purpose
The COMOS LS Remote License Supplier serves to connect a COMOS client to a Citrix Server 
without having to use the COMOS ICA Client. Instead, the Microsoft terminal client or Citrix 
terminal client can be used. It is recommended to always work with the most recent client 
version.

As a part of this technique, the client transfers its license to the terminal server. The license 
may be a PC license or it may be obtained from a license server. 

With the COMOS LS Remote License Supplier, the same result can be achieved as with a 
Citrix client, but without VPN access, and also via a web-based client (e.g. Citrix Web Interface).

See also
Installing COMOS on Citrix (Page 172)

7.13.2 Prerequisites/System environment

Requirement
● Current COMOS version (installed on the server)

● Setup for COMOS Remote License Supplier (CLS RemoteLicenseServicexx.zip) 

Releases
The same requirements and the same system environment apply as for COMOS LS. See 
section Requirements/System environment (Page 81).

7.13.3 Installation on the client

Unpacking the zip file
CLS RemoteLicenseServicexx.zip 
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The ZIP file is moved to a dedicated, empty folder and is unpacked. After unpacking, the 
following file is started:

"Setup.exe"

The InstallShield Wizard will now guide you through the installation.

Optional: Uninstalling the previous Remote License Supplier
If a Remote License Supplier is already installed on the client, the "Setup.exe" file will first ask 
you to remove the previous version.

The removal language is always the same language that was used during the installation. The 
following steps are required for removal:

1. Setup language
"Choose a setup language"

2. Welcome window

3. Program administration
Here, select: "Remove program"

4. Remove program

5. Finish

InstallShield Wizard is completed. You have to start the "Setup.exe" file again manually.

Installation
Setup runs through the following steps:

1. Setup language
"Choose a setup language"

2. Welcome window

3. Select destination folder

4. Path to the .DAT file
Select the folder in which the DAT file is to be created. The folder selected or entered here 
is handled as follows:

– The folder is created, if required.

– The "client.dat" file is created in the folder.

– "Control Panel > System": "Extended" tab, "Environment variables" button: The 
"RemoteLicense" system variable is created and populated with the above specified 
folder.

5. Optional: License server
At this point, the InstallShield Wizard checks whether COMOS is already installed on the 
PC. If COMOS is not installed, the "License server" dialog is displayed additionally.

6. Install

7. Finish

InstallShield Wizard is completed.
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Central installation files
Alternatively: the installation files can also be stored in the network. In this case, the setup can 
be controlled by means of an INI file:

In parallel with the "setup.exe" file: 

rls.ini 
[DATFILE]

Path="C:\RemoteLicense"
The path information is then displayed as the default value in the "Enter Directory of the *.DAT 
Communication File" dialog window. The default value can be overwritten manually.

Otherwise, the setup works exactly as described above.

7.13.4 Installation on the server

Overview of the terminal server with Citrix server
COMOS switches to the Remote License technique when an environment variable named 
"RemoteLicense" is detected on program startup. If you implement this setting on the server 
side in the environment variables of the operating system, it affects all the COMOS instances 
that are launched on the server.

If this is not desired, a session-based setup is also possible. For this, the environment variable 
is only set once a user has started COMOS. Then you can use the COMOS RLS as required.

To allow session-based setting of the environment variable, this variable must be configured 
in a script in which COMOS is subsequently started. It then applies to one user and one 
COMOS; other users are not affected by this. This script is saved in a file and published on 
Citrix as an additional application. This script file is started on a terminal server by double-
clicking it.

Alternatively, you can also embed the script in the login scripts of specific users.

When the environment variable is detected, COMOS writes a file named "client.dat" to the path 
that is included in the "RemoteLicense" environment variable. For this mechanism to work, 
COMOS needs write access on the client.

Configuring write access for Citrix client software
1. Open the Citrix connection.

2. Select the "Full access" option from the dialog box.

3. If the window does not open, select the "Open Connection Center" command in the context 
menu of the Citrix client icon in the task bar.
The "Citrix Connection Center" window opens.

4. Select your connected server.

5. Click on the "File security" button.

6. Assign the desired rights.
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Configuring write access for MS Terminal Server clients
For Terminal Server the Remote Desktop Client is required. 

1. In the Windows menu, select "Start -> Run".
The "Run" window opens.

2. Enter "mstsc.exe".
The Remote Desktop client starts.

3. Click "Options".

4. Select the "Local Resources" tab.

5. Select the "Drives" options.

6. Save your settings as a file or click directly on "Connect".

Sequence
A script is prepared on the server.

● The "RemoteLicense" environment variable is set in the script.

● When using the Citrix client: \\client\c$\<path>
● When using the Terminal Server client: \\TSClient\c\<path>
● The Citrix client accesses the Citrix Server and starts the script file, which is published as 

an application. The particularity here: The environment variable set in the script only affects 
the user's own session; it has no effect on those of other users.

Script examples
The script examples must be located parallel to "Comos.exe".

1. Citrix Server
set RemoteLicense=\\client\C$\RemoteLicense\Client.dat
start comos.exe
exit

2. Terminal Server
set RemoteLicense=\\TSClient\c\RemoteLicense\Client.dat
start comos.exe
exit

7.13.5 Operation

Start parameter
/AUTOMINIMIZE: The application is minimized automatically after the start without a 
confirmation. 
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Start
1. Click "Start > Programs > COMOS Remote License Service" in the Windows menu.

The "Minimize to tray" query is displayed.

2. Select one of the following options:

– "OK": The Remote License Supplier interface is minimized and can only be opened via 
the icon in the system tray (task bar).

– "Cancel": The Remote License Supplier user interface remains open.
Then connect the computer to the terminal server and start COMOS.

7.13.6 LicenseLib

General
LicenseLib controls access to the local license files (if available) and handles all 
communication with COMOS LS. LicenseLib is included both in the current service packs 
and in the Remote License Supplier setup. 

The LicenseLib file of the service pack and the LicenseLib file of the Remote License 
Supplier do not interfere with each other:

● LicenseLib of the service pack: is registered so that COMOS always finds its own 
LicenseLib.

● LicenseLib of the Remote License Supplier: is found automatically by means of a 
manifest file.

Registering / Manifest
The LicenseLib for the Remote License Supplier is not registered, but is found automatically 
by means of a manifest file.

Storage location of the licenses
If the Remote License Supplier is used with an individual local license, the following procedure 
is the easiest: Copy the "ComosLicense.xml" file to the installation directory of the Remote 
License Supplier. You can find additional information on this topic in the "COMOS xx - Readme" 
manual, keyword "Installing COMOS license products".

7.13.7 "Comos.LicenseLib.config" file

Comments
<Configuration> section: Single-row XML comments (which start with <!--) are permitted. 
All other comments or additions are prohibited. 
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Location
After the installation, this file is located in the installation directory of the Remote License 
Supplier. If the Remote License Supplier accesses a license server, the port can be configured 
there. 

The following method is used to search for the "Comos.LicenseLib.config" file: 

1. Starting from the current directory: Change to the higher-level directory. A search is 
performed there to find the "\config" directory, and this directory is in turn searched for the 
"Comos.LicenseLib.config" file. 

2. After this, the current directory of LicenseLib is searched for the 
"Comos.LicenseLib.config" file.

3. Then the default port 27011 is tested. 

Syntax
<setting key="ComosLicenseServerPort" value="xxx" />

7.14 Using an ICA Client

7.14.1 Prerequisites/System environment

Requirement
● Setup for Framework Net 2.0 available

● Setup for COMOS LS ICA Client available

Releases
COMOS LS ICA Client is released for the following operating systems: 

● Windows XP Pro SP2

COMOS LS ICA Client is released for the following software:

● Citrix Client Neighborhood 9.0 (or earlier)
The CLS ICA Client setup does not include an optional setup for the Citrix client. Citrix 
Client Neighborhood 9.0 must therefore be installed.

● COMOS LS 1.3 (or higher)

The technical functions of the COMOS LS ICA Client and the commercially available Citrix 
clients are largely identical. This requires that the client workstation must have an installation-
compatible working environment. Clients on which no independent software can be installed 
are unsuitable for the COMOS LS ICA Client.

COMOS License Management (COMOS LM)
7.14 Using an ICA Client

152 Installation Manual, 03/2017 V10.2.1, A5E37082844-AB



7.14.2 Installation

Unpacking the ZIP file
CLS ICA Client xx.zip 

1. Place the ZIP file in a dedicated, empty folder and and unpack the file.

2. Start the "Setup.exe" file.

3. Then follow the instructions in the InstallShield Wizard:

– Language selection

– Welcome screen

– License agreement

– Target folder

– License server / License manager server (optional)
This dialog is displayed if a validly configured version of COMOS is not available on the 
PC. If COMOS is installed, the available licenses can continue to be used as usual. 

– Installation startup

7.14.3 LicenseLib

General
"LicenseLib" controls access to the local license files and handles all communication with 
COMOS LS Process. LicenseLib is part of the current service pack and part of the COMOS 
LS ICA Client setup. 

The LicenseLib of the service pack and the LicenseLib of the COMOS LS ICA Client do not 
interfere with each other: 

● LicenseLib of the service pack:
Registered so that COMOS always finds its own LicenseLib.

● LicenseLib of the COMOS LS ICA Client:
is found automatically by means of a manifest file.

Registering / Manifest
The LicenseLib for the COMOS LS ICA Client is not registered, but is found automatically 
by means of a manifest file.

Storage location of the licenses
Proceed as follows if the COMOS LS ICA Client is used with a local license: 

● Copy the "ComosLicense.xml" file to the installation directory of the COMOS LS ICA Client.
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See also
Syntax of "Comos.LicenseLib.config" (Page 91)

7.14.4 "Comos.LicenseLib.config" file

Comments
The <configuration> section must not contain any xml comments.

Location
After the installation, this file is located in the installation directory of the COMOS LS ICA Client. 
If the COMOS LS ICA Client accesses a license server, configure the port there. 

The following method is used to search for the "Comos.LicenseLib.config" file: 

1. From the current directory of the LicenseLib the system changes to the higher-level 
directory. A search is performed there to find the "\config" directory, and this directory is in 
turn searched for the "Comos.LicenseLib.config" file. 

2. The current directory of "LicenseLib" is searched for the "Comos.LicenseLib.config" file. 

3. The default port 27011 is tested. 

Syntax
<setting key="ComosLicenseServerPort" value="xxx" />

7.14.5 Starting the COMOS ICA Client
The COMOS LS ICA Client requires the PC to be already connected to the target network.

If the PC is in the same domain as the Citrix Server, then a connection is automatically 
available. 

If the PC and the Citrix Server are in different domains, first access the external network for 
example via modem access, drive connection, etc. The COMOS LS ICA Client can only be 
started when the external domain is visible in the Explorer in the network environment.

● Then click "Start > Programs > Comos ICA Client".
When the COMOS LS ICA Client starts, the following two windows are displayed:

– "Options" window

– "COMOS ICA Client" window with two subsections
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7.14.6 Closing the COMOS session
Close the ICA Client after the end of the COMOS session. This step ensures that all 
components are released on Windows systems.

7.14.7 Reference to the ICA Client

7.14.7.1 COMOS LS ICA Client main window

Published applications
Applications (programs) that were released on the Citrix Server by the administrator are 
displayed in the "Published Applications" area on the left. Each of the ICA symbols represents 
a preconfigured access to an application.

The applications can also be located on different servers. Where the application is actually 
located and how it is configured is of little importance to you as a user. You only need to know 
which of the displayed icons you need to click on. You get this information from you Citrix 
administrator.

The window may be empty or incomplete during startup. This can have the following reasons:

● The Citrix ICA Client is not configured correctly.

● The Citrix Server administrator has not released any applications.

● There are different Citrix Servers with different versions. For reasons attributable to Citrix, 
only applications that have been published on the latest Citrix Server are displayed initially 
in a network.

User-defined connections
Your own "user-defined connections" can be displayed in the COMOS LS ICA Client. This type 
of connection provides a completely preconfigured option to access the appropriate 
connection. (Technically: The appserv.ini file of Citrix is read.)

Use:

Alternative 1: "Options", "Login" tab: Enter the password for a user-defined connection here. 
Then double-click the corresponding icon.

Alternative 2: Double-click the corresponding icon. A small login window opens in which you 
must enter the appropriate password.

Menu of the "Comos ICA Client" main window
There are three icons above the two areas in the "Comos ICA Client" window.

Close 
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Figure 7-1 Open ICA file

Enables access for workstations that do not have a direct access to the network. This can be 
done by opening a predefined file from the Citrix administrator containing all necessary data 
for access. The file can be sent as usual, via e-mail or by means of a disk. The ICA file is then 
opened here and the connection is established.

Help (Opens this text)

Direct start
You can drag the displayed ICA applications as well as the user-defined connections as a link 
from the COMOS LS ICA Client onto the desktop.

7.14.7.2 Options

"Login" tab
● "User name", "Password" and "Domain" fields

Connection data for the Citrix connection. Input not absolutely necessary: Missing 
information will be requested subsequently when starting the application or establishing 
the user-defined connection.
You will be logged onto both the external domain and COMOS using this information. More 
precisely: Only COMOS is opened initially, but when you open a database, the "User name" 
of the domain login is used as the user name within Comos (in the "User name" field). 
The user name must be identical for both logins (COMOS; Domain). Make sure that the 
user name in COMOS has the required permissions.

● "Server" field / "Direct start" button
Allows you to directly access the Citrix Server itself (not just a separate program on the 
Citrix Server).
Security risk: Do not allow general access via quick launch!
Application: Enter the server name in the "Server" field and click the "Direct start" button. 
The "Server" field can remain blank for all other cases.
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"Graphic" tab
● "Window size" list

– "User-defined" Enter the height and width in pixels

– "Percentage": Enter the percentage value for the screen size.

– "Full screen": Full screen display.

The window size also specifies the maximum size in which COMOS is visible. COMOS 
cannot project past the COMOS LS ICA Client.

● "Window colors" list: Color settings for the Citrix connection.

"General" tab
● "Server selection" field

The "Released applications" subsection may be incomplete at the start. This may be caused 
by the fact that different Citrix Servers with different versions exist in the network. For 
reasons attributable to Citrix, only applications that have been published on the latest Citrix 
Server are displayed initially in a network.
In this case special servers can be added to search for applications. As soon as a server 
is added, all released (published) applications will be displayed.

● "Encoding" field
The entry for this field depends on the type of encryption required by the released 
application. Contact your Citrix administrator for more information.

7.15 Transferring the license server using the COMOS start parameter

Parameter transfer
If you want to specify a license server when starting COMOS, the server is transferred with 
the key /LS.

Examples:

Comos.exe /LS: <xyz>
Comos.exe /LS: <xyz>:<port>
Comos.exe /LS: <xyz>:<backup>
Comos.exe /LS: <xyz>:<port>;<backup>:<port backup>
All license requests are then sent to this server. The procedure is as follows:

1. COMOS is started.

2. A password query is started and sent to the specified license server.

3. When the license server is found and if the password is correct, this password is valid for 
the current COMOS session. The required licenses are requested in the next steps but 
without input of the password. 

4. When COMOS is closed, the password must be entered again with the next start.
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Make sure that you have set up your password in advance. See also section "License Server" 
menu (Page 130), keyword "Create password for user access".

7.16 Registration of the "Comos.LicenseLib.dll" file

Default case as of COMOS 9.0:
The "LicenseLib" of the Service Pack is found automatically and is therefore not registered. 

Exception: The registration is carried out as described below when use is made of third-party 
applications that use the workset and are not located in the COMOS "BIN" directory.

Manual registration
The "Comos.LicenseLib.dll" library has been developed for COMOS LS. This library uses .NET 
technology and cannot be registered using older registration tools. In .NET technology, such 
components have to be registered using the "RegAsm.exe" tool. This file is an integral part of 
the Microsoft .NET Framework 2.0 setup. 

You can therefore search for the "RegAsm.exe" file and register the "Comos.LicenseLib.dll" 
in a DOS box using this file. However, such an approach might be too complex for the user. 

Therefore, the following method was selected: 

● The "RegAsm.exe" file was also copied as "RegAsm_V2.0.50727.exe" into the "<Comos>
\BIN" folder.

● A command file was added to the "<Comos>\BIN" folder: 
"ComosLicenseLib_Register.cmd". This file calls the "RegAsm_V2.0.50727.exe" file in the 
"BIN" directory, thereby registering the "Comos.LicenseLib.dll" file.

● The counterpart to this is the "ComosLicenseLib_Unregister.cmd" file, which is used to 
unregister "Comos.LicenseLib.dll" if necessary.

7.17 COMOS LS error codes
Some of the error codes (LS_ErrorCode) are also written to the log files when log files are 
generated. The log files are controlled in the ComosLS.exe.config. See chapter Reference for 
ComosLS.exe.config (Page 84).

Note for users in Germany: Only error texts displayed in COMOS have been localized and are 
entered in German in the table below. All other error texts are only available in English.

ID Message Constant
100 The requested product will expire soon WARNING_EXPIRATION
110 A license for the product was already released with the trans‐

mitted cookie.
INFO_PRODUCT_ALREADY_CHECKEDOUT_FOR
_COOKIE

111 The user is assigned to the product (user->product->type) INFO_PRODUCT_ASSIGNMENT_FOR_USER
112 The group is assigned to the product (group->product->type) INFO_PRODUCT_ASSIGNMENT_FOR_GROUP
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ID Message Constant
113 The user is neither directly nor indirectly assigned to the prod‐

uct by means of a group - Other assignments of the type IN‐
CLUDE exist for the product (user<->product)

INFO_PRODUCT_ASSIGNMENT

114 The user is assigned to the group (user->group) INFO_GROUP_ASSIGNMENT_FOR_USER
115 Switched to license INFO_PRODUCT_SWITCHED_TO_LICENSE
130 The user is assigned to the package (user->package) INFO_PACKAGE_ASSIGNED_TO_USER
200 Cookie was removed INFO_COOKIE_WAS_REMOVED
300 Found file INFO_FILE_FOUND
301 Found sequence ID INFO_SEQUENCEID_FOUND
302 Named User are not defined INFO_NAMEDUSER_NOT_USED
303 No file found INFO_FILE_NOT_FOUND
304 The following file was deleted INFO_FILE_DELETED
410 The last heartbeat is older than 6 minutes - the licenses map‐

ped to the corresponding cookie will be released soon
INFO_COOKIE_HEARTBEAT_DEAD_SOON

440 Trying to start the Comos License Server... INFO_COMOSLICENSESERVER_STARTING
441 Comos License Server successfully started INFO_COMOSLICENSESERVER_STARTED
442 The Fail Over-System was activated successfully INFO_COMOSLICENSESERVER_FAILOVER_AC

TIVATE
443 The Fail Over-System was started but not activated INFO_COMOSLICENSESERVER_FAILOVER_TE

ST_OK
444 The runtime level of the Fail Over-System is INFO_COMOSLICENSESERVER_FAILOVER_RU

NTIMELEVEL
445 Trying to send the e-mail INFO_COMOSLICENSESERVER_FAILOVER_EM

AIL_SENDING
446 The e-mail was sent successfully INFO_COMOSLICENSESERVER_FAILOVER_EM

AIL_SENT
460 The number of stored users in the actual Named User File 

exceeds the maximum number of available licenses for the 
product

INFO_NAMEDUSER_ALREADY_EXISTS

461  INFO_NAMEDUSER_NOT_EXISTS
470 The setting could not be found in the application's configura‐

tion file
INFO_APPLICATIONSETTING_MISSING

480 Some products have more assignments of type RESERVED 
than licenses available

INFO_LICENSEFILE_COUNT_LESS_RESERVE
D

481 The product has more assignments of type RESERVED than 
licenses available (product: available - reserved)

INFO_LICENSEFILE_COUNT_LESS_RESERVE
D_PRODUCT

502 The dongle area for the sequence ID contains invalid charac‐
ters - The Dongle will be reset to 0

INFO_DONGLE_SEQUENCEID_WRONG_FORMAT

600 IP of the Terminal Server session where Comos was started INFO_IP_COMOSCLIENT
601 IP of the PC where the Terminal Server session was started INFO_IP_SESSION
603 Collecting status for INFO_COLLECTING_STATUS
800  FORCE_SECOND_CHECKOUT_NAMEDUSER
801  INFO_NO_EXTENDED_CHECKOUT
9990 Please update your Comos RemoteLicenseService - The ver‐

sion you are using is out-of-date!
CLM_CITRIX_UNKNOWN_COMMAND

9996  CLM_CITRIX_TRANSFORM_FAILED
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ID Message Constant
9997 9997 - connection failed CLM_CITRIX_CONNECTION_FAILED
9998 9998 - invalid data returned CLM_CITRIX_INVALID_DATA
9999 9999 - crypt strings are different CLM_CITRIX_CRYPT_MISMATCH
   
-100 The product does not exist ERROR_PRODUCT_NOT_FOUND
-101 The requested product has partially expired ERROR_PRODUCT_PARTIAL_EXPIRED
-102 The requested product has completely expired ERROR_PRODUCT_COMPLETE_EXPIRED
-103 No free license exists for the requested product ERROR_PRODUCT_NO_FREE_LICENSE_FOUND
-104 No valid license file found for product ERROR_PRODUCT_NO_VALID_LICENSE_FILE

_FOUND
-110 The user has already checked out the product ERROR_PRODUCT_NAMEDUSER_ALREADY_CHE

CKEDOUT_LICENSE
-111 The maximum number of Named Users has been reached – 

no more users can be stored
ERROR_PRODUCT_NAMEDUSER_MAXIMUM_USE
R_STORED

-112 The maximum number of to be released Named User licen‐
ses has been reached

ERROR_PRODUCT_NAMEDUSER_MAXIMUM_CHE
CKOUTS

-113 The additonal product for another check out of a 'NAM‐
ED_USER' license is not available or all associated licenses 
are checked out.

ERROR_PRODUCT_NAMEDUSER_SPECIAL_LIC
ENSE_NOT_FOUND

-114 The user does not exist as a "Named User" and the "AutoAdd" 
functionality is disabled

ERROR_PRODUCT_NAMEDUSER_AUTOADD_DIS
ABLED

-115 The user does not exist as Named User ERROR_PRODUCT_NAMEDUSER_NOT_ASSIGNE
D

-120 The cookie was not created ERROR_COOKIE_NOT_FOUND
-130 The requested package does not exist ERROR_PACKAGE_NOT_FOUND
-131 The user is assigned to more than one package ERROR_USER_MORE_PACKAGES
-132 The user is not assigned to any package ERROR_USER_NO_PACKAGE
-133 Packages cannot be defined within local license files ERROR_PACKAGE_LOCAL_LICENSE
-200 The requested product was not checked out ERROR_PRODUCT_NOT_CHECKEDOUT
-201 The requested product was not checked out using the passed 

cookie
ERROR_PRODUCT_NOT_MAPPED_TO_COOKIE

-202 The passed cookie was not created ERROR_COOKIE_NOT_FOUND
-203 The product does not exist ERROR_PRODUCT_NOT_FOUND
-300 The path does not exist ERROR_PATH_NOT_EXIST
-301 File not found ERROR_FILE_NOT_FOUND
-310 The Named User file could not be found ERROR_NAMEDUSER_FILE_NOT_FOUND
-311 No user entries exist in the Named User file ERROR_NAMEDUSER_USERS_NOT_FOUND
-312 The sequence in the Named User file does not match the 

stored sequence in the dongle
ERROR_NAMEDUSER_SEQUENCEID_MISMATCH

-320 No license files found in path ERROR_LICENSEFILE_NOT_FOUND
-321 No products were found in the license file ERROR_LICENSEFILE_PRODUCTS_NOT_FOUN

D
-322 Wrong format for version ERROR_LICENSEFILE_VERSION_WRONG_FOR

MAT
-323 Duplicate sequence ID found ERROR_LICENSEFILE_SEQUENCEID_DUPLIC

ATE_FOUND
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ID Message Constant
-324 Invalid products found for package ERROR_LICENSEFILE_PACKAGES_INVALID_

PRODUCTS
-325 Module has dependencies, but is not declared as a product ERROR_LICENSEFILE_DEPENDENCIES_INVA

LID_PRODUCT
-326 Mismatches found concerning the dependencies of products ERROR_LICENSEFILE_DEPENDENCIES_MISM

ATCH
-327 Invalid hardware type found ERROR_LICENSEFILE_HARDWARETYPE_MISM

ATCH
-328 Different license types were found in the license files for the 

product
ERROR_LICENSEFILE_LICENSETYPE_DIFFE
RENT

-329 Not allowed to use packages with licenses of type 
NAMED_USER

ERROR_LICENSEFILE_PACKAGE_WITH_NAME
DUSER

-330 License files found with the following version ERROR_LICENSEFILE_VERSION
-331 The COMOS LS can load license files up to version ERROR_LICENSEFILE_CLS_TO_OLD
-332 The PC has to member of a network domain ERROR_LICENSEFILE_NO_DOMAIN
-333 Invalid file type found ERROR_LICENSEFILE_INVALID_FILETYPE
-340 The file checkpoint.dat was not found ERROR_CHECKPOINT_FILE_NOT_FOUND
-341 It's not allowed to use local license files at a Terminal Server ERROR_LOCALLICENSE_TERMINALSERVER
-350 The subnets file does not contain any valid subnets ERROR_SUBNETS_FILE_EMPTY
-360 No package found ERROR_PACKAGE_NOT_FOUND
-361 The assignments for the packages could not be saved ERROR_PACKAGE_SAVE_ASSIGNMENTS
-362 The assignments for the packages could not be read ERROR_PACKAGE_READ_ASSIGNMENTS
-370 The registry path could not be found ERROR_REGISTRY_PATH_NOT_EXIST
-371 The registry key could not be found ERROR_REGISTRY_KEY_NOT_EXIST
-400 The product does not exist ERROR_PRODUCT_NOT_FOUND
-401 Invalid type for product found ERROR_PRODUCT_INVALID_TYPE
-402 The requested package does not exist ERROR_PACKAGE_NOT_FOUND
-403 The following products don't exist in the license files but have 

assignments
ERROR_PRODUCTS_ASSIGNED_BUT_NOT_FOU
ND

-404 No checkouts found for product ERROR_NO_CHECKOUT_FOR_PRODUCT_FOUND
-405 Checkout info without count for product->user ERROR_CHECKOUTINFO_WITHOUT_COUNT
-406 Checkout info without user name found ERROR_CHECKOUTINFO_WITHOUT_USERNAME
-407 Checkout info without cookie found ERROR_CHECKOUTINFO_WITHOUT_COOKIE
-408 Checkout info as null found ERROR_CHECKOUTINFO_AS_NULL
-410 The passed cookie was not created ERROR_COOKIE_NOT_FOUND
-411 The IP address of the request does not match the IP address 

stored on the cookie
ERROR_COOKIES_MISMATCH

-420 The passed version is too old ERROR_VERSION_TO_OLD
-421 The passed key is invalid ERROR_KEY_UNDEFINED
-422 Wrong license token set for the license requested ERROR_LICENSETOKEN_MISMATCH
-430 Product was set as dependent on itself ERROR_DEPENDENCY_ITSELF
-431 Invalid dependent type found ERROR_DEPENDENCY_INVALID_TYPE
-432 A dependency for the module is already stored ERROR_DEPENDENCY_ALREADY_STORED
-433 The required dependency does not exist as a product ERROR_DEPENDENCY_REQUIRED_NO_PRODUC

T
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ID Message Constant
-435 Invalid value for Runtime of 'Fail Over'-System found ERROR_COMOSLICENSESERVER_FAILOVER_I

NVALID_RUNTIME
-436 Update Runtime of 'Fail Over'-System failed ERROR_COMOSLICENSESERVER_FAILOVER_U

PDATE_RUNTIME_FAILED
-437 The 'Fail Over'-System is not deactivated ERROR_COMOSLICENSESERVER_FAILOVER_N

OT_DEACTIVATED
-438 The reset of the 'Fail Over'-System was not initialized ERROR_COMOSLICENSESERVER_FAILOVER_N

OT_INIT
-440 The last Checkpoint is newer than the actual Date&Time ERROR_COMOSLICENSESERVER_CHECKPOINT
-441 The COMOS License Server was stopped due to an incon‐

sistency
The error message is also supplied when the license server 
could not be started. 
Interaction with failover system: Error message is also sup‐
plied when the status of "Test" is changed to "Standby" and 
the license server is inactive.

ERROR_COMOSLICENSESERVER_SHUTDOWN

-442 The Fail Over-System is deactivated ERROR_COMOSLICENSESERVER_FAILOVER_D
EACTIVATED

-443 The maximum runtime of the Fail Over-System is reached ERROR_COMOSLICENSESERVER_FAILOVER_E
LAPSED

-444 The time saved at the dongle is greater than the actual time 
spent

ERROR_COMOSLICENSESERVER_FAILOVER_I
LLEGAL

-445 The Fail Over-System could not be activated ERROR_COMOSLICENSESERVER_FAILOVER_A
CTIVATE

-446 The Comos LS master system is running ERROR_COMOSLICENSESERVER_FAILOVER_M
ASTER_RUNNING

-447 The runtime level of the Fail Over-System could not be 
changed

ERROR_COMOSLICENSESERVER_FAILOVER_S
TANDBY

-448 Mismatch between the dongle IDs of Fail Over-System and 
the master system

ERROR_COMOSLICENSESERVER_FAILOVER_M
ISMATCH_DONGLE

-449 The e-mail could not be sent ERROR_COMOSLICENSESERVER_FAILOVER_E
MAIL

-450 The transmitted handshake deviates from the returned hand‐
shake

ERROR_HANDSHAKE_MISMATCH

-451 The login to the license server was canceled ERROR_LOGINCLS_CANCELED
-452 List of cookies cannot be accessed ERROR_ACCESS_TO_COOKIES_FAILED
-453 No user name was passed ERROR_NO_USERNAME_PASSED
-460 The number of stored users in the actual Named User File 

exceeds the maximum number of available licenses for the 
product

ERROR_NAMEDUSER_NOT_ENOUGH_LICENSES

-461 The change to a previous Named User file was not initialized ERROR_NAMEDUSER_FILECHANGE_NOT_INIT
-462 The change to a Named User file with a higher sequence ID 

than the actual ID is not allowed
ERROR_NAMEDUSER_SEQUENCEID_TO_HIGH

-463 Please check the answer code because the sequence ID 
could not be extracted

ERROR_NAMEDUSER_SEQUENCEID_WRONG_FO
RMAT

-464 The sequence within the ticket file differs from the actual se‐
quence

ERROR_NAMEDUSER_WRONG_SEQUENCEID
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ID Message Constant
-467 NAMED_USER assignments exist but license type is not 

NAMED_USER
WARNING_NAMEDUSER_ASSIGNMENTS_EXIST
_BUT_LICENSE_TYPE_IS_NOT_NAMEDUSER

-468 NAMED_USER assignments exist but product does not exist 
in license file

WARNING_NAMEDUSER_ASSIGNMENTS_EXIST
_BUT_LICENSE_IS_MISSING

-470 The setting could not be found in the application's configura‐
tion file

ERROR_APPLICATIONSETTING_MISSING

-480 actual number of check outs > maximum number in the re‐
loaded license files

ERROR_LICENSEFILE_RELOAD_MISMATCH_U
SAGECOUNT

-481 has check outs but is missing as product in the reloaded li‐
cense files

ERROR_LICENSEFILE_RELOAD_MISSING_PR
ODUCT

-482 has check outs as Named User, but is not Named User in the 
reloaded license files

ERROR_LICENSEFILE_RELOAD_MISMATCH_N
AMEDUSER

-483 actual number of Named Users > maximum license count in 
the reloaded license files

ERROR_LICENSEFILE_RELOAD_MISMATCH_N
AMEDUSERCOUNT

-490 A wrong password was entered ERROR_PASSWORD_MISMATCH
-491 No password has yet been defined ERROR_PASSWORD_FILENOTFOUND
-492 The signature of the password file is invalid ERROR_PASSWORD_FILECHANGED
-500 Login to dongle failed ERROR_DONGLE_LOGIN
-501 Reading dongle buffer failed ERROR_DONGLE_BUFFER_READ
-502 Stored sequence ID has the wrong format ERROR_DONGLE_SEQUENCEID_WRONG_FORMA

T
-503 Saving to dongle buffer failed ERROR_DONGLE_BUFFER_SAVE
-504 Mismatch serial number ERROR_DONGLE_SERIALNO_MISMATCH
-505 Mismatch sequence ID ERROR_DONGLE_SEQUENCEID_MISMATCH
-506 Mismatch random number ERROR_DONGLE_RANDOM_MISMATCH
-507 Illegal dongle found ERROR_DONGLE_MISMATCH
-508 Dongle check failed after maximum retries ERROR_DONGLE_MAX_TRIES
-550 Could not retrieve volume serial number from drive c ERROR_HARDDISK_NO_DRIVE_C_FOUND
-551 Mismatch volume serial number ERROR_HARDDISK_MISMATCH
-560 Mismatch identification data ERROR_NETSID_IDENTDATA_MISMATCH
-561 The domain in the file does not match the domain the local 

PC is part of
ERROR_NETSID_IDENTDATA_DOMAIN

-562 The server name in the file does not match the name of the 
local PC

ERROR_NETSID_IDENTDATA_SERVER

-563 The serial number in the file does not match serial number of 
the local Windows installation

ERROR_NETSID_IDENTDATA_SERIALNO

-564 Invalid identification type ERROR_IDENTDATA_TYPE
-600 No unique cookie could be created ERROR_COOKIE
-700 No valid signature was found ERROR_SIGNATURE_NODE
-701 The signature is invalid – the file was changed ERROR_SIGNATURE_MASMATCH
-750 The internal format of the identification file is invalid ERROR_IDENTDATA_NODE
-751 A value for the identification file could not be retrieved ERROR_IDENTDATA_VALUE
-752 Restricted to unknown hardware ERROR_HARDWARE
-800 Invalid handling found in the license file INVALID_FOUND
-801 The special license handling is not defined in the license file NOT_FOUND_IN_LICENSEFILE
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ID Message Constant
-802 The passed conditions do not match those required for the 

extended activation
EXTENDED_CHECKOUT_MISMATCH_CONDITIO
NS

-1001  SERVER_ISCHECKEDOUT
-1002  SERVER_CHECKOUT
-1003  SERVER_CHECKIN
-1004  SERVER_HEARTBEAT
-1005  SERVER_CREATECOOKIE
-1006  SERVER_NAMEDUSER_READ
-1007  SERVER_NAMEDUSER_WRITE
-1009  SERVER_GETPRODUCTSTATUS
-1010  SERVER_GETCHECKOUTSTATUS
-1011  SERVER_GETSERVERINFOS
-1012  SERVER_GETSERVERDONGLEID
-1013  SERVER_RELOADLICENSEFILE
-1014  SERVER_READCHECKPOINT
-1015  SERVER_PREPARERESULTXML
-1016  SERVER_GETNAMEDUSERSTATUS
-1017  SERVER_ADDTICKET
-1018  SERVER_DELETEOVERWRITABLE
-1019  SERVER_AUTOADD
-1020  SERVER_CHANGENAMEDUSERFILE
-1021  SERVER_CHANGENAMEDUSERFILEINIT
-1022  SERVER_ADDNAMEDUSER
-1023  SERVER_REMOVENAMEDUSERS
-1024  SERVER_ISAVAILABLE
-1025  SERVER_RUNTIMECHECK
-1026  SERVER_SAVELICENSEGROUPS
-1027  SERVER_GETUSERSTATUS
-1028  SERVER_SAVELICENSEUSERS
-1029  SERVER_SAVEPRODUCTASSIGNMENTS
-1030  SERVER_CREATEWORKLOAD
-1031  SERVER_CREATESNAPSHOT
-1032  SERVER_SAVENAMEDUSERS
-1033  SERVER_PASSWORDFORAPPLICATIONS
-1034  SERVER_FAILOVER_STANDBY
-1035  SERVER_FAILOVER_SAVESETTINGS
-1036  SERVER_SAVEPACKAGEASSIGNMENTS
-1037  SERVER_CHECKOUTPACKAGE
-1038  SERVER_GETVALUEFORKEY
-1039  SERVER_FAILOVER_TESTMODE
-1040  SERVER_FAILOVER_RESETINIT
-1041 <exception message> (ComosLicense: Web Session han‐

dling)
SERVER_SESSION_CHECKOUT
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ID Message Constant
-1042 <exception message> (ComosLicense: Web Session han‐

dling)
SERVER_SESSION_CHECKIN

-1043 <exception message> (ComosLicense: Web Session han‐
dling)

SERVER_SESSION_ISACTIVE

-1044 <exception message> (ComosLicense: Web Session han‐
dling)

SERVER_SESSION_GETINFOS

-1045 <exception message> (ComosLicense: Web Session han‐
dling)

SERVER_SESSION_HEARTBEATS

-1046 <exception message> (ComosLicenseServer) SERVER_CREATE_IDENTDATA
-1047  SERVER_FAILOVER_RESET
-1100  LIB_INIT
-1101  LIB_CREATECOOKIE
-1102  LIB_CHECKOUTMODULE
-1103  LIB_CHECKOUTPACKAGE
-1104  LIB_CHECKIN
-1105  LIB_ISCHECKEDOUT
-1106  LIB_USELOCALDONGLE
-1107  LIB_CHECKLOCALDONGLE
-1108  LIB_GETLICENSESERVER
-1109  LIB_ISIPINTERNAL
-1110  LIB_CHECKUSERPASSWORD
-1200  DONGLE_MONITOR_CHECK
-1201  DONGLE_NEXTSEQUENCEID
-1202  DONGLE_CHECK
-1203  DONGLE_INIT
-1204  DONGLE_RESET
-1205  DONGLE_READ
-1206  DONGLE_CHANGESEQUENCEID
-1207  DONGLE_WRITEVALUE
-1250 <exception message> (ComosLicenseServer) IDENTFILE_LOAD
-1251 <exception message> (ComosLicenseServer) IDENTFILE_INIT
-1252 <exception message> (ComosLicenseServer) IDENTFILE_ADDDATA
-1253 <exception message> (ComosLicenseServer) IDENTFILE_CREATE
-1254 <exception message> (ComosLicenseServer) IDENTFILE_SAVE
-1260 <exception message> (ComosLicense: Named User han‐

dling)
NAMEDUSER_ID_REGISTRY_READ

-1261 <exception message> (ComosLicense: Named User han‐
dling)

NAMEDUSER_ID_REGISTRY_WRITE

-1262 <exception message> (ComosLicense: Named User han‐
dling)

NAMEDUSER_IS_VALID

-1263 <exception message> (ComosLicense: Named User han‐
dling)

NAMEDUSER_ADDUSER

-1270 <exception message> (ComosLicenseServer) DONGLEFREE_INIT
-1271 <exception message> (ComosLicenseServer) DONGLEFREE_VALIDATE
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ID Message Constant
-1272 <exception message> (ComosLicenseServer) DONGLEFREE_NAMEDUSER_NEXT_ID
-1273 <exception message> (ComosLicenseServer) DONGLEFREE_NAMEDUSER_CHANGE
-1274 <exception message> (ComosLicenseServer) DONGLEFREE_EXTRACT
-1275 <exception message> (ComosLicenseServer) DONGLEFREE_CHECK
-1276 <exception message> (ComosLicenseServer) DONGLEFREE_NAMEDUSER_READID
-1280 <exception message> (ComosLicense: Restriction handling) RESTRICTION_INIT
-1281 <exception message> (ComosLicense: Restriction handling) RESTRICTION_HAS_VALIDATION
-1282 <exception message> (ComosLicense: Restriction handling) RESTRICTION_NAMEDUSER_NEXT_ID
-1283 <exception message> (ComosLicense: Restriction handling) RESTRICTION_NAMEDUSER_CHANGE
-1284 <exception message> (ComosLicense: Restriction handling) RESTRICTION_CHECK
-1285 <exception message> (ComosLicense: Restriction handling) RESTRICTION_NAMEDUSER_READID
-1300 The COMOS License Server does not reply or returned an 

unexpected error
LICSERVER_NOT_AVAILABLE

-1400 <exception message> (hearbeat at the comos.dll) CLM_HEARTBEAT_EXCEPTION
-2000 The internal license job could not be started CLM_ERROR_STARTUP
-2001 The return code contains invalid characters CLM_ERROR_CONVERSION_FAILURE
-2002 The user login could not be retrieved CLM_ERROR_EMPTY_USERNAME
-2003 Named User Licenses will not be supported in connection 

with 'runas'. Please start COMOS without 'runas'
CLM_ERROR_STARTED_WITH_RUNAS

-2004 The query returned a BAD SYSTEM DATE, because the lat‐
est login in the database is newer than the expiration date of 
the license

CLM_ERROR_BADSYSDATE

-2005 Please ensure that 'Microsoft .NET Framework 2.0' is instal‐
led on the user PC!

CLM_ERROR_NO_DOTNET_FEATURES

-2006 The COMOS client license component could not be regis‐
tered!

CLM_ERROR_REGISTER_LICENSELIB

-2007 Heartbeat - error initializing XML CLM_ERROR_XML_INIT
-2008 Heartbeat : error starting the thread CLM_ERROR_HEARTBEAT_START
-3102 The license could not be obtained. Use a local license file. 

Please check the local settings
Do you want to connect to a license server. Please check the 
following entries in the Registry
HKEY_CURRENT_USER\\SOFTWARE\\INNOTEC\\Comos\
\LastUsedLicenseServer
HKEY_CURRENT_USER\\SOFTWARE\\INNOTEC\\Comos\
\ForceLicenseServer

LM_BADHANDSHAKE_CHECKOUT

-3103 The client was forced to connect to FLEXlm, but the request 
failed.
Please check the following values in the registry
HKEY_CURRENT_USER\\SOFTWARE\\INNOTEC\\Comos\
\ForceLicenseServer

LM_BADHANDSHAKE_FORCE_FLEXLM

-3104 The client was connected by default to the COMOS license 
server, but the request failed.
Please check the following values in the registry
HKEY_CURRENT_USER\\SOFTWARE\\INNOTEC\\Comos\
\ForceLicenseServer

LM_BADHANDSHAKE_FORCE_CLM

COMOS License Management (COMOS LM)
7.17 COMOS LS error codes

166 Installation Manual, 03/2017 V10.2.1, A5E37082844-AB



ID Message Constant
-3105 The client tried to connect to FLEXlm and COMOS LS, but 

both requests failed. Use a local license file. Please check 
the local settings
Do you want to connect to a license server. Please check the 
following entries in the Registry
HKEY_CURRENT_USER\\SOFTWARE\\INNOTEC\\Comos\
\LastUsedLicenseServer
HKEY_CURRENT_USER\\SOFTWARE\\INNOTEC\\Comos\
\ForceLicenseServer

LM_BADHANDSHAKE_BOTH_TESTED

-3201 An incorrect version of the license server was found. Please 
check the following entries in the Registry
HKEY_CURRENT_USER\\SOFTWARE\\INNOTEC\\Comos\
\LastUsedLicenseServer
HKEY_CURRENT_USER\\SOFTWARE\\INNOTEC\\Comos\
\ForceLicenseServer

LM_ERROR_WRONG_VERSION

-3302 An unexpected error has occurred. Please try again or check 
the 'Debug Monitor' outputs for more details

LM_EXCEPTION

-5000 Please make sure that you use a license server or a local 
license!

CLM_ERROR_UNKNOWN

7.18 Remote administration
You have the option to access COMOS by means of a remote access.

This requires an access with TerminalClient software to a Windows 2000 or Windows 2003 
server in administration mode. Contact the support team to find out which licenses are required 
and how to technically implement this option.

7.19 Dongle-free license with COMOS LS Host-ID

Requirements
● Microsoft .NET Framework 2.0. or newer

● CLS Server 1.7.0 or newer

● PC client is a member of the network domain

● You are familiar with the COMOS LM overview.
See chapter Overview of COMOS LM (Page 73).

Aim
COMOS LS Host-ID retrieves the various client values. These values are referred to here as 
"Identifying values". The Host-ID is the sum of the Identifying values. Siemens Support can 
use the Host-ID to generate a license file that does not require a dongle. 
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Installation
The file Comos.LicenseHostIdAtCustomer.exe is copied to the PC where COMOS LS 
is installed.

The exe file cannot be started directly. 

Retrieving "Identifying values"
● Log on to the client operating system as administrator.

● Copy the file Comos.LicenseHostIdAtCustomer.exe to the PC where COMOS LS is 
to be installed.

● Start the application.
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● Click "Retrieve values".
The following fields are filled out automatically.

– "Name of the PC"
Name of the PC, on which "COMOS LS Host ID" is executed.

– "Name of the Domain"
Domain name for this PC.

– "Windows Product-ID"
The product ID generated when Windows is activated.

● Click "Retrieve values".

● A dialog opens in which a file for the saved values is specified.

● After you click "Save", the file name in the field "Saved to file" is shown and the values in 
this file are saved in the following form:

– PC name: <PC name>

– Domain name: <Domain name>

– Windows Product ID: <Product ID>

● Optional: Click "Copy values to clipboard".

● Insert the values in an email.

● Send these values to your SIEMENS sales representative.

NOTICE

"Identifying values" includes internal information

Use a secure transmission method. Examples: Password-protected archive file, fax, 
encrypted e-mail.

Relationship between COMOS LS Host-ID and Named User management
The assignment between Named User licenses and users is saved as follows:

● Without the use of COMOS LS Host-ID
Saving in the dongle

● With the use of COMOS LS Host-ID
Saving in the registry

When switching to COMOS LS Host-ID, the previous assignment list is no longer evaluated in 
the dongle. You have the following options for creating a new assignment list for COMOS LS 
Host-ID:

● Creating all assignments again with the User Manager

● Importing the previous assignment list with the User Manager
See chapter "Named User" menu (Page 144).
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Commissioning the license server
● You receive a special license file from Siemens that can only be used on this PC. If relevant 

characteristics are changed (e.g. the association of the PC to the domain), the license file 
is unusable.

● Administer COMOS LS as usual.
See section Administering local licenses (Page 80) and sectionAdministering central 
licenses (Page 81).
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Installing COMOS and additional software 8
8.1 Alternative installation in case of restrictive security settings

No direct start of installation
You can find the operating systems released for COMOS in chapter Compatibility matrix 
(Page 15).

Due to restrictive security settings of the user account control (UAC) for administrator 
applications on current Windows operating systems, use of the HTML interface of the COMOS 
Setup browser is not appropriate. In this case, the installation cannot be started via the 
Installation link of the Setup browser. Instead, start the installation via Windows Explorer.

Start the installation from the Windows Explorer
1. Open a file explorer.

2. Depending on the required product, open the file explorer to the following directory: 

Product Directory
COMOS "...\Setup-Browser\SetupCallers\<Language>\Inst-Comos"
COMOS PDMS Integration "...\Setup-Browser\SetupCallers\<Language>\Inst-Pdm"
COMOS Plant Modeler "...\Setup-Browser\SetupCallers\<Language>\Inst-Plm"
COMOS Enterprise Server "...\Setup-Browser\SetupCallers\<Language>\Inst-EntprSvr"
COMOS Walkinside "...\Setup-Browser\SetupCallers\<Language>\Inst-Walkinside"
License management "...\Setup-Browser\SetupCallers\<Language>\Lic-Management"
License Server Monitor "...\Setup-Browser\SetupCallers\<Language>\Lic-ServerMonitor"
Remote License Service "...\Setup-Browser\SetupCallers\<Language>\Lic-Remote"
User Manager "...\Setup-Browser\SetupCallers\<Language>\Lic-UserManager"
COMOS TIFF Printer "...\Setup-Browser\SetupCallers\<Language>\AddOn-TiffPrinter"
COMOS TIFF Server "...\Setup-Browser\SetupCallers\<Language>\AddOn-TiffServer"
Teamcenter FCC "...\Setup-Browser\SetupCallers\<Language>\AddOn-Tc"
SIMATIC XML Transfer "...\Setup-Browser\SetupCallers\<Language>\AddOn-SimXmlTfer"

3. Select the command "Start as administrator" from the context menu of the "setup.exe" file.
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8.2 Terminal Server: CLS Remote License Supplier
If you work with the Terminal Server, use one of the following tools on the client side:

● COMOS ICA Client 
The COMOS ICA Client is used only in connection with the Citrix Server.
See also chapter Third party licenses of a Citrix environment  (Page 172).

● CLS Remote License Service
See chapter Using the COMOS Remote License Supplier (Page 147).

8.3 Installing COMOS on Citrix

8.3.1 Third party licenses of a Citrix environment 
The licenses for the Citrix server and Microsoft Terminal server are generally not covered and 
must be purchased by you.

8.3.2 COMOS licenses for a Citrix environment
The following scenarios may apply in connection with the required COMOS license in a Citrix 
environment:
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Internal domain
● Requirement:

– Citrix server and client are in the same domain.

– Domain membership of the client can be determined by COMOS when it is started on 
the Citrix server.

– The COMOS license server is configured on the Citrix server.

● For various reasons, Comos may fail to detect the domain of the Citrix client.
The domain membership of the client is not recognized:

– Firewall of the Citrix client blocks "File and Printer Sharing"

– Access via a Citrix Web interface: A setting called "Web interface generates client name" 
or "Dynamic device name" is enabled. You can disable this setting as of Citrix 
Presentation Server 4.5.
1. Open the "Citrix Access Management Console" window.
2. Open the "Manage session settings" window.
3. Click in the "Remote compound" group on the "Clientname" entry.
4. Disable the "Web interface overwrites ICA client name"
 option.

– User profile: The "Refuse" right was assigned for calling components via the network.
The "Refuse" right is a setting in the rights management of Windows Active Directory.
Active Directory is a rights management utility for computer networks with Windows 
servers and PCs.
Despite membership of the client in the server domain, COMOS additionally demands 
an external access license in this case. Contact the support team. 

Access to a Citrix Server is conducted from outside
● Using an external Citrix client

For external employees, such as service providers, you need an additional external access 
license in order to open the COMOS database, regardless of the module used.

● Access via own COMOS Citrix client ("Comos ICA client").
The COMOS ICA client either has its own local license or its own license manager has 
previously been configured. The latter requires that a COMOS ICA client also has access 
to the license manager server and is, therefore, located in the same network.

You can obtain more information in the price and product catalog.

8.3.3 Installation overview for Citrix
1. Installing the Citrix server

To learn about the installation of Citrix Presentation Server or "XenApp Plugin for Hosted 
Apps" (new product name ), refer to the Citrix documentation. Released version: See 
chapter Compatibility matrix (Page 15).

2. Installation of COMOS on the Citrix Server
See also section Start the installation on Citrix (Page 174).
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3. Making COMOS available on a Citrix Server
See also section Citrix Delivery Services Console (Page 174).

4. Installing Citrix clients
See also section Configuring a Citrix ICA Client (Page 175).

8.3.4 Printers in Citrix environments 

TIFF
A TIFF printer driver is supplied with COMOS. There is a separate version of the TIFF printer 
driver that you must use on Citrix servers.

See also section Installing "COMOS TIFF server" (Page 198).

Local printers
You can configure the ICA clients in such a way that the local printers are addressed instead 
of the Citrix server printers. See also section Server settings (Page 176).

The complete installation of a Citrix environment is described in the Citrix documentation.

8.3.5 Installing COMOS on the Citrix server

8.3.5.1 Start the installation on Citrix
Standard Installation: See chapter Installing COMOS with the Setup browser (Page 181).

Alternatively: See chapter Alternative installation in case of restrictive security settings 
(Page 171).

8.3.5.2 Citrix Delivery Services Console
Proceed as follows to prepare COMOS by means of Citrix XenApp 6 or 6.5:

1. Select the following node in the Citrix Delivery Services Console: "Citrix Resources > 
XenApp > QSCitrix > Publish applications"
The "Publish applications" window opens with the category of "Welcome". 

2. Click "Next".

3. Assign an appropriate display name and application description in the category "Name".

4. Click "Next".

5. Select the following settings in the category "Type":

– Activate the option "Application".

– Group "Application type": Activate the option "Access from a server". Select "Installed 
application" in the list "Server Application Type".
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6. Click "Next".

7. Enter the COMOS installation path in the category "Storage location".

8. Click "Next".

9. Specify in the category "Server" which servers host COMOS.

10.Click "Next".

11.Specify in the category "User" which users can see and start COMOS.

12.Click "Next".

13.Optional: Specify a client application folder in the category "Link representation".

14.Click "Next".

15.Click the "Finish" button in the category "Publish immediately" to complete the configuration.

COMOS is now available in the web interface.

See also
ICA connection to COMOS (Page 176)

8.3.5.3 Novell Networks 
There is no release for mixed networks, e.g. if an MS server is working in a Novell network.

The workgroups of Novell networks are not supported.

8.3.6 Configuring a Citrix ICA Client

8.3.6.1 COMOS ICA Client
The CLS ICA client is technically identical to the commercial Citrix clients. A requirement 
however is, that the client workstation must have an installation-compatible working 
environment. Clients on which no independent programs can be installed are not suitable for 
the CLS ICA client.

See also
Using an ICA Client (Page 152)
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8.3.6.2 Different access modes on Citrix servers
COMOS licensing makes a distinction depending on whether the client and Citrix Server belong 
to the same Windows domain. The access mode differs depending upon whether or not the 
domain is recongized.

● Citrix ICA Client
Determines the domain.

● Citrix web interface
Does not detect the domain.

The installation has a decisive influence on which COMOS license you can use. See also 
section Third party licenses of a Citrix environment  (Page 172).

8.3.6.3 Server settings
You can configure the Citrix ICA client at the server end or client end.

The suggested settings in the following "Edit Connection" window are not mandatory, but they 
have been tested.

"Advanced..." button
Select "reset" in the "On a broken or timed-out connection" list either here with the setting at 
the server end or client end.

"Client Setting..." button
No special requirements from COMOS. Regard the general principles of performance 
monitoring. 

8.3.6.4 ICA connection to COMOS
Add the new ICA connection.

In the next window, assign an appropriate name to the connection. Select the following:

● Network protocol: "TCP / IP"

● Connection to: "Published Application"

Click the "Server Location..." button.

In the next window, add a new server with the IP address "192.168.119.10".

Specify application
In the list where the "Published Application" option is enabled, specify the configured COMOS 
application, e.g. "COMOS 7".

The "Published Application" option was previously entered as an "Application" in the Citrix 
Presentation Server. See also section Citrix Delivery Services Console (Page 174).
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8.3.6.5 Client settings

ICA settings - "General" tab
Set "Client Name" on the server, click the "Pass-Through Authentication" option.

Properties of the ICA client
"Connection" tab

"Standard Options" tab
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"Login information" tab
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8.3.6.6 Windows Server operating systems
If a Windows Server operating system is used as the terminal server, there is a "Remote 
Desktop Users" group in the group management. In this group, enter the user names of the 
people who want to start this session.

Alternatively, enable terminal server permission individually for each user in the user properties.

8.3.7 DBMon Outputs 
Debug view does not have to be started separately as of COMOS 9.0.

When you start COMOS, a log runs automatically. This log file is automatically written to the 
following directory:

"<home root> \Documents and Settings \<User> \Local Settings \Application Data 
\Comos_Industry_Solutions \Listeners \Comos_Log_<Date>.log"

Example:

"c:\Documents and Settings\fro\Local Settings \Application Data \Comos_Industry_Solutions 
\Listeners \Comos_Log_2009_06_24_11_49_26.log"

8.3.8 FAQs

COMOS does not open
The following causes are possible:

● No free license available for COMOS.
Purchase additional licenses.

● The Citrix administration is erroneous.
Check "Released applications" or "User-defined connection".

COMOS opens, but is "empty"
The following cause is possible:

● The "user" for the login to Citrix and the "user" in COMOS were spelled differently, or no 
corresponding "user" has yet been specified in COMOS.
You will be logged onto both the external domain and COMOS using this information. The 
user name has to be exactly the same for both registrations. Please make sure that the 
user name in COMOS is the same as the user name for the domain and that the user in 
COMOS has the required rights.
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COMOS is not fully visible
The following cause is possible:

● The window of the COMOS ICA client is too small.
Check if the right information has been entered in the "Options".
The "size" in the COMOS ICA client options defines the maximum size in which COMOS 
is visible. You cannot change the width and height of the COMOS ICA client window while 
using COMOS. Close the COMOS ICA client before you enter new options.

The operation of COMOS is somehow "distorted"
The following cause is possible:

● Differing settings on the Citrix server for mouse, keyboard, etc.
The settings of the Citrix server apply within the client window, not your own settings. This 
applies especially to the mouse settings, which can be set differently (e.g. for lefties). During 
the installation of the Citrix ICA client, select the "Desired function: Maintain local settings" 
option.

The screen flickers or the display is askew
The following cause is possible:

● With Citrix 4.5: The domain user is not a local administrator

● With Citrix 4.5: The domain user does not have local administrator rights on the terminal/
Citrix server.

This behavior is a standard problem for modern software that works with WPF.

Cause: Permission problems 

WPF writes the "d3d9caps.dat" to "c:\windows\system32" or "%windir%\system32" file.

The "d3d9caps.dat" file contains the information that the Citrix client sent to the server 
concerning the graphic capabilities of the client.

Microsoft has confirmed this as an error and offers a hotfix. These problems are almost always 
fixed with the "KB955692" patch from Microsoft:

After applying the hotfix, the "d3d9caps.dat" file is saved as follows by default:

"%userprofile%\local settings\application data\"

In this directory the signed-in user usually has unrestricted rights and the above behavior no 
longer occurs.

See also
Microsoft - Help and Support (http://support.microsoft.com/)
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8.4 Installing COMOS with the Setup browser

8.4.1 Software requirements
Software requirements for Windows: See also section Compatibility matrix (Page 15).

8.4.2 COMOS Setup browser: Start window

Requirement
Microsoft Internet Explorer 8 or higher

If you are using an older version of the Internet Explorer, start the installation steps manually 
in the directory structure of the CD. These include, for example, unpacking the COMOS 
database or starting "setup.exe" with the "Run as administrator" command from the context 
menu.

Starting the Setup browser
Insert the COMOS CD. The Browser starts automatically. If there is no autostart, start the 
"index.html" file on the CD.

With some systems, a security prompt is displayed the first time the COMOS Setup browser 
opens. For example "To help protect your security...". Click this button to allow the blocked 
content.
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User interface areas
The user interface of the COMOS Setup browser is divided into the following areas:

xxxxxxxxxx   xxx   xxx   xxx

xxxxxxxx

xxxxxx

xxxxxx

xxxxxx

 xxx

 xxx

 xxx

xxxx

xxxxxxxxxxxxxx xxxx xxxxxxxxxxx xxxxx x xxxxxxxx xxxxxx

xxxxx xxxxx xxx xxx

xx xxxxx xxxxxx xxxxxxxxx xxxxxxx

1

2
3

1. Menu bar (horizontal menu bar):
Here, you can change the language or show the contact address.

2. Navigation area (left window pane):
You will receive information about the selected product in the detail area if you click on a 
menu here.

3. Detail area (right window pane):
Here, you can find product information and a navigational link to install the selected product, 
open a manual in PDF format, or open a third-party manufacturer's website.

Selecting the language
Click the button "English" or "German" in the horizontal menu bar to change the interface 
language of the COMOS Setup browser to German or English.

Your selection is valid for the following points:

● Setup language of all components (except: only English for TIFF printer setup).
Note: The selected language is binding for some components and in this case can only be 
changed by a new installation.

● User interface of COMOS: You can customize the language of the user interface after the 
installation.

Alternatively, a message window may pop up. Confirm with the "Yes" button.
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8.4.3 Installing the COMOS portfolio

Requirements
The Setup browser has been started. See also chapter COMOS Setup browser: Start 
window (Page 181).

Procedure
Select a main product under "Content of the CD" in the "Main products" menu. Then, click on 
the corresponding link in the details area:

● "COMOS"
Link in detail area: 

– "Install COMOS (Page 184)"

● "COMOS 3D Integration (add-on installations)"
Link in detail area: 

– "Install PDMS Integration"
See "3D Integration Administration" manual, keyword "Installing".

● "COMOS Enterprise Server"
Link in detail area: 

– "Install COMOS Enterprise Server"
See "Enterprise Server" manual, keyword "Install COMOS Enterprise Server".

● "COMOS Walkinside"
Links in detail area: 

– "Installing COMOS Walkinside Integration"
See "COMOS Walkinside Integration" manual, keyword "Installing "COMOS Walkinside 
Integration"".

– "Installing Walkinside Batch Assignment"
See "COMOS Walkinside Integration" manual, keyword "Installing "Walkinside Batch 
Assignment"".

You must install a dongle driver when using a dongle: See also chapter Installing the dongle 
driver (Page 201).

Important note for Windows 7 and Windows Server
Under the following Microsoft operating systems the installation of the main product is not 
started directly via the installation link in the HTML interface of the CD Browser: 

● Windows 7

● Windows Server 2008, Windows Server 2008 R2 and Windows Server 2012

Proceed instead as described in section Alternative installation in case of restrictive security 
settings (Page 171).
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8.4.4 Installing COMOS

8.4.4.1 Optional: MS Visual C++ 2012
If the "MS Visual C++ 2012" component has not been installed yet:

1. After starting the COMOS installation, the "COMOS 10.2 Release 1" window opens with 
the note "Microsoft Visual C++ 2012 Redistributable Package (x86)".

2. Click "Install".
After installation of Visual C++ 2012, the installation wizard automatically switches to the 
COMOS installation and the welcome window opens. See chapter Welcome screen from 
the InstallShield Wizard (Page 184).

8.4.4.2 Welcome screen from the InstallShield Wizard
In the "InstallShield Wizard" window, click the "Next >" button.

See also
Security information (Page 184)

8.4.4.3 Security information
Read the note on IT security and click "Next".

See also
Conditions of the license instructions (Page 184)

8.4.4.4 Conditions of the license instructions
To proceed with the installation, mark the "I accept the terms of the license agreement" option 
and click the "Next >" button.

Click the "Print" button to print the license agreement.

See also
Target folder for the COMOS installation (Page 184)

8.4.4.5 Target folder for the COMOS installation
The installation wizard recommends a target folder in the "InstallShield Wizard" window.
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Adapting the target folder
1. To use another folder instead, click the "Change" button; otherwise click the "Next >" button.

2. If you want to change the target folder, another window appears.

3. Click the "Create new folder" button to create a new directory. Assign a suitable name to 
the new folder.

4. Click "OK" to confirm.

The selected folder has to be empty; otherwise, a window with the following message is 
displayed: "The selected directory is not empty! Please select an empty directory."

You cannot change the target folder after the installation.

See also
Select the source folder for the service pack (Page 185)

8.4.4.6 Select the source folder for the service pack
In the next window, select the service pack that is executed with the COMOS installation.

● To change the source folder where the service pack is included, click on the "Change ..." 
button. Select the source folder and click the "OK" button, then the "Next >" button.

– The directory with the service pack that is to be installed may not be located in the 
COMOS program directory.

– The ServicePack must be available as a zip file.

● The field can also remain blank. In this case you install a service pack via the Update Center 
later. See also section Specifying the update path manually using the dialog window  
(Page 215). The Update Center is located under "Start > Programs > Comos > <Version 
Number>". 

COMOS cannot run without a service pack installed.

See also
Defining the licensing (Page 185)

8.4.4.7 Defining the licensing
In the next window you select the licensing mode. There are two possibilities.

"License server": Network license
Click the "Next >" button to confirm.

The next window displays the name of the license server / port that may have already been 
set in an older version. As default setting the full name of the COMOS LS Server 
"ComosLizenzServer" appears in the "Name" field and standard port "27011" in the "Port" field.

Both fields are editable. To proceed, click the "Next >" button.
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"License file": Single seat license
This option copies a license file with a single seat license to your hard drive. You need a dongle 
for this, as well as the corresponding dongle driver. You must install this driver if it is not already 
installed. See also section Installing the dongle driver (Page 201).

Click the "Next >" button to confirm.

In the next window select your license file with the "..." button; otherwise you cannot proceed 
with the installation.

Once you have selected the license file, the next window opens informing you that you have 
successfully copied the license file to the specified path. Click "OK" to confirm.

The following installation steps apply for both licensing types.

See also
Starting and completing the installation (Page 186)

8.4.4.8 Starting and completing the installation
Click the "Install" button. This process may take a few minutes. 

Click the "Finish" button in the next window.

8.4.4.9 Covered part modules
The client installation basically covers the following components:

● The COMOS start symbols are added to a program group.

● Help
In the COMOS installation folder, a "Help" subfolder is created which in turn contains more 
folders and files.

● COMOS program files
Only available if you have selected an update in the Select the source folder for the service 
pack (Page 185) section.
Installation directory for COMOS: "<Program directory>\COMOS\<Version number>
\Current".

● COMOS Update Center
The path is: "<Program directory>\COMOS\<Version number>\updatecenter\Comos 
Update Center 4.exe". In the course of the COMOS installation, you specify the path from 
which the COMOS Update Center is to obtain its update source files. You can also enter 
this information later.
For information on using the COMOS Update Center, see also section Installing COMOS 
updates (Page 214).

● Config file (optional) or license file (optional)

● Runtime files
Runtime components are copied to "Windows\System32".

● Microsoft .NET Framework 4/ .NET Framework 4.5
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● Microsoft Visual C++ 2012 Redistributable Package (x86)

● Fonts folder
Installation of the following fonts, if not yet available:
"nina.ttf"= "Nina Standard"
"ninab.ttf"= "Nina Bold"

● If you install the dongle software locally, the files are copied to the "Windows\System32" 
directory.

Which of the components is installed depends on the user inputs and the PC.

All components, except the hardlock driver, are installed in the background. This means that 
after starting the installation the user does not have to make any further entries. The installation 
process is only visible via the status bar. The hardlock driver has its own installation routine, 
which you need to confirm.

8.4.4.10 Customization

Plugins / Manifests
If you create customized settings under the "\bin-path", only use the following folder and files. 
These are not overwritten by updates.

● File: "ComosCustomize.manifest"
Automatically created during the complete version setup.

● Folder: "Custom"
Create this folder manually.
The folder name "Custom" has to be spelled exactly this way!

Basic information concerning manifests
Manifest files are used to describe COM components and ComVisible assemblies so that 
components do not have to be registered. All manifest files can reference other manifest files.

The syntax for COM components differs from that for ComVisible assemblies. The manifests 
for assemblies can be embedded in the assembly or created separately as files.

Manifest files can be manually created with Microsoft tools, for example "RegAsm.exe", 
"MT.exe" or with tools from third-party vendors.

GDI Resources

Registry entries
Windows only has limited resources for the graphical display of interfaces ("GDI resources"). 
If several graphic-demanding applications are started at the same time, Windows may become 
overloaded. If you overload your PC, the monitor will no longer be correctly refreshed. 
However, mouse clicks are still executed.
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In the event of shortages the administrator should check if more GDI resources can be 
provided. The system side limit for GDI resources are set as follows:

● "HKEY_LOCAL_MACHINE > SOFTWARE > Microsoft > Windows NT >"

● "CurrentVersion > Windows"

● "GDIProcessHandleQuota"

● "UserProcessHandleQuota"
"Default value: 12,000"

As of Windows XP SP3: 64,000 possible, approx. 12,000 can be effectively used.

You can find additional information on this topic in the "Class Documentation COMOS_dll" 
manual, keyword "GetResources".

GDI objects per GB of RAM
The GDI resources are directly dependent on the available memory.

If you set a higher value, it will be reset to 10,000.

The value of the two entries GDIProcessHandleQuota and UserProcessHandleQuota 
has to be the same. You need to reboot after making the changes.

Avoid opening too many report or tproperties windows at the same time.

Unloading dynamic icons
Dynamic icons are the icons which have been assigned to the objects via their base objects. 
They are loaded when necessary and use up many GDI resources. Windows controls the 
screen with the GDI resources. COMOS informs you if your GDI resources are almost used 
up. 

If necessary, unload the dynamic icons to release GDI resources with the following command:

● Context menu in the Navigator: "Unload all dynamic icons"
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8.4.5 Uninstalling COMOS
There are two ways to uninstall COMOS:

● By means of the usual uninstall process:

– In the Windows Start menu, select "Start > Control Panel > Add or Remove Programs".

– Select the COMOS version. Click the "Remove" button. A prompt is displayed again 
whether you really want to remove COMOS <Version Number>. Confirm with the "Yes" 
button.

● By means of the Setup browser.

– Select the subdirectory of the corresponding product in the directory "...\Setup browser
\Software", for example:
To uninstall COMOS: "...\Comos Main\Comos"
To uninstall Remote License Service: "...\License Products
\ComosRemoteLicenseService"

– Run the "setup.exe" file. The window with the language selection opens.

– Select the desired language and confirm with the "OK" button.

– Click "Next >". The window for removing the program is displayed. Confirm with the 
"Remove" button.

– You decide whether or not you want to also delete the installation directory.

– To exit the wizard, confirm with the "Finish" button.

8.4.6 Installing the COMOS database
The COMOS database contains all system objects and libraries required for COMOS. The 
database provided here is an Access database. 

Requirements
● Before you unpack the database, check to make sure that the current COMOS version is 

installed. If it is not, you will receive a prompt.

● The Setup browser is open. See also chapter COMOS Setup browser: Start window 
(Page 181).

Procedure for a new database
1. In the Setup browser, select the link "COMOS database > Install COMOS iDB".

2. Click on the link "For installation of the COMOS iDB (please unzip)".
A zip file is displayed.

3. Unpack the zip file.

To use the database productively you must copy the Access database to your MS SQL 
database or Oracle database. Test your databases before using them productively.
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Additional information about installing and managing databases can be found in the 
"Administration" manual, keyword "Integrating and maintaining databases in COMOS".

Database update
If a database already exists, you must use the "Database update" tool. You can find additional 
information on this topic in the "COMOS Administration" manual, keyword "Database update".

Changes on the PC
The ZIP file includes the following folders:

● "Database<Version Number>.mdb"

● "Database<Version Number>" folder
This folder contains:

– Reports (example projects / copy templates)

– Report templates

– Icons

– Other administrative files

The database includes the current system project, a base object as well as an example project. 

English is initially set as the database language. You can change the language. Open the 
database in COMOS and select a different language under project properties in the "Language" 
category. 

8.4.7 Installing COMOS license products

8.4.7.1 Overview of COMOS License Management
COMOS is based on a client-client network, and for this reason all COMOS clients are 
technically equal. Every COMOS client can provide its own license (local license). Citrix 
solutions and similar work environments are excluded in this case. COMOS License 
Management (COMOS LM) is not required in a system of clients with local licenses

COMOS License Management is absolutely required if central licenses are intended to be 
used.

COMOS License Management is a collection of software tools and workflows that are provided 
along with the central licenses for COMOS. They also support mixed systems including local 
licenses.

The programs that are required for licensing, the registration of licenses, user administration, 
and all related tasks can be found in the "License products" menu of the COMOS setup browser.
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Requirements
The Setup browser is open. See also chapter COMOS Setup browser: Start window 
(Page 181).

Packages that can be installed in COMOS LM
The following installation packages are available: 

● COMOS License Server
Integrated application:

– COMOS LSService

– COMOS LSProcess

– COMOS LS Monitor

Individual application:

– COMOS LS Monitor

● COMOS Remote License Supplier

● COMOS License User Manager

● COMOS License Server Host-ID

All packages that can be installed have their own version number.

Important note for Windows 7 and Windows Server
Under the following Microsoft operating systems the installation of these programs is not 
started directly via the installation link in the HTML interface of the Setup browser: 

● Windows 7

● Windows Server 2008, Windows Server 2008 R2 and Windows Server 2012

Proceed instead as described in section Alternative installation in case of restrictive security 
settings (Page 171).

Additional information
You can find additional information on this topic in the "Administration" manual, keyword 
"COMOS License Management".

See also
Installing COMOS LS (Page 192)

Installing the COMOS Remote License Supplier (Page 192)

Installing the COMOS License User Manager (Page 192)

Installing COMOS License Server Host-ID (Page 193)
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8.4.7.2 Installing COMOS LS

Requirements
● You are familiar with COMOS License Management.

See chapter Overview of COMOS License Management (Page 190).

Procedure
1. Select the menu "COMOS License Management > COMOS License Server".

2. Click on the link "Install license server".

3. Click on the link "Install License Server Monitor" to install only the license Server Monitor. 

See also chapter Using COMOS License Server Monitor (Page 116) and chapter Administering 
central licenses (Page 81).

You must install a dongle driver when using a dongle: See also chapter Installing the dongle 
driver (Page 201).

See also
Interrupted communication (Page 229)

8.4.7.3 Installing the COMOS Remote License Supplier

Requirements
● You are familiar with COMOS License Management.

See chapter Overview of COMOS License Management (Page 190).

Procedure
1. Select the menu "COMOS License Management > COMOS Remote License Supplier".

2. Click the "Install COMOS Remote License Supplier" link.

See also chapter Using the COMOS Remote License Supplier (Page 147).

8.4.7.4 Installing the COMOS License User Manager

Requirements
● You are familiar with COMOS License Management.

See chapter Overview of COMOS License Management (Page 190).
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Procedure
1. Select the menu "COMOS License Management > COMOS License User Manager".

2. Click the "Install License User Manager" link. 

See also chapter Using the COMOS License User Manager (Page 133).

8.4.7.5 Installing COMOS License Server Host-ID

Requirements
● You are familiar with COMOS License Management.

See chapter Overview of COMOS License Management (Page 190).

Procedure
1. Select the menu "COMOS License Management > COMOS License Server Host-ID".

2. Click the "Install COMOS License Server Host-ID" link.

See also chapter Dongle-free license with COMOS LS Host-ID (Page 167).

8.4.8 Installing COMOS add-on programs

8.4.8.1 Overview of the COMOS add-on programs
The following add-on programs are located in the "Add-on programs" menu:

● "COMOS DocumentView"

● "COMOS TIFF Printer"

● "COMOS TIFF server"

● "Teamcenter FCC"

● COMOS Revision Printer (HARP)

● "SIMATIC XML Transfer and AI Components"

Requirements
The Setup browser is open. See also chapter COMOS Setup browser: Start window 
(Page 181).
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Important note for Windows 7 and Windows Server
Under the following Microsoft operating systems the installation of these programs is not 
started directly via the installation link in the HTML interface of the Setup browser: 

● Windows 7

● Windows Server 2008, Windows Server 2008 R2 and Windows Server 2012

Proceed instead as described in section Alternative installation in case of restrictive security 
settings (Page 171).

See also
"COMOS DocumentView" (Page 194)

"Teamcenter FCC" (Page 199)

"SIMATIC XML Transfer" (Page 200)

Installing the "COMOS TIFF Printer" (Page 194)

Installing "COMOS TIFF server" (Page 198)

8.4.8.2 "COMOS DocumentView"
COMOS DocumentView allows you to link COMOS to a Sharepoint.

Procedure
1. Select the menu "Add-on programs > COMOS DocumentView".

2. Click on the link.

3. Copy the wsp file. This is a solution package.

4. The installation of solution packages is described in your Sharepoint documentation.

8.4.8.3 Installing the "COMOS TIFF Printer"

TIFF-printer limitation
You cannot use the COMOS TIFF PRINTER with:

● Windows 7 (32-bit and 64-bit) 

● Windows Server 2008 R2 and later

Instead, configure your Revision printer using the file "HARP.ini".
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General information regarding the printer driver

Printer driver for the revision archive (revision printer)
COMOS offers the option to revise documents. A special printer driver is installed on your PC. 
COMOS supports TIFF or PDF as file formats. There are a variety of printer drivers that can 
produce TIFF, and there are printer drivers that can produce PDF. The result will differ slightly 
depending on the printer driver.

COMOS has a fixed list of supported printer drivers, some of which are not included in the 
scope of delivery. You need to purchase these drivers separately. 

COMOS-specific instances of the printer drivers
If a printer driver is not only used by COMOS but also by applications from other vendors, 
conflicts may occur. For example, a different software might require completely different printer 
driver settings.

In such cases, you can configure different printer driver instances:

1. Open "Start > Control Panel > Printers and Faxes"

2. Duplicate the desired printer driver.

3. Configure the copy for the COMOS requirements.

4. Rename the copy as follows and note the spaces:
'Comos' + <PrinterName>

Effect: COMOS and other applications do not have to share one and the same printer driver; 
users can still use their regular printer drivers for other applications.

Currently, you cannot create a second instance for the TIFF printer driver that is included in 
the COMOS scope of delivery.

Licensing
Fully executable version, included in the COMOS product package. However, no support is 
provided.

Driver versions

as of COMOS 9.0: Printer Driver 10.24

Due to technical reasons it is possible that the output of the different versions can vary 
marginally.
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Installation

Procedure
1. Select the menu "Add-on programs > COMOS TIFF Printer". 

2. Click on the link in the detail area.

If required: Uninstalling an existing version
Existing versions are always deleted first when you start the installation routine for the Tiff 
printer driver. You must confirm this with "OK".

During the uninstallation routine there is a callback asking if shared data should also be deleted.

Consult your system administrator to determine the correct option here.

After the deinstallation there is callback stating a "successful installation". At the completion 
of the installation there is a prompt to restart the computer. Follow this prompt, otherwise the 
new TIFF printer might not be installed without errors.

If the installation does not automatically continue after rebooting the computer, click the "Install 
COMOS TIFF Printer" link once again.

Installing the new version
The InstallShield Wizard starts when you click the "Install COMOS TIFF Printer" button.

The interface language is always English.

Click "Finish" to complete the installation.

Settings for the printer driver 
To set up a printer driver for a COMOS revision printer, open the properties of the printer driver:

● "Start > Control Panel > Printers and Faxes > "<Printer driver>" > Printer Settings..."

If you make the settings in COMOS and you have the required rights, the settings from the 
"Properties" of the printer are permanently overwritten without another prompt.

Print settings
"Start > Control Panel > Printers and Faxes > "<Printer driver>" > "Printer Settings..."

"Device Settings" tab
You can control the paper size by means of a script option in COMOS. Otherwise the settings 
that were made here are applied.

The paper alignment is automatically conducted by COMOS.

The remaining settings in this tab can be set freely.

The file size increases with a higher resolution.
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"File Formats" tab
Requirement: One of the TIFF formats is selected.

Different "file format" settings generate different results.

Example: If the setting "TIFF Group 4" is selected, the output has a displacement of 0.4 mm 
in contrast to "TIFF Group 3.1 Dimension".

"Options":

● "Create Multipage Image" option: Must be activated.

● "Disable Image" option: Must be disabled.

"Filename Generation" tab
● "Name Generation Method" list: Must be set to "Use the document name".

● "Filename" field, "Keep existing files" option: Must be disabled.

You need full access for the "Output Directory" field.

● "Output Directory" field: If no directory is specified, the temp directory of the user is 
automatically set as the output directory.
With Citrix: Each user needs a separate "Output Directory".

Remaining tabs
Keep the default settings.

Printer name
Standard name: "Comos Tiff"

No second instance can be created for the TIFF printer driver.

Changes on the PC
The printer folder for the "Comos Tiff" printer is added in the "Control Panel". The corresponding 
printer drivers are copied to the "\WinNT\System32" folder and a folder for the printer sample 
files is created.

TIFF viewer
TIFF is one of the possible archiving formats for COMOS revisions. COMOS has a built-in 
TIFF viewer. It is therefore unnecessary to install an additional TIFF viewer if TIFF is selected 
as the revision format. 

You can find additional information on this topic in the "Operation" manual, keyword 
"Revisioning".
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Behavior during a COMOS uninstallation
When you uninstall COMOS, this printer driver is not removed from your system. To uninstall 
the driver, remove the driver printer by means of the control panel.

8.4.8.4 Installing "COMOS TIFF server"

TIFF-printer limitation
You cannot use the COMOS TIFF PRINTER with:

● Windows 7 (32-bit and 64-bit) 

● Windows Server 2008 R2 and later

Instead, configure your Revision printer using the file "HARP.ini".

Licensing
Fully executable version, included in the COMOS product package. However, no support is 
provided.

Driver versions

Starting from COMOS 8.1.4: Printer Driver 9.02

The version number of the "Tiff" printer driver and that of the "Tiff (Server)" printer driver are 
completely independent. 

Installation
1. Select the menu "Add-on programs > COMOS TIFF Server".

2. Click on the link in the detail area. 

You need a special driver if you want to use a TIFF printer driver on a Citrix server.

Available for:

● Windows XP SP3

If no terminal server is installed on your PC, the installation of the TIFF printer driver is 
canceled. 

If the terminal server is available, installation is performed.

Comparison of the two TIFF printer drivers
These are two different developments with different results.

The printer driver "Tiff (Server)", for example, produces colored files and also has other default 
settings in the properties.
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Switching from one driver to another can, therefore, only take place after conducting thorough 
tests with test files. The generated revision files will definitely differ from each other. 

Control/Configuration
The server variant is basically configured like the local TIFF printer driver. There are the 
differences:

"File Formats" tab
● "File format" list

 "TIFF Lempel-Ziv&Welch"

● "Color depth" list
The color depth is only available for this server variant and can only bet set there since the 
local TIFF printer driver cannot print in color.

8.4.8.5 "Teamcenter FCC"
1. Select the menu "Add-on programs > Teamcenter FCC".

2. Click on the link. 

3. Follow the instructions in the InstallShield Wizard.

The Teamcenter File Client Cache (FCC) gives you access to the data of a Teamcenter server. 

You also need a license for the COMOS interface to the Teamcenter for communication 
between COMOS and Teamcenter.

You can find additional information on this topic in the "Process Data Interface to Teamcenter/
NX" manual.

8.4.8.6 Installing the COMOS revision printer (HARP) 

Aim
The freely configurable revision printer (HARP) technically supports a large number of 
customer-specific revision processes. The revision printer works in two steps:

1. Creating a PostScript file 

2. Conversion of the PostScript file into PDF

The standard configuration that has been tested and maintained by Siemens support can be 
installed in the Setup browser. 

Procedure
To install this standard configuration, follow these steps:

1. Select the menu "Add-on programs > COMOS Revision Printer (HARP)".

2. Click the "Install COMOS Revision Printer (HARP)" link.
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See also chapter Configuring the "Freely configurable revision printer" revision archive 
(Page 204).

8.4.8.7 "SIMATIC XML Transfer"
1. Select the menu "Add-on programs > SIMATIC XML Transfer".

2. Click the "SIMATIC XML transfer and AI Components" link.

Used for exchange with PCS 7. Includes the component "AI COMPONENTS" as well as the 
menu entries for an XML import and export in PCS 7. 

STEP 7 (part of SIMATIC PCS 7) is a mandatory requirement for installation and use.

8.4.9 Installing third-party programs

8.4.9.1 Overview of the COMOS third party programs
The "Third Party Programs" menu contains links to third-party programs that are required for 
working with COMOS:

● " "Adobe Reader"

● "pdfFactory Pro"

● "Dongle driver"

Requirement
The Setup browser is open. See also chapter COMOS Setup browser: Start window 
(Page 181).

See also
Install Adobe Reader (Page 201)

Install pdfFactory Pro (Page 202)

Installing the dongle driver (Page 201)

8.4.9.2 Installing snapshot support

Licensing
Observe the Microsoft license conditions.
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Net Framework 4.5
1. Select the menu "Third-party programs > .NET Framework 4.5".

2. Click on the link.

The Microsoft website opens from which you can download .NET Framework 4.5 and install 
it.

SQL Server® 2012 SP1 Feature Pack
1. Select the menu "Third-party programs > Microsoft® SQL Server® 2012 SP1 Feature 

Pack".

2. Click on the link.

The Microsoft website opens from which you can download SQL Server® 2012 SP1 Feature 
Pack and install it.

Additional information
You can find additional information on this topic in the "Snapshots" manual.

8.4.9.3 Installing the dongle driver
The protective adapter software (HASP4 dongle) is necessary for error-free operation of the 
protective adapter on the USB port. The dongle driver is only required for a single user COMOS 
license. Install dongle drivers and dongles only on the server of the license manager for network 
licenses. 

Outdated dongle drivers could lead to a system crash when used in conjunction with Windows 
7. Check that you are using the right driver for your operating system.

Procedure
You must install a dongle driver when using a dongle:

1. Select the menu "Third Party Programs > Dongle driver".

2. Click on the link.

A website opens from which you can download the driver and install it.

The dongle driver is a prerequisite for using the "Dongle.exe" tool.

8.4.9.4 Install Adobe Reader

Licensing
The Adobe Reader is free of charge.
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Version
Adobe Reader X

Installation
1. Select the menu "Third Party Programs > Adobe Reader".

2. Click on the link.

The Adobe website opens from which you can download Adobe Reader and install it.

Specific points relating to use
PDF is one of the possible archiving formats for COMOS revisions.

A PDF viewer must be installed to open and read revision files in "PDF" file format.

A software program that creates files of the "PDF" type must be installed to create and release 
PDF revision files. This software can be purchased from the respective manufacturer.

See also
General information on Adobe PDF (Page 212)

8.4.9.5 Install pdfFactory Pro

Licensing
You can download a free limited trial version or purchase a full version.

Version
Version 4.x: The necessary functions for COMOS are enabled. Any additional functions of the 
pdfFactory, as well as printing and revising via the COMOS Enterprise Server, are not enabled.

Installation
To create a "PDF" type file a corresponding printer driver must be installed on the PC. This 
software is only required on PCs releasing a revision. A PDF is only written at this time.

1. Select the menu "Third Party Programs > pdfFactory pro".

2. Click on the link.

The pdfFactory website opens from which you can download pdfFactory and install it.

Specific points relating to use
● "pdfFactory" or

● "pdfFactory Pro"
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Full access right: "Printing settings...", "Settings" tab > "Folder locations" list

See also
General information on Adobe PDF (Page 212)

8.4.10 Installing COMOS documentation

8.4.10.1 Overview of the COMOS documentation
Relevant documents for the installation can be found in the "Documentation" menu. The 
documents are available in PDF format. To read them you need a PDF reader that is compatible 
with PDF 1.7 (ISO32000-1:2008 PDF). 

In addition you have access to the entire COMOS documentation in the details area of the 
"Documentation" menu. Click on the link "To customer documentation" for this purpose. 

Electronic manuals and information on COMOS after installation
A help directory is installed on your computer with the COMOS installation: "<COMOS 
installation directory>/Help/". See chapter Administration of the help menu (Page 251) for more 
on this.

After COMOS has been installed, you can open the complete help as follows: 

1. Starting COMOS

2. "Help > COMOS help system" menu bar

If references are made to other manuals in the documentation, these manuals are also 
available via the "COMOS help system". To navigate to these manuals, go to the "Content" 
tab in the COMOS help system and open the table of contents until you can see the individual 
manuals. 

See also
"Readme" (Page 204)

"Release Notes" (Page 203)

"Frequently Asked Questions" (Page 204)

Known Issues (Page 204)

8.4.10.2 "Release Notes"
Click on the "Release Notes" link.

A PDF file opens.
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8.4.10.3 "Readme"
Click the "COMOS Readme" link.

A PDF file opens.

8.4.10.4 Installation instructions
Click on the "Installation instructions" link.

A PDF file opens.

8.4.10.5 Known Issues
The Known Issues are now part of the readme.

8.4.10.6 "Frequently Asked Questions"
Click on the link "COMOS Frequently Asked Questions".

A PDF file opens.

8.5 Installing printer driver for COMOS revision printer

8.5.1 Configuring the "Freely configurable revision printer" revision archive

8.5.1.1 Overview of the freely configurable revision printers

Revision printer
The revision printer works in two steps:

1. Creating a PostScript file

2. Conversion of the PostScript file into PDF

You configure an INI file, in which you define which PostScript printer is used for printing and 
how to convert the generated PostScript file to PDF. This enables you to use the same printer 
for revisioning reports as for printing on paper. In so doing, only the utilized characters of the 
fonts are embedded. Complete embedding occurs only when eStamp is used. See chapter 
The standard configuration for HARP (Page 209) for more on this.
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A standard configuration that has been tested and maintained by Siemens support is available 
for HARP. This standard configuration is installed as follows:

1. Open the Setup browser.

2. Select "Add-on programs > COMOS revision printer (HARP)".

3. Follow the installation instructions.

See also
"Freely configurable revision printer" revision archive (Page 205)

Verification of the INI file (Page 205)

Reference of the key commands in "HARP.ini" (Page 206)

Support for HARP (Page 212)

8.5.1.2 "Freely configurable revision printer" revision archive

Requirements for printing revisions
The revision printer is entered in the properties of the COMOS project. You can find additional 
information on this topic in the "Administration" manual, keyword "Revision options: Specifying 
the revision archive".

Requirements to be met by the workstation of the COMOS client:

● The printer entered in the INI file must support PostScript.

● The printer must support the setting of the name of the print file for output via the GDI 
interface.

● When you create a revision, you need "read and execution" permission for the conversion 
program.

● The freely configurable revision printer was configured by an administrator in the INI file. 
The administrator stored the configuration file in the following directory:
As of COMOS version 9.0: "< COMOS installation path>\config\"

8.5.1.3 Verification of the INI file

Requirement
● You are familiar with the overview of the freely configurable revision printers.

See Chapter Overview of the freely configurable revision printers (Page 204).

Default values and erroneous settings
If an erroneous setting is detected while reading the INI file, the software continues to read the 
INI file. You get a complete overview of the erroneous settings. Defaults values are 
automatically set for some of the erroneous settings.
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Checks:

● Existence of the INI file: If the INI file is missing, you receive a message and the initialization 
is canceled.

● Specification of a printer in the PrinterName key: Only a check as to whether an entry 
exists is made.

● Specification of a name for the output file in the PrinterRedirection key: A default 
value is automatically used if the value is missing. That is why no error message is issued.

● Definition of a conversion call in the ConvertCommand key: Only a check as to whether 
an entry exists is made. 

● Definition of a timeout for the conversion in the 
ConvertCommandExecuteSynchronTimeOut key: A default value is automatically used 
if the value is missing. That is why no error message is issued.

● Specification of a file name for the converted file in the 
ConvertCommandOutputFullFileName key: A default value is automatically used if the 
value is missing. That is why no error message is issued.

● Definition of a value for the revision sleeper in the ConvertCommandRevisionSleeper 
key: A default value is automatically used if the value is missing. That is why no error 
message is issued.

● Definition of a conversion factor from millimeters into the unit used by the converter tool in 
the ConvertCommandPaperSizeConversionFactor key: If the conversion factor is 
not defined, but the placeholders %PaperSizeX% and %PaperSizeY%  are still used, the 
default value 1 is automatically used. In this case it is assumed that the converter tool also 
uses millimeters for calculation.

See also
Reference of the key commands in "HARP.ini" (Page 206)

8.5.1.4 Reference of the key commands in "HARP.ini"

Requirement
● You are familiar with the overview of the freely configurable revision printers.

See Chapter Overview of the freely configurable revision printers (Page 204).

Section "Default"
Various placeholders have been defined for this section, which you can use to configure the 
INI file. Placeholders are always enclosed in % signs. Pay attention to upper and lower case 
characters when inserting placeholders.
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The following table describes the keys and placeholders of the "Default" section:

Key / placeholder Description
Key PrinterName Name of the printer that prints the document upon revision release. When you use 

a network printer you have to use the UNC name: \\<Server>\<release>, e.g. \
\CS01\HP284002
The printer generates a PS file. The print output is redirected to the position that you 
specify in the PrinterRedirection  key.
Enter the name of the printer in the same notation as in the "Printers and Faxes" 
dialog in Windows.
Note: Network printers are an exception.

Key PrinterRedirection Indicates the full path and name of the print output file. The print output of the printer 
that you specified in the PrinterName  key is redirected to this position. The user 
who is prints must have write rights in the specified directory.
The generated file is deleted after a successful revision.
If the specified file name contains space characters, it must be put in inverted com‐
mas ("..."), for example "C:\Documents and Settings\userXYZ\Local 
Settings\Temp\%ComosSystemUID%_%WindowsUser%_%TimeStamp%.PS".
If this information is missing, the local temp directory of the logged-in user is set by 
default: Documents and Settings\[UserName]\ Local Settings\Temp 

Placeholder 
%PostScriptFullFileName%

Automatically designates the output file the printer generates that you specified in 
the PrinterName  key. The file name that you defined in the 
PrinterRedirection  key is used.
The use of this placeholder is only relevant for the ConvertCommand key.

Placeholder %WindowsUser% Designates the user who is currently logged into the workstation. You can use this 
placeholder in the following keys:
● ConvertCommand
● ConvertCommandOutputFullFileName
● PrinterRedirection

Placeholder %TimeStamp% Designates the point in time at which the user requested creation of the revision 
release. The time is shown in the yyyymmddhhnnss format: 
● 4-digit year
● 2-digit month
● 2-digit day
● 2-digit hour
● 2-digit minute
● 2-digit second
You can use this placeholder in the following keys:
● ConvertCommand
● ConvertCommandOutputFullFileName
● PrinterRedirection

Placeholder %ComosSystemUID% Designates the internal identifier of the document that is created for the revision 
release.
You can use this placeholder in the following keys:
● ConvertCommand
● ConvertCommandOutputFullFileName
● PrinterRedirection
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Key / placeholder Description
Placeholder %PaperSizeX% and pla‐
ceholder %PaperSizeY%

Designates the alignment, width and height of the revision file.
The value that is used during the revision process takes the conversion factor from 
millimeters to the format used by the converter tool into account: %PaperSizeX% 
= PaperSizemm * ConvertCommandPaperSizeConversionFactor

Placeholder %LayoutOrientation
%

Describes the alignment of the paper format. Use this placeholder in the 
ConvertCommand key to define the alignment of the paper format in the generated 
PDF. Depending on the alignment of the original document, the value that you de‐
fined in the ConvertCommandLandscape  or ConvertCommandPortrait key 
is entered here during conversion.

Key ConvertCommand Here, you specify the program call that converts the PostScript file into a revision file 
with the "pdf" file extension. In this key you can insert freely defined placeholders 
that you have to specify in section ConvertCommand Parameters. Enclose the 
freely defined placeholders in % signs. Predefined placeholders are also available 
for selection here.

Key 
ConvertCommandExecuteSynchr
onTimeOut

Here, you specify the time in seconds after which the revision component resumes 
execution, even if the called program has not been closed yet. If this entry is missing 
in the INI file, a default value of 30 seconds is used. Only specify full seconds.
Example: 2.5  is an invalid value.

Key 
ConvertCommandOutputFullFil
eName

Here, specify the full name and path of the file that is generated by calling the program 
that you defined in the ConvertCommand key.
This revision component takes this file and transfers it to the document directory of 
the current project as the released revision for the document which has undergone 
revision. If the user has the necessary rights, the file is deleted after successfully 
completing the transfer.
If the entry is missing in the INI file, a predefined directory "COMOS" in the local temp 
directory of the current user is used.

Key 
ConvertCommandRevisionSleep
er

Here, specify the maximum waiting period of the revision component in minutes. If 
no output file is available after this period has expired, the process is rated as erro‐
neous. Only specify full minutes. Example: 2.5  is an invalid value.
If this information is missing in the INI file, the registry is checked to see whether a 
revision sleeper was defined. If the revision sleeper was not specified in the registry 
either, the default value of 2 minutes is used.
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Key / placeholder Description
Key 
ConvertCommandPaperSizeConv
ersionFactor

COMOS calculates internally in millimeters. In this key you specify the conversion 
factor that must be used to convert millimeters into the unit used by the converter 
tool.
If you do not set this key, the paper format is not clearly specified. The output format 
thus depends on the converter tool. Example: GhostScript ignores the paper format 
of the PostScript file and uses the default paper format Letter.
Enter the conversion factor as a decimal fraction, a total of 4 bytes is available (^= 
Long in Visual Basic). You can therefore specify numbers from -2.147.483.648 to 
2.147.483.647.
Example: Internally, GhostScript uses 1/72 inch as unit. A conversion factor of 2.83 
(=72/24.5) is needed to convert millimeters that are used internally in COMOS into 
1/72 inch.

Key ConvertCommandLandscape 
and key 
ConvertCommandPortrait

Use the ConvertCommandLandscape  key to define which value is passed to the 
conversion program for the landscape format. Use the 
ConvertCommandPortrait  key to define which value is passed to the conversion 
program for the portrait format. For external documents, the alignment used by the 
printer for generating the PostScript file is adopted. If the alignment is not detected, 
the portrait format is used. If the conversion call does not contain information regard‐
ing the alignment of the paper format, this information is not passed to the conversion 
program.

"ConvertCommand Parameters" section
Here, you only configure the parameters required by the program that you set in the 
ConvertCommand key of the Default  section.

8.5.1.5 The standard configuration for HARP

Requirement
● You are familiar with the overview of the freely configurable revision printers.

See section Overview of the freely configurable revision printers (Page 204).

Aim
The freely configurable revision printer (HARP) also supports customer-specific revision 
processes.

The standard configuration that has been tested and maintained by Siemens support is 
presented below.

Configuration of the PostScript printer
The "HARP.ini" file supplied in the default settings uses the following configuration:

● the OEM PostScript printer driver supplied with Windows

● COMOSHarp.inf

● COMOSHarp.ppd
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To activate the standard configuration, proceed as follows:

1. Start the Windows interface "Devices and printers".

2. Select the function "Add printer".

3. Select the function "Add a local printer".

4. Use the option "Use available connection".

5. Use the option "Data carriers".

6. Load the file COMOSHarp.inf.
The associated PPD file must be parallel to the inf file.

7. Confirm the installation of the printer "COMOS HARP".

8. Confirm the installation of an unsigned printer driver. 
This dialog is started automatically by the operating system, because a ppd file is being 
used. When COMOS HARP is used, the message from the operating system is not quite 
correct: COMOSHarp.ppd is not itself a printer driver, but uses the operating system's 
original PS printer driver.

9. Use the option "Do not release printer" 

Installation of GhostScript
The HARP standard configuration requires the following PS converter: 

● GhostScript

– For 32-bit systems, the 32-bit version of GhostScript must be installed.

– For 64-bit systems, the 64-bit version of GhostScript must be installed.

GhostScript is not a component of the operating system and must be obtained separately and 
installed.

You can find more information on the list of versions of third-party software that are currently 
supported in the "COMOS 10.1 Readme" manual, keyword "Freely configurable revision 
printers".

Configure HARP.ini
The file HARP.ini is prepared for standard cases and must not be changed, other than with 
the options listed below. 
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Customize the following options: 

● Path for PrinterRedirection
Enter the directory in which the PostScript files will be temporarily stored. This directory 
must exist and all users who are to make revisions must have write permission in this 
directory.

● Path for ConvertCommandOutputFullFileName
Enter the directory in which the converted PDF files will be temporarily stored. This directory 
must exist and all users who are to make revisions must have write permission in this 
directory.

● Path for ConvertCommand
Enter the directory for the exe file and the name of the exe file for GhostScript (gswin64c.exe 
or gswin32c.exe).

The components that are to be edited are printed in bold in the following example:
[Default]
PrinterName="Comos HARP"
RevisionExtension=.PDF
PrinterRedirection=C:\temp\ComosHARP\%ComosSystemUID%_%WindowsUser%_
%TimeStamp%.PS
ConvertCommandOutputFullFileName=C:\temp\ComosHARP\%ComosSystemUID%_
%WindowsUser%_%TimeStamp%.PDF
ConvertCommand=%GsCall% -sDEVICE=pdfwrite -dPDFSETTINGS=/prepress -
dEmbedAllFonts=true -dAutoRotatePages=/None -sOutputFile=
%ConversionFullFileName% -c "<< /Orientation %LayoutOrientation% >> 
setpagedevice" -f %PostScriptFullFileName%
ConvertCommandExecuteSynchronTimeOut=60
ConvertCommandRevisionSleeper=2
ConvertCommandDecimalDelimiter=.
ConvertCommandPrecision=2
ConvertCommandLandscape=3
ConvertCommandPortrait=0
[ConvertCommand Parameters]
GsCall="C:\Program Files\gs\gs9.05\BIN\gswin64c.exe" -q -dSAFER -
dNOPAUSE -dBATCH
;EOF: HARP.INI

Interaction with eStamp when fonts are embedded
● Only the utilized characters are embedded in the standard configuration of HARP.ini.

● The following fonts are not embedded in the standard configuration of HARP.ini.

– Courier

– Helvetica

– Times family

– Symbol

– ZapfDingbats

The existence of these standard fonts is required on all target systems.

● Complete embedding occurs automatically when eStamp is used.
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Note
Observe copyright of fonts

Do not use any fonts with restricted use permission if eStamp is used in connection with HARP. 
Complete embedding of fonts may infringe the copyright holder's rights.

See also
Support for HARP (Page 212)

8.5.1.6 Support for HARP

Requirement
● You are familiar with the standard configuration for HARP.

See section The standard configuration for HARP (Page 209).

Support
Siemens tests the functionality of the freely configurable revision printer only for the standard 
configuration. This applies to both the PostScript printer driver used and the version of 
GhostScript used. Siemens does not provide support for GhostScript. Customizations to 
HARP.ini that go beyond the tested parameters are at the user's own risk.

Only the originally supplied Microsoft OEM PostScript printer drivers for the officially supported 
operating systems are permissible.

GhostScript has the technical ability to create PDF/A files. This capability is not supported in 
the standard configuration. Siemens does not provide support for the implementation of a 
workflow for creating PDF/A files.

You can find more information on the list of versions of third-party software that are currently 
supported in the "COMOS 10.1 Readme" manual, keyword "Freely configurable revision 
printers".

8.5.2 General information on Adobe PDF

PDF as revision archive
● Checking parallel installation of Acrobat Pro and Acrobat Reader

Acrobat Pro and Acrobat Reader use their own print settings. When both programs are 
installed, the incorrect setting can be used during revisioning with PDF.
You can find additional information on this topic in the "Administration" manual, keyword 
"Revision options: Specify revision archive (specify print format)".
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Adobe Acrobat
Adobe Acrobat is not included on the COMOS CD.

Printer interface "Adobe PDF": Port / output folder
● Properties of the printer, "General" tab "Printer Settings" button

● Properties of the printer, "Ports" tab.

Select a port here that corresponds to the Windows conventions. Adobe created the port "My 
Files" in the default settings, which cannot be used in this way.

● Select "Add" for the port.

● Alternative 1: Use the following path for the new port: 
"C:\Documents and Settings\<user>\Local Settings\Temp"

● Alternative 2: For the new "Adobe PDF Port Monitor" port use
c:\Temp\AdobePDF\

You need full access to the selected path . Each user needs an independent port (independent 
folder).

PDF print format: Format compatibility
The compatibility must be set to the following value:

● PDF 1.4
When you use Acrobat PDF settings, the name of the value is: "Acrobat 5 (PDF 1.4)"

The setting "PDF 1.5" can result in loss of data.

PDF print format: Compression
Recommendation: Disable compression. 

Installing software for PDF
● See chapter Install Adobe Reader (Page 201).

● See chapter Install pdfFactory Pro (Page 202).
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8.6 Installing COMOS updates

8.6.1 Overview
Overview of the COMOS Update Center:

● The COMOS Update Center is a mandatory component of the installation of the COMOS 
basic version.

● The COMOS Update Center installs COMOS updates.
The latest update contains all changes made to the previous update of this version.

● User interface language of the COMOS Update Center
The installation language determines the user interface language of the COMOS Update 
Center. 
A subsequent change is only possible by changing the registry: 
HKEY_LOCAL_MACHINE > SOFTWARE > Wow6432Node > INNOTEC > COMOS, entry 
language

Once you have installed a basic version of COMOS, you can call the COMOS Update Center 
as a dialog window. To do this, open the program "Start > Programs > COMOS > 10.2.1 > 
UpdateCenter".

8.6.2 Call options
You can call the COMOS Update Center as a dialog window, as a console window, or in Silent 
mode.

If you initiate the call as a console window or in Silent mode, the application needs to be called 
with all the required parameters. The call is carried out without any operator actions taking 
place and the program is exited automatically.

Using the call options
● As part of a basic COMOS installation, the COMOS Update Center is called in the form of 

a console window.

● The COMOS Update Center is called as dialog window for updates and subversions.

8.6.3 Installation
The COMOS Update Center is installed during the COMOS Client installation. The COMOS 
Update Center is considered a mandatory component: The installation is performed in the 
background without a further prompt.

The path is: "<COMOS installation directory>\<Version number>\updatecenter\Comos Update 
Center 4.exe". However, in the course of the COMOS installation, you specify the path from 
which the COMOS Update Center should obtain its update source files. You can also enter 
this information later.
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8.6.4 System environment and required rights
● You require the following rights:

– Full access: No

– Edit: Yes

– Read, execute: Yes

– List folder content: Yes

– Read: Yes

– Write: Yes

– Special rights: No

Usually the Windows group of the main users has these rights.

● The Update Center requires that none of the files in the COMOS installation path can be 
accessed. This means that COMOS has to be closed.
No program in the "Bin" folder may be running, including DBMon from the "Bin" folder. No 
help file or text file from this folder may be open.

● The update must not be stored in the COMOS program directory.

8.6.5 "ServicePack.xml"
Each service pack and DocuPack is associated with a "ServicePack.xml" file. This file is stored 
there and identifies the service pack concerned. Even basic installations contain a service 
pack for the basic version and, therefore, file "ServicePack.xml".

The file is important for identifying and controlling installations and updates. If you contact the 
support department, you will often find that they require this file in order to extract information 
from it.

8.6.6 Specifying the update path manually using the dialog window 
You can install specific updates by calling the required location via the update window. You 
need to exit COMOS before doing this.

If you have not specified an update path as described in section Select the source folder for 
the service pack (Page 185), you can do this manually:

"Start > Programs > Comos > 10.1 > UpdateCenter.
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Procedure
Click the "Select Service Pack" button. There are two available options:

1. Select an unzipped service pack
Select a unzipped service pack from one of the directories and confirm with the "OK" button.
The selected service pack will be checked. The current status can be seen in the window 
of the COMOS Update Center at any time.
To install the service pack, click the "Update" button. Once it has been successfully 
installed, a window confirming this is displayed.
Click the "Quit Application" button to exit the COMOS Update Center.

2. Select a ZIP file
Select a directory in which a compressed version of the "ZIP" file of the service pack is 
located. Click "OK" to continue.
An additional button, "Unzip Archive", is displayed at the top right of the COMOS Update 
Center window. Click this button. The service pack is now unzipped and verified.
To install the service pack, click the "Update" button. Once it has been successfully 
installed, a window confirming this is displayed.
Click the "Quit Application" button to exit the COMOS Update Center. 

Information messages
A message appears if you select an old service pack and, therefore, a smaller service pack 
number. You will be prompted if you want to overwrite the service pack. Confirm with the "OK" 
button or cancel with the "Cancel" button. The same procedure applies if the service pack has 
already been installed. 

Result
The COMOS update was installed.

● If the service pack includes a help folder, the new help is installed.

● If the service pack does not include a help folder, the old help is copied to the installation 
of the service pack.

8.6.7 Parameter-controlled update in Silent mode / Console mode
You can start the COMOS Update Center for a parameter-controlled update without a Windows 
interface. To do this, the software needs the program call to transfer the service pack as a 
parameter. In Console mode, you can view the progress of the service pack installation 
process. This may take a few minutes. The program is exited automatically. In Silent mode, 
you cannot view the progress of the installation process or see the program being exited.

Example of a call in Console mode:

"<COMOS installation folder>\updatecenter\Comos Update Center 4.exe" /COMOSTYPE:
101 /CONSOLE /PATH:"X:\CIS\SERVICE_PACKS\V101_Upd_03.zip"

Example of a call in Silent mode:

"<COMOS installation folder>\updatecenter\Comos Update Center 4.exe" /COMOSTYPE:
101 /CONSOLE /PATH:"X:\CIS\SERVICE_PACKS\V101_Upd_03.zip"
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Both examples install service pack 03 from the "X:Cis\Service_packs" directory.

It is important to set parameters with spaces in " " (quotation marks), as well as the path to the 
EXE file for the COMOS Update Center.

The parameter "/COMOSTYPE:xx" determines the COMOS target version. If you work with 
several parallel versions, this parameter determines which version is updated.

The value "xx" stands for the COMOS version. 

For example:

- "90" for COMOS 9.0

- "91" for COMOS 9.1

- "92" for COMOS 9.2

- "100" for COMOS 10.0

- "101" for COMOS 10.1

If the parameter is missing, "90" is assumed.

8.7 Parameter-aided installation of COMOS 

8.7.1 General
You can also control the setup of COMOS via command line parameters. See section 
"Setup_exe_parameter.txt" (Page 217).

● One of the options is to start the internal built-in MSI Installer from Microsoft. 
To do so, use the "/v" option. See specifically section Passing parameters to the .msi file 
incorporated in "Setup.exe" (Page 218) for more on this. 
If you use the "/v" option, all possibilities offered by the MSI Installer are available to you. 
See section "MSIDatenbank_Parameter.txt" (Page 221) for more on this.

8.7.2 "Setup_exe_parameter.txt"

8.7.2.1 Command line parameters for "Setup.exe"

Copyright
(C) InstallShield
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Parameter
Similar to a compiled "MSI" type file, "Setup.exe" can accept a limited set of command line 
parameters. You can use these parameters to specify the language to be used during your 
setup and if "Setup.exe" should run in Silent mode. You can also pass parameters to the 
incorporated "MSI" type file via "Setup.exe".

The "Setup.exe" file accepts the in the following described command line options:

"/v" MSI command line parameter
"/s" Silent mode
"/l" Setup language
"/p" Password mode
"/a" Administrative installation
"/j" Advertise mode
"/x" Uninstall mode
"/f" Repair mode
"/w" Wait

8.7.2.2 Passing parameters to the .msi file incorporated in "Setup.exe"
If the "Setup.exe" file is part of your setup, you have to pass command line parameters to the 
"MSI" type package incorporated in "Setup.exe". Arguments are passed to the "MSI" type file 
using the "/v" option. By using this option, you can list all supported parameters that are passed 
to the "Msiexec.exe" file.

For example, you could use the "Transforms" command:

"Setup.exe /v"TRANSFORMS=\"C:\Transforms\My Transform.mst\"""

For passing over parameters there are some special formatting rules you have to regard. First 
you have to set a backslash (\) prior to every quotation mark which is inside already existing 
quotation marks. 

The command line stated above, for example, contains the following:

"/v"TRANSFORMS=/"C:\Transforms\My Transform.mst/""". You have to use the 
quotation marks since the path to transform is a long one. Since you have to set the entire 
argument in quotation marks the command line instruction might fail if you don’t set a backward 
slash prior to all internal quotation marks.

Another formatting rule stipulates that no spaces are allowed between the command line option 
"/v)" and the arguments passed.

If you pass over multiple parameters with the "/v" option, you have to separate them with a 
space, for example: 

"Setup.exe /v"TRANSFORMS=\"C:\Transforms\MyTransforms.mst\" /qn""

This command applies a transform and executes the setup in silent mode.
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8.7.2.3 Running "Setup.exe" in Silent mode

Objective
If you do not want to display a status bar when the "Setup.exe" file is launched, use the "/s" 
command line parameter.

Example
The "Setup.exe /s" command launches the "Setup.exe" file, but no user interface is displayed. 
If you also want MSI setup to be run in Silent mode, you have to pass the "/qn" command line 
parameter using the "/v" parameter via the "Setup.exe" file.

● Example: "Setup.exe /s /v/qn"
/v/qn is written without spaces.

If you have included the "Select Setup Language" dialog box to give the end user the 
opportunity to select a language for running the setup, this dialog window will not be displayed.

Instead, the setup is carried out in the default language of the target computer. If the target 
computer's language is not part of the available languages that are shipped, setup is conducted 
in the default language, normally English. You can use the "/l" command line parameter to 
specify a certain language.

If your setup is password-protected, you also have to pass the "/p" parameter.

8.7.2.4 Specifying the setup language from the command line
If you include multiple languages in your setup, InstallShield creates the setup in your default 
language and creates so-called transforms for each embedded language. If you want to have 
the setup language selected based on the location of the target computer, a transform is 
performed according to the language area/region of the target system. Since these languages 
are applied in the form of a transform, you can specify the language via the command line of 
the "Setup.exe" file using the "/v" option. 

8.7.2.5 Disadvantages of using the "/v" parameter
Using the "/v" parameter to specify the language has two major disadvantages. These 
disadvantages can be avoided by using the "/l" parameter.

The first disadvantage is that the language transform that you request is added to the language 
transform that is applied by the search for the language area/region. As an example, you could 
create a setup in two languages, English and German, and create it in a way that the setup is 
executed in German if the country settings in the target system are set to German. If you want 
the setup to always be run in German and use the "/v" command line parameter to apply the 
German transform, the "MSI" type file gets the following command:

"TRANSFORMS=1031.mst;1031.mst"

However, if you use the "/l"parameter instead, the original transform is not applied and the 
"MSI" type file gets the following command:

"TRANSFORMS=1031.mst"
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From a functional point of view it makes no difference which parameter you use. If you use a 
parameter that applies the transform twice, the time the setup takes for the start is doubled.

The second disadvantage of using the "/v" parameter is that the "Setup.exe" file is not run in 
the correct language. Only by using the "/l" parameter you can ensure that the "Setup.exe" file 
will be run in the language that you specified in the command line.

8.7.2.6 Using the parameter "/l"
Instead of stating a transform you have to state a decimal language ID. The command for 
German, for example, would be "Setup.exe /l1031".

8.7.2.7 Stating a password from the command line
You can use the "/p" parameter to define a password for a password-protected setup. If you 
execute a password-protected setup in silent mode, you have to enter the password from the 
command line, otherwise the installation would fail.

In order to execute a password-protected setup in silent mode, enter following command in 
the command line:

"Setup.exe /s /v/qn /p"Password""

8.7.2.8 Stating the installation mode from the command line
You can specify the mode for running your setup using the "/a" (Administration, "/j" (Advertise), 
"/x" (Uninstall mode) or "/f" (Repair) parameters. These options are described in detail in the 
following sections.

8.7.2.9 Administration
If you execute a setup in "Administration" mode you can install the setup on the network. In 
doing so you give everyone who has the appropriate rights the option to install the setup on 
their local computer. No further parameters are required for this option.

8.7.2.10 Advertise
"Advertised programs" is an installation mode upon request where features are not installed 
during the setup, but instead upon request from the installation program. If you start the 
"MsiExec.exe" file with the "/j" <package> option, the components are offered on the computer 
of the end user but are not immediately installed. In most cases there is the possibility to offer 
the features in the User-defined setup dialog field. 

8.7.2.11 Uninstallation
If you want to uninstall from the command line, you need to use the "/x" option, e.g. "Setup.exe /
v/x". No further parameters are required.
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8.7.2.12 Repair
Starting a setup in "Repair" mode ensures that the key file of every component is installed and 
undamaged. Starting a setup in "Repair" mode ensures that all your application data is 
available and undamaged. If the setup determines that a file is missing or damaged, it tries to 
solve the problem.

To start a setup in "Repair" mode from the command line, use the "/f" option. 

8.7.2.13 Wait
Use this command line option if you want the "Setup.exe" file to wait until "MsiExec.exe" is 
completed before closing. Furthermore, the "/w" command returns all return codes generated 
by the "MsiExec.exe" file.

If you use the "/w" option in a batch file, you should use the Setup.exe command line argument 
"start /w" as a prefix. A correctly formatted example would be:

"start /w msiexec.exe /w /i readme.txt"

(C) Install Shield

8.7.3 "MSIDatenbank_Parameter.txt"

Copyright
(C) InstallShield

Purpose
The "MsiExec.exe" file is the executable Window Installer program which interprets installation 
packages and installation products on target systems.

Parameter
● "/i" <package> or <product code>

Use this format to install the Othello product:
"msiexec /i"
"C:\WINNT\Profiles\author\My Documents\MySetups\\Othello\Trial Version\Release
\DiskImages\Disk1\Othello Beta.msi""
Product code refers to the GUID, which is automatically generated in the "Product code" 
property of your product.

● "/f" [p|o|e|d|c|a|u|m|s|v] <package> or <product code>
An installation with the "/f" option repairs or reinstalls missing or erroneous files.
As an example use the following syntax in order to force a new installation of all files:
"msiexec /fa"
"C:\WINNT\Profiles\author\My Documents\MySetups\\Othello\Trial Version\Release
\DiskImages\Disk1\Othello Beta.msi"
Along with the following flags:
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"p" Installs a missing file
"o" Reinstalls a file if it is missing or if an older version of the file exists on the system 

of the user
"e" Reinstalls a file if it is missing or if an equivalent or older version of the file exists 

on the system of the user
"c" Reinstalls a file if it is missing or if a stored checksum for the installed file does 

not match the value for the new file
"a" Forces a new installation of all files
"u" or "m" Overwrites all necessary user registry entries
"s" Overwrites all existing links
"v" Starts your application from the source and saves the local installation package 

in the cache memory

● "/a" <package>
The "/a" option can be used by users with administrator rights to install products in the 
network.

● "/x" <package> or <product code>
A product is removed with the "/x" option.

● "/j" [u|m] <package>

– "/j" [u|m] <package> /t <transform list>

– "/j" [u|m] <package> /g

– "/j" <language ID>
If the "/j" <package> option is used, the components of your application are offered on 
the computer of the end user.

"u" Only offers components to the current user
"m" Offers components to all users of the computer
"g" Specifies the language ID
"t" Applies a transform on the offered product

Transforms allow the synchronization of an application for different languages. If you update 
the German version of your product you can also update the English version of your product 
by using transform.

● "/l" [i|w|e|a|r|u|c|m|p|v|+] <log file>
If option /l is used for creation purposes, the path of the protocol file is defined and the 
settings of the flags define which information should be included in the protocol file:

"i" Logs status messages
"w" Logs warnings that are not critical
"e" Logs all error messages
"a" Logs the start of action sequences
"r" Logs action-specific records
"u" Logs user requests
"c" Logs the starting parameters of the user interface
"m" Logs "insufficient memory" messages
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"p" Logs terminal settings
"v" Logs detailed output when set
"+" Appends an existing file
"*" Placeholder character: You can use it to log all information (except the detailed 

output setting).

● "/p" <patch package>
If the "/p" option is used, a patch is applied to an installed setup package. In order to apply 
a patch to an installed administrative image, combine these options with "/a" as follows:
"/p" <patch package> "/a" <package>

● "/q" [n|b|r|f]
The "/q" option is used in connection with the following flags to specify the layer of the user 
interface:

"q" or "qn" Create no user interface
"qb" Creates a basic user interface

The following settings for the user interface display a modal dialog field at the end of the 
installation: 

"qr" Displays a reduced user interface
"qf" Displays the complete user interface
"qn+" Displays no user interface
"qb+" Displays a basic user interface

● "/?" or "/h"
Both commands display the copyright information for the Windows Installer.

● "/y"
This command starts the "SelfRegModules"s action (for the self-registration of the modules) 
and opens the "SelfReg" table. Use this option if you need to acquire registry information 
that cannot be directly added to the "SelfReg" table with the "InstallShields Power Editor".
Select "Power Editor" in the check list in order to edit the MSI tables in your .msi project file.

● "/z"
This command starts the "SelfUnregModules" action with which the registration for modules 
in the "SelfReg" table can be revoked.
This module is located in the "ActionText" table, which can be opened via the "Power Editor".
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● TRANSFORMS
Use the command line parameter TRANSFORMS to state all transforms which should be 
applied on your basic package. The command line used to call the transform function might 
look like this:
"msiexec /i "C:\WINNT\Profiles\author\My Documents\MySetups\\Your 
Project\Trial Version\My Release-1\DiskImages
\Disk1\ProductName.msi" TRANSFORMS="New Transform 1.mst""
Multiple transforms can be separated by using semicolons. Therefore, it is not 
recommended to use semicolons in the names of the files which are to be used for 
transform, since the Windows Installer cannot interpret them correctly.

● Properties
All public properties can be set or changed from the command line. Public properties differ 
from private properties in the way that they always appear in capital letters. Example: 
"COMPANYNAME" is a public property.
Use the following syntax to set a property via the command line:  "PROPERTY = VALUE". 
If, therefore, you would want to change the value for
"COMPANYNAME" you would have to enter the following:
"msiexec /i "C:\WINNT\Profiles\author\My Documents\MySetups\\Your 
Project Name\Trial Version\My Release-1\DiskImages
\Disk1\ProductName.msi" COMPANYNAME = "InstallShield""

(C) Install Shield

8.7.4 Installation in silent mode
Example for the above options: You can install COMOS in such a way that no InstallShield 
user interface starts.

setup.exe /s /l1033 /v"INSTALLDIR=\"C:\PROGRAM FILES\COMOS\92\" 
LICENSESERVER=\"COMOSLICENSESERVER" UPDATEPATH=\"D:\Comos\Comos 
9.2\Service Pack\" /L* \"c:\msilog.log\" /QN+"
Remove the line breaks from this example.

Ensure that you do not remove or add spaces by mistake.

Explanation:

"/s" Silent mode
"/l1031" Language, here: German.

English would be /l1033.
"/v..." A switch, that from here on all words in capital letters are constant code words 

for the MSI setup. Without "/v", the following information is ignored and the 
standard information is used.

"/L" The LOG file is switched on. The LOG file will be approximately 3.5 MB in size. 
"/QN+" A feedback message is displayed after the installation is completed.

An installation in Silent mode reboots the computer without a prompt if necessary. Ensure that 
all important applications are closed.
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8.7.5 Customized files are retained during the COMOS update.
As of COMOS 10.2.1.0, users have the option of creating a Config file as part of a COMOS 
update to retain any manually customized files after an update.

The following steps are required to prevent customized files from being overwritten during the 
update.

Instruction

1. In the COMOS installation directory, create a folder called "AdditionalComosBundles" on 
the level on which the "bin" folder is located.

2. Create an .xml file in "AdditionalComosBundles". 

3. The .xml file is to list all files from the existing COMOS installation that shall not be 
overwritten. Use the following structure for this:
   <bundle>
    <description>
     <name>COMOS</name>
     <version>10.2.1.0</version>
    </description>
    <files>
     <file>BIN\OCX\comos.dll</file>
     <file>BIN\Comos.Commander.exe</file>   
    </files>
   </bundle>
Note
Wildcard

You can use a wildcard here, which means you can use all .dll files from the "BIN\OCX\" 
folder, for example, instead of only one. An asterisk is used to do this, example:  "BIN\OCX
\*.dll".

4. Save the .xml file, go to the Update Center menu in COMOS and start the update as 
administrator.

5. COMOS was successfully updated and the listed files were not changed.

8.8 Carrying out a version change

8.8.1 Definitions

COMOS version
The COMOS version is maintained as a two-digit number. 
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Example: "COMOS 10.1"

● This may be followed by a third digit representing a release number.

● A code number for an update may also be included.

Example: "COMOS 10.1 Update 03"

To display the COMOS version, select "Help > COMOS Info" from the menu bar.

Database scheme
All object properties available in COMOS are stored in the database. When a new object 
property is introduced for a current COMOS version, the database must be expanded to include 
this new property.

COMOS index
The COMOS index is a function for boosting the performance of database adjustment. This 
tool carries out a number of tasks for the administrator concerning the administration of base 
data.

Database version
The database is assigned specific version numbers whenever relevant developments are 
made. The change of a database version has the result that older COMOS clients can no 
longer work with the database.

COMOS document version
Similar to the database model, there is a continuous development of options for documents. 
The document version regulates the range of options available for the user. New options can 
only be set when the document version has been increased.

8.8.2 Testing new version

8.8.2.1 Test
A test must include all activities and COMOS tools that are relevant for the production 
processes of the company.

8.8.2.2 Testing new version
The COMOS version and the database are interrelated in many ways. In particular, the display 
of documents or certain operating methods can change. Databases that are in productive use 
must not be converted unchecked under any circumstances.
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8.8.2.3 Create a copy of the database
Make a copy of the database and test it with the current COMOS version.

Do this by creating a physical copy of the database plus document directory while retaining 
the RDBMS. 

● On a server database that would be a dump which is loaded into a new database. In 
addition, the document directory must be backed up, which may be located on a separate 
server.

● In Access, a physical copy of the MDB file and the document directory are sufficient.

You have the option of exporting the data from a server database into an Access database, 
which can then be tested. Not only is this a quick way to make a copy of the server database, 
but the performance of the RDBMS is also improved if you use an Access database.

8.8.2.4 Installing a new COMOS client
You can operate different versions of COMOS simultaneously one one PC. 

See also
Installing COMOS and additional software (Page 171)

8.8.2.5 Adjusting the COMOS index and the database scheme
If a current COMOS version offers new object properties, you need to adapt the database 
scheme. You cannot use the current COMOS version unless the database scheme has been 
adapted.

If a current COMOS version offers new database indices, you need to adapt the COMOS index. 
Once you have done this, you will be able to enjoy improved performance. Performance will 
not be improved unless you adapt the COMOS index.

The database scheme and COMOS index will be checked and adapted. If you open a current 
COMOS version with an older database with administrator rights, a dialog window appears.

● "No" button
If you click the "No" button, the database remains unchanged and is not opened. COMOS 
remains open and you can select a suitable database.

● "Yes" button
To adapt the database scheme and the indices, click the "Yes" button. Both the older and 
the new, current COMOS clients can continue to work as usual.
No kind of data loss can occur. However, the older clients use the options that were made 
available only by updating the database model.

If you have administrator rights and open a current COMOS version with an older database, 
you are notified that the tables and indices need to be adapted.

After the message, COMOS remains open and you can select another suitable database.
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8.8.2.6 Increasing the document version
The document version is managed in COMOS with the help of the Support dialog.

Once the document version has been increased, this cannot be fully undone. The documents 
saved or created after the increase cannot be reconverted.

8.8.2.7 Increasing the database version
The database version is managed in COMOS with the help of the Support dialog.

Once the database version has been increased, this cannot be undone.

8.8.3 Changing the version

Complete migration of all clients (recommended)
A complete migration involves the following steps:

● Log off all COMOS clients from the database.

● Install the new COMOS version on all clients.

● Adapt the database scheme and indices. then adapt the database. If necessary, adapt the 
document version and the database version. 

Optional: Mixed installation
To perform a staggered migration / mixed installation, follow these steps:

● Install the new version on the individual computers.

● Log off all COMOS clients from the database.

● Adapt the database scheme and indices.

● The clients may log in again. New and old clients can work. However, some new 
functionalities are not yet available at this point, as neither the database version nor the 
document version have been incremented.

● Migrate all the remaining clients and adapt the databases.

● Once all clients have been migrated, adapt the document version and database version as 
needed.

Installing COMOS and additional software
8.8 Carrying out a version change

228 Installation Manual, 03/2017 V10.2.1, A5E37082844-AB



8.9 Errors and special settings

8.9.1 Permissible screen resolutions
To adjust the screen display, follow these steps:

1. Right-click on the desktop.

2. Select the "Adapt" command.

3. Click on the bottom left of the list "See also" on "display".

4. Select one of the settings "Small", "Medium", "Large"

Note
User-defined font size 

The "Determine user-defined font size (DPI)" is not permitted.

8.9.2 Interrupted communication
Communication between COMOS and the License Manager can be faulty for several reasons: 

● Physical failure of a segment of the network

● Stopping or freezing of the License Manager

● Changes to the system configuration after installation etc.

This example deals with a situation where COMOS cannot address the license manager 
service (COMOS LS Service).

If communication between COMOS and the License Manager is disrupted, a corresponding 
message informing you of this is displayed in a dialog box. The software component COMOS 
LS cannot be executed correctly at this time. In this case, it is not possible to access a database.

If the network problem (either hardware or software end) is solved and the error message still 
appears, it may be necessary to execute the entire installation routine or parts of it again.

Contact the support in this case.

8.9.3 TIFF printer
Error: Sometimes the TIFF printer only creates "GRP" type files. This error should no longer 
occur with the new version of the TIFF printer driver.

Troubleshooting: This problem can only be solved by a new installation of the printer driver.

Proceed as follows: 

1. Delete the printer entry from the printer directory.

2. Open the Setup browser.
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3. Start the COMOS TIFF setup.

4. Remove the COMOS TIFF printer.

5. Restart the system and repeat the COMOS TIFF installation.

8.9.4 Resource problems while printing
Generally, you cannot increase the dpi number as desired when printing. At some time the 
system will reach its limits and can no longer carry out revisions correctly. This mainly depends 
on the amount of random access memory (RAM). Usually, the more RAM you have in the 
computer, the higher the maximum resolution for printing.

TIFF printing
The printer sends an error message if there is not enough RAM available for TIFF printing. 
The revision print is aborted with the warning: "Revision could not be printed". In the 
DebugView/DBMon the following error message is displayed:
[632] ++++++++++++++++++++++++++++++++++++++++++++++++++
[632] ComosDefRevPrn::ComosTiff::IRevisionPrinter_DoPrint():
[632] Printing has been aborted!
[632] Print status: 'Error #252: Not enough memory to create tiff 
file'
[632] -> Revision of (A1|SPS|PFB.001) failed! -> aborting [632]
++++++++++++++++++++++++++++++++++++++++++++++++++++++

pdfFactory
pdfFactory does not report errors if resources are fading; instead, it prints until the resources 
are completely gone and then quits. 

The result: incomplete printouts.

Fineprint, the manufacturer of pdfFactory, therefore recommends that the longer paper side 
should not exceed 32,767 pixels. This results in a maximum resolution of 600 dpi for DIN A0.

8.10 Administration tasks when you first start COMOS
During login, the different versions of the COMOS software and the COMOS database are 
checked for compatibility. 

You can find additional information on this topic in the "Administration" manual, keyword "Login 
check: Database scheme and database indices" and keyword "Login check: Database version 
and document version."
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Login in a locked database with keycode.exe 9
Keycode.exe

A COMOS EE database can also be opened with COMOS PT. However, COMOS EE can no 
longer open this database afterwards.

If this happens accidentally, you can lift the block on the COMOS ET database Proceed as 
follows:

● In Windows Explorer, open the ..."\BIN" directory.

● Start "KEYCODE.exe".

● Select the database which you want to enable.
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Administration of the appearance of the COMOS menu 
(main.xml) 10
10.1 COMOS menu bar and COMOS toolbar

Principle
The contents of the COMOS menu bar and COMOS toolbar are defined in a system-internal 
XML file. The content actually displayed depends on the following factors:

● Module that you have started.

● User rights with which you are logged in.

● Use of the additional configuration file "Main.xml".

In addition to this XML file, you can create the configuration file "Main.xml". In this configuration 
file, you adapt the definition of the COMOS menu bar and COMOS toolbar to your requirements.

If the "Main.xml" is defective, the default XML file is also used. If "DBMon.exe" or 
"DebugView.exe" is running, a corresponding message is output there.

Advantage of customer-specific XML files
● Customer-specific content (menus, submenus, menu commands, tools) can be added to 

the COMOS menu bar and COMOS toolbar.

● The content offered in the default setting can be reduced to that relevant for the user.

Menus and menu commands in the default setting
For information on which menus, submenus and menu commands are contained in the 
COMOS menu bar by default: 

You can find additional information on this topic in the "COMOS Administration" manual, 
keyword "Reference of the COMOS menu: Menu entries".

See also
XML structure of MAIN.XML (Page 234)
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10.2 XML structure of MAIN.XML

Overview
The XML file for configuring the COMOS menu bar and COMOS toolbar has the following 
structure:

Node layer 1 Node layer 2 Description
<ComosMainMenu>  The parent node
 <General> For the declaration of the used XML struc‐

ture
Attribute: Version
Current: Version="1"

 <Lib> Library for registering the basically available 
menu bars, toolbars and their contents

 <Menu> Defines the content users can see in CO‐
MOS.

See also
Reference to XML node <Lib> (Page 241)

Reference to XML node <Menu> (Page 248)

10.3 Storage directory
Storage directory for "Main.xml" and its clones:

"<COMOS installation directory>\config\menu"

10.4 Clone of "Main.xml"

Principle
You can create clones of the file "Main.xml". Clones have the same structure as the file 
"Main.xml", but a different file name. 

To use a clone specify the clone as a COMOS start parameter. 

Passing start parameters is not required for the following modules: 

● Design Viewer (old: Construction Assistant)

● EI&C

● FEED

● P&ID

● View
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The clones are used automatically when the module is started. Requirement: The name 
convention is observed. 

Evaluation sequence
During startup, COMOS checks whether an XML file has been passed as a start parameter. 
Then COMOS checks which XML files are available and uses the first file found in the following 
order:

1. File passed as a start parameter

2. If COMOS has been started with the Design Viewer, EI&C, FEED, PID or View module: 
The module-specific clone

3. "Main.xml"

4. If COMOS has been started with one of the modules mentioned in step 2: The internal 
system XML file for this module

5. The internal system standard XML file

See also
Creating a custom XML file (Page 235)

10.5 Creating a custom XML file

Procedure
1. Change to the directory "<COMOS installation directory>\config\menu".

The "ExampleMain.xml" file is located in this directory.

2. If the file does not exist, install the latest update.
The file is copied to the directory.

3. Open file in an XML editor or text editor that supports Unicode.

4. Edit the XML file to meet your needs.

Note
Note case-sensitive entry (upper and lower case letters)

Your entries are case-sensitive, as described in this document.
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5. Save your changes.

6. Rename the file. You have two options

– Assigning standardized name:
The file is automatically evaluated during the start of the following module:

Module Name of the XML file
Design Viewer "CA.xml"
EI&C "ET.xml"
FEED "FEED.xml"
P&ID "PID.xml"
View "V.xml"
Remaining modules "Main.xml"

– Assigning name freely: The file is only evaluated if it was passed as a COMOS start 
parameter: /MN:<file name>

Adapting the XML file
You have the following options:

● Remove the nodes of menus, submenus, menu commands, or toolbars and tools that are 
not needed from the <Menu> node.

● Register entries such as customer-specific menus or menu commands in the node <Lib>. 
Use the entries in the node <Menu>.

● Change the definition of a menu command or tool from the toolbar, which is used by the 
standard XML file.
Examples: Change the visibility of a command or change its label, assign a command to a 
different function right as the present one
Proceed as follows:

– In the <Lib> node, open the <Tool> node with which the menu command or tool is 
registered.

– Copy the node.
With the following steps, you edit the copy.

– Change the value of the id attribute. Use a unique identifier.

– Adapt the attributes and subnodes.

– In the <Menu> node, open the <Toolbar> node.

– Search for the menu command or tool whose idref attribute uses the original id.

– Replace the value for idref with the id you have assigned.

See also
Clone of "Main.xml" (Page 234)
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10.6 Example: Base object call

Objective
In this example, you edit an existing file "Main.xml" to add a submenu for opening base objects 
to the "Extra" menu in the COMOS menu bar.

Requirement
● The file "Main.xml" has been created. 

● The file contains the following nodes:

– <ComosMainMenu> <Lib> <Toolbars> <Toolbar id="MainMenu" 
type="MainMenu" />

– <ComosMainMenu> <Menu> <Toolbars> <Toolbar idref="MainMenu">
And the subnode <Tool idref="ID_mnuExtra"> below that. 

Procedure 
1. Open the file Main.xml".

2. Open the following node: <ComosMainMenu> <Lib> <Tools>.

3. Add the following subnodes:
<Tool id="ID_MyOwnAdminQueries" type="PopupMenu">
 <Caption> 
 <Text xml:lang="de-de" value="Meine Administrator-Abfragen" />
 <Text xml:lang="en-en" value="My administrator queries" />
 </Caption>
 <Binding type="CDevices" root="@System|@O|@Query" />
 <Rights dependencyProperty="Visible" adminOnly="true" /></Tool>

4. Open the following node:
<ComosMainMenu> <Menu> <Toolbars> <Toolbar idref="MainMenu">

5. Add the following subnode:
<Tool idref="ID_MyOwnAdminQueries" />

6. Save the file.

10.7 Example: Own icon in the menu bar

Objective
In this example, you are editing an existing "Main.xml" file in order to add your own icon to the 
COMOS menu bar which you will use to call a user interface. 
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Requirement
● The file "Main.xml" has been created. 

● The base object "CDev_Test_1" exists.

● The image for the icon must be stored in a folder called "pictures". The "pictures" folder 
must be created in parallel with the "menu" folder.

Procedure 
1. Open the file Main.xml".

2. Make sure that the following node exists:
<ComosMainMenu> <Lib> <Toolbars> <Toolbar id="TestMenu" 
type="Toolbar" />

3. Open the node:
 <ComosMainMenu> <Lib> <Tools>.

4. Add the following subnodes:
<!--##Customer-specific tools-->
<Tool id="ID_Test1" type"Button">
  <Caption>
   <Text xml:lang="de" value="Test1">
  </Caption>
  <Picture key="CPlugInImportData"/>
  <Binding type="CDevice" root="CDev_Test_1"/>
  <Window type="Floating" width"7200" height="4200" 
resizeMode="Resize"/>
</Tool>
<!--##Customer-specific tools"-->
The file name of the icon is specified without a file extension. 
The root is specified with the SystemFullName, which means with path specification.

5. Open the following node:
<ComosMainMenu> <Menu> <Toolbars> <Toolbar idref="TestMenu">

6. Add the following subnode:
<Tool idref="ID_Test1">

7. Save the file.

Example
<ComosMainMenu>
<!--
##################################################
                L I B:  TOOLS, TOOLBARS
##################################################-->
<Lib>
<Tools>
<!--##Customer-specific tools-->
<Tool id="ID_Test1" type"Button">
   <Caption>
     <Text xml:lang="de" value="Test1">
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   </Caption>
   <Picture key="CPlugInImportData"/>
   <Binding type="CDevice" root="CDev_Test_1"/>
   <Window type="Floating" width"7200" height="4200" 
resizeMode="Resize"/>
</Tool>
<!--##Customer-specific tools"-->
</Tools>
  
<Toolbars>
     <Toolbar id="TestMenu" type="Toolbar"/>
</Toolbars>
</Lib>
<!--
##################################################
                M E N U
##################################################-->
<Menu>
<Toolbars>
   <Toolbar idref="TestMenu">
     <Tool idref="ID_Test1"/>
   </Toolbar>
</Toolbars>
</Menu>
</ComosMainMenu>
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Reference of the XML schema of Main.xml for the 
COMOS menu 11
11.1 Reference to XML node <Lib>

11.1.1 Attributes and subnodes of <Lib>

Purpose of <Lib>
Library for registering the basically available menu bars, toolbars and their contents

Attributes of <Lib>
None

Subnodes of <Lib> and their attributes

Node Attributes Description
<Tools> - Here, you can register items in the COMOS interface that can 

be used by the menu bar and toolbars (menus, submenus, 
commands, tools). 
There is a <Tool> subnode for every item.  See chapter Attrib‐
utes and subnodes of <Tool> (Page 241).

<Toolbars> - Here, you can register the toolbars or menu bar that can be 
used in the COMOS interface.
There is a <Toolbar> subnode for each toolbar and for the 
menu bar. See chapter Attributes and subnodes of <Toolbar> 
(Page 247).

11.1.2 Attributes and subnodes of <Tool>

Requirement
● The subnodes of <Lib> are known.

See chapter Attributes and subnodes of <Lib> (Page 241) for more on this.

Purpose of <Tool>
Each node represents an item in a toolbar or menu bar, which is basically available in the 
interface. The attributes define the properties and behavior of the item.
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Attributes of <Tool> 
● id

Must be unique. Any character string. 

● type
Determines the type of menu bar and toolbar item. 
Possible values:

– PopupMenu
A menu or submenu
In order to create a menu with three drop-down submenus, you need four <Tool> nodes 
of the type PopupMenu.

– Button
A command in a menu or a button for a tool in a toolbar

– StateButton:
An option

– ComboBox
A list generated automatically by COMOS for selecting a case. Name: 
ID_ProjCasesCB
Other lists cannot be registered.

– Seperator
Hyphen for optical division of menus 

Note
Mandatory node

The <Tool> node requires the following subnodes:
● <Caption> and <Text>
● If <Tool> for type has the value "Button"  or "StateButton": <Class> or 

<Binding>
● For tool buttons: <Picture>

<Tool> <Caption>
<Caption>
Attributes: 

Defines the label of an item.

The label appears in the tooltip for buttons.

The label is read depending on the interface language configured in COMOS. If there is no 
label for the current interface language, the English text is read.

Subnodes:

● If the translations are determined by the ITX functionality, a <Caption> subnode is 
required.
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● If the translations are entered manually, a <Caption> subnode is required for each 
language.

<Tool> <Text>
<Text>
Attributes: xml:lang or itx
Subnodes of <Caption>
There must be a separate <Text> node for each language, in which the label is displayed.

All languages for which ITX support is available are permitted.

● xml:lang 
Use the following syntax:
xml:lang="<standard language code>" value="<label>"
Example:
<Caption><Text xml:lang="en-en" value="Load"/><Text xml:lang="de-
de" value="Laden"/></Caption>

● itx
The label is determined with the ITX functionality.
Support from the Support required.

<Tool> <Picture>
<Picture>
Attributes: key
Assigns the picture specified by key to the higher-level <Tool> node.

Permitted picture formats:

● "*.ico"

● "*.jpg"

● "*.png"

Permitted dimensions: 16 x 16 pixels

If the higher-level node <Tool> is an option (type="StateButton"), the picture is only 
visible when the option is deactivated. The user sees a check mark for an activated option.

● key 
Information about a customer-specific picture.
The path information for the picture file is relative to the folder with the main.xml file:
<Picture key="..\icons\ok.ico"/>
Requirement in this example: based on standard installation, the "icons" folder is located 
parallel with the "menu" folder.
The internal standard path is: "<COMOS Installation directory>\Current\config\pictures"

<Tool> <Class>
<Class>
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Attributes: type, progid, assembly, method
Defines the action triggered when the user selects this item.

● type
– NET

A .NET WPF interface opens or a .NET method is started.
Sets the assembly and progid attributes. To invoke a method, also set the method 
attribute.
If type="NET": The full name of the class that defines the .NET WPF interface
The .NET class must have a constructor without parameters.

– COM
A COM plugin or COM method is started. To invoke a method, also set the method 
attribute. Values for progid: 
If type="COM": The ProgID of the plugin

● assembly
Not defined if type="COM"
Value: The full name of the assembly, i.e. without the extension "*.dll"
Custom assemblies must be located in the following directory: "<COMOS installation 
directory>\BIN\Custom". 

● method 
Name of the method that is called
Examples:

– NET WPF interface:
<Class type="NET" assembly="Comos.UIF" progid= 
"Comos.UIF.UIControls.UIFormsList"/>

– .NET method:
<Class type="NET" assembly="TestNET" progid="TestNET.XY" 
method="ABC"/>

– COM plugin: <Class type="COM" progid="CPlugInWord.Word"/>

<Tool> <Rights>
<Rights>
Attributes: dependencyProperty, functionRights or adminOnly
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Locks the item or hides it, depending on the user rights.

● dependencyProperty
– Visible

The item is only visible when the condition set by the functionRights or 
adminOnly attribute is fulfilled.

– Enabled
The item can only be selected when the condition set by the functionRights or 
adminOnly attribute is fulfilled.

● functionRights
– Bit field for the function rights that the user must have

– You can find the current list of the function rights and their constants in the "Class 
documentation COMOS_dll" manual.

● adminOnly
– true or false

● withDBUpdateRightOnly
– true or false

withDBUpdateRightOnly = true: Condition is met in the following cases:
User has "Rights for database update" or "Administrator" rights.
And an update package is imported

Examples:

● <Rights dependencyProperty="Enabled" adminOnly="true" />

<Tool> <Binding>
<Binding>
Attributes: type, root
Links the item to a base object. 

Typical application case: Opening a query from a menu. Queries behave the same way in the 
base data and engineering data so that these objects can be integrated using a base object 
call.

● type
– CDevice

When the user selects the item, the base object specified by root opens.

– CDevices
When the user selects the item, a submenu appears with the base objects located below 
the base object specified by root. Base objects with base object references are not 
displayed. 

● root
The SystemFullName of the base object. Example:

– <Binding type="CDevice" root="@System|@O|@Print" />
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<Tool> <Window>
<Window>
Attributes: type, area, subarea, width, height, scaleMode, resizeMode, state
Only when a NET WPF interface is opened: Determines the behavior of the interface

● type
– Tab

The interface is inserted in the area or subarea as a tab.
Default

– Floating
The interface appears as a non-modal window. The window and main application can 
be used interchangeably.

– Modal
The interface appears as a modal window. You can only use the main application again 
once you close the window.

● area
Set only if type="Tab"
– Value: Document

The tab is opened in the working area.
Default

– Value: Document2
If COMOS is used on two screens (menu bar, command "View > Screen 2": The tab is 
opened in the working area of the second screen.

– Value: Navigator
The tab is opened in the Navigator.

● subarea
Set only for type="Tab"
– Value: Detail

The tab is opened in the detail area.

● width and height
Set only if type="Modal" or ="Floating"
Width and height in the unit defined by scaleMode
Not for type="Tab"

● scaleMode
Set only if type="Modal" or ="Floating"
Values: pixel or twips

● resizeMode
Set only if type="Modal" or ="Floating"
Values: NoResize or Resize (default)
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● autoClose
Set only if type="Modal" or ="Floating"
– Value: true

Default
The window closes automatically with a project change or database change.

– Value: false
● state

Defines whether the tab or a card is fixed or its contents are replaced the next time you 
open an object of the same type.
Values:

– Reuse: "Reuse tab/window" button is green (not fixed). The user can switch to yellow 
(fixed).

– Unique: The "Leave tab/window open" button is yellow. The user can switch to green 
(reuse).

– ReuseOnly: The button is green. It is not possible to switch to yellow.

– UniqueOnly: The button is yellow. It is not possible to switch to green.

Example
<Window type="Floating" width="9045" height="6810" scaleMode="twip" 
resizeMode="NoResize" />

Combining the <Tools> node
When a custom XML file is available, COMOS does the following:

● COMOS combines the custom file and the standard file to form the contents of the 
<Lib><Tools> node.

● If two <Tool> nodes from the custom file and standard file have the same value for id, 
the definition from the standard file is given priority.

11.1.3 Attributes and subnodes of <Toolbar>

Requirement
● The subnodes of <Lib> are known.

See chapter Attributes and subnodes of <Lib> (Page 241).

Purpose of <Toolbar>
Each node represents a toolbar or menu bar, which is basically available in the interface. Its 
attributes define the properties and behavior of the toolbar or menu bar.
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Attributes of <Toolbar>

Attribute Description
id Must be unique. Any character string. 
type Determines the type of bar. 

Possible values:
● MainMenu

COMOS menu bar
● Toolbar

A toolbar of the COMOS toolbar

Subnode
<Toolbar> can have the <Rights> subnode. The node has the same attributes as the node 
of the same name under <Tool>.

11.2 Reference to XML node <Menu>

11.2.1 Attributes and subnodes of <Menu>

Purpose of <Menu>
Defines the content displayed in the COMOS interface.

Attributes of <Menu>
None

Subnode of <Menu> and its attributes

Node Attributes Description
<Toolbars> - Here, you define the menu bars and toolbars the user can see 

in COMOS.
Subnodes: There is a <Toolbar> subnode for each bar.

11.2.2 Attributes and subnodes of <Toolbar>

Purpose of <Toolbar>
Each node represents a toolbar or menu bar, which the user can see in COMOS.
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Attributes of <Toolbar>

Attribute Description
idref Reference to a toolbar or menu bar registered in the 

<Lib><Toolbars> node
The value of idref must be identical to the value assigned to the corre‐
sponding <Toolbar> node in the library with the id  attribute. 
Example:
<Lib>
   <Toolbars>
      <Toolbar id="Query_Main" type="Toolbar" />
   </Toolbars>
</Lib>
<Menu>
   <Toolbars>
      <Toolbar idref="Query_Main" />
   </Toolbars>
</Menu>

Subnodes of <Toolbar> and their attributes
Under <Toolbar>, you define the toolbar and menu bar items the user sees in COMOS 
(menus, submenus, menu commands and tools). There is a Tool node for every item. 

Attributes of <Tool>:

Attribute Description
idref Reference to a toolbar or menu bar item registered in the 

<Lib><Tools> node
The value of idref must be identical to the value assigned to the corre‐
sponding <Tool> node in the library with the id  attribute. 
Example:
<Lib>
   <Tools>
      <Tool id="id_MenuView" type="PopupMenu" />
   </Tools>
</Lib>
<Menu>
   <Toolbars>
      <Toolbar idref="MainMenu" >
         <Tool idref="id_MenuView> ... <Tool/>
      </Toolbar>
   </Toolbars>
</Menu>

Subnodes of <Tool>
Only when the node referenced via idref is a PopupMenu type. In this case, there is a 
<Tool> subnode under <Tool> for each submenu.
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Administration of the help menu 12
Requirements

See chapter Help viewer (Page 15) for the supported browsers.

Format of the COMOS help
COMOS uses HTML5 websites controlled with scripts for the help.

Start / automatic start of COMOS help
● The help is opened in the usual way from the COMOS "Help" menu with the "COMOS help 

system" entry.

● The COMOS "Readme" and COMOS "What's New" files are available in addition as PDF 
files in the Help menu.

● The start help is enabled for every new version and every release or SP. You switch the 
start help on and off using the "Help > Show help at start" command in the COMOS menu.
Automatic start is managed in the registry. The following registry entry switches off 
automatic start:
[HKEY_CURRENT_USER\Software\INNOTEC\COMOS] "ShowStartHelp"="0"

● The help screen for the COMOS help system is displayed in a separate window; it does 
not close when COMOS closes.
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Filing structure and customization
1. Top level:

– "Help" folder

2. Second level:

– "Chinese"

– "English"

– "German"

– "System"

3. Third level:

– "Chinese", "English" and "German" folders:
These folders each contain a "start.htm" file. This file is called independent of the 
language when the command "COMOS help system" is used in COMOS.
In addition, you can create separate folders and help files for each language in these 
folders. Permitted file formats:
PDF, pdx
doc
txt
If additional folders have been created, they will appear in the "Help" menu.

Note

It is not possible to store the help files in the network and connect them to the clients as 
a link. 

– "System" folder
The files for the COMOS help system are stored here in the subfolders "de-DE", "en-
US", "zh-CHS".

Sorting your own files
● Standard sorting of the files: Alphabetical

● An invisible prefix is allowed. The prefix is composed of up to three digits and an underscore.
Example: "09_" or "010_".

● If COMOS finds such a number prefix that ends with an underscore, this prefix is included 
in the sorting, but it is not displayed.

Additional sources of information
● COMOS customer documentation is also available on the Internet. If you want to print 

individual manuals, you can download them as PDF files from the SIEMENS Industry Online 
Support portal.

● In the "My Documentation Manager" online application, you can read, configure, and even 
apply change notifications to the COMOS help files (registration required).
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